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Foreword

 

How to Start Your Genealogy Project

 

Get the Facts First

 

In compiling your genealogy, you are looking for information—names, dates, relationships and places. You 
can be sure that you had a great-great grandmother, and that she was born and died on specific days. The 
facts are out there. The challenge of genealogy lies in finding them.

There are literally hundreds of sources of genealogical information which can assist you in your 
search, and the facts you discover can lead to exciting, and often unexpected revelations. Sometimes trivial 
details mask profound events which are disclosed by persistent investigation.

 

Now Consider the Source

 

Genealogy engages you in a struggle between the need for uncompromising accuracy and the natural urge 
for unrestrained imagination. Both imagination and accuracy are essential: without imagination, enthusiasm 
wanes; without accuracy, the search flounders on false leads.

It helps to keep one distinction in mind while searching. There are at least two sides to everyone’s per-
sonality—a public and a private side. The private side encompasses life in the home—marriage, family, hob-
bies, reflections, domestic concerns. The public side emerges outside, where everyone wears a slightly 
different face and clothing. Sometimes records of the private and public sides of an ancestor may seem to 
conflict. Together they represent a whole person.

When you cease to be an eye-witness to an event, you must rely heavily on the word of others. The 
people on whose word you rely may not have been eye-witnesses either. The greater the distance between 
you and the information you seek—whether the distance is measured in miles or generations—the greater 
the need to rely on the word of someone else. In each transfer of information lies the opportunity for misin-
terpretation—a typographical error, a conscious exaggeration, an inadvertent slip of the tongue. Always look 
for the possibility of error in any source. Many were never meant to be used for historical research.

Be aware of biases or what a person might want to gain by telling a story one way or another. When 
you spend time interviewing relatives, you need to know what to believe and what not to believe. You are 
asking a member of the family about another member of the family, living or dead. Consider the relationship 
between the two. Wishful thinking or resentment or a failure of memory could color the story. Sometimes 
what is omitted can be of great significance. Family misunderstandings of a deeply-rooted nature can lead to 
the expulsion of an individual from living memory. The tenacity of a genealogical researcher can reestablish 
the presence of these “black sheep” and restore them to the family tree.

Cross check with as many sources as possible. Some written records are more reliable than others, but 
on the surface, this might not be easy to assess. Both public and private sources need to be carefully and crit-
ically evaluated. With written sources, it is important to ask the same questions you would with a living 

 

i x



 

source. What were the authors’ motivations? What did they have to gain by writing this story? How did they 
obtain the story in the first place?

In the case of public records—military records, court records, real estate documents—the person com-
piling them probably had no stake in the information contained therein. Accuracy may not have been the first 
concern. Often, the same is true for local history books. Amateur circuit-riding historians would arrive in a 
community and offer to write a local history. Some are accurate, others aren’t. It is the wise and prudent 
researcher who approaches public documents and historical accounts with a certain degree of caution.

 

A Note on the Slipperiness of Language

 

Whether listening to a story in person or consulting written texts, you are using a continually changing lan-
guage. A word that looks familiar may have a completely different meaning in a 200-year-old document. 
Some words are no longer used. Others have acquired a new meaning. Great care must be exercised to avoid 
misinterpretation.

Remember too, that your family name may have changed with prevailing spelling conventions. The 
name 

 

Smith

 

 may have been spelled 

 

Smyth

 

, 

 

Smythe

 

, 

 

Smeeth

 

, 

 

Smithson

 

, or 

 

Smithington

 

. Ancestors may have 
changed their names to avoid persecution. Quite frequently, the keepers of early church records took liberties 
with spellings, and there was no one to argue with the only literate person within miles.

 

Start With Yourself

 

Compiling your genealogy begins with you. Sit down and list what you know about yourself: name, date of 
birth, names of parents, your place of residence, the important events of your life. Then see what you know 
about your ancestry. Seek every last bit of information about where you have come from and who has pre-
ceded you.

To make sure from the outset that nothing is lost, write everything down. Write it all down. You don’t 
know when you may need it again. Note the source of your information so that if you need to go back to 
check a fact, you can re-evaluate its source.

 

Home Sources

 

Once you have exhausted the supply of the most readily available information, there will still be holes in the 
pedigree chart and family group sheets. There are two directions to pursue at this point, and it doesn’t matter 
which you choose first. You can look for evidence of ancestors in written records and also in the memories of 
living relatives. Shuttle back and forth between the written and the oral, seeking the most—and most accu-
rate—information available.

The list of possible sources at home is endless. Look for family histories, family bibles, journals, dia-
ries, letters, yearbooks and scrapbooks. Other sources include legal and financial papers, photographs, and 
even household items.
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Conducting an Interview

 

After picking your brain for facts and searching your home and the homes of others looking for written 
sources of information, you have an opportunity to sit down and talk with people about the past. In this most 
rewarding part of the genealogical search, you can find out directly from relatives what their life has been 
like and how other people have figured in it.

You are looking for the five 

 

W

 

s—Who, What, Where, When and Why—but you can come back with 
far more. Find out names, dates, places and relationships, and then probe. What familial traditions have dis-
appeared over the years? What do members of the family talk about when they gather for reunions? Be 
patient and resist any temptation to dispute or pass judgment upon anything said.

To record your conversation, take notes or use a tape recorder. Tape is preferable as long as your inter-
viewee doesn’t object, but take along a notebook to record non-verbal messages that may not show up on the 
tape.

 

Moving Out With the Search

 

The resources to draw upon next are official records in libraries, archives and repositories scattered through-
out the world. Start with your public library. There you will find genealogy reference books, directories and 
guides, information about local genealogical and historical societies and other research assistance.

The largest collections of genealogical data are found in libraries maintained by The Church of Jesus 
Christ of Latter-day Saints (LDS Church). While the Family History Library in Salt Lake City, Utah, is the 
largest, check your telephone directory for a local branch.

 

Enjoy Your Genealogical Pursuit

 

Start with the known and seek the unknown. The methods of the genealogical search are much like that of 
any search. First, you define exactly what you want to know, then you design a plan for locating the informa-
tion. You search, return with data, and then assess whether it is accurate. Once verified, it can fit into the 
framework of what you already know and inspire new searches.

You are looking for as much information about your family as you can find, in as many places as you 
can find it. In the process, you’ll encounter pitfalls and dead-ends, but care and accuracy will decrease the 
number of detours. Sometimes picking a path through the past may sound like traipsing through a berry 
patch. That is in fact exactly what it is: a sticky search with steady rewards along the way.
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Section 1:
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Welcome to Ultimate Family Tree™ and the exciting world of genealogy. Genealogy is the pursuit of k
edge about our past. It’s a way to look at our families in order to better understand ourselves. With U
Family Tree, you can view the past in ways never dreamed possible by your ancestors.

Ultimate Family Tree’s easy-to-use data entry screens, Instant Web Page Publisher, spell check
online capabilities are firsts for any genealogy software. Using Ultimate Family Tree, you can docum
events in each individual’s life by drawing from a library of almost 200 predefined events or by creating
own. Fundamental information for each person is entered through Ultimate Family Tree’s powerful In
ual Record window.

The online functions provided by Ultimate Family Tree are its most exciting feature. It’s possible
connect directly to the program’s exclusive Web site and converse with research experts, download u
genealogical information, and upload your own family history Web page.

Soon you will be entering your own information and creating beautiful journals of loved family 
members.

Help is Always at your Fingertips
Ultimate Family Tree provides the following help:

• The Ultimate Family Tree User’s Guide

• The Ultimate Family Tree Web Site http://www.uftree.com
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• Online Help—an online reference guide that includes context sensitive help, extensive cross re
ing, troubleshooting assistance, a guide to error messages, answers to frequently asked questi
a glossary.

• Technical support

If you have questions about any aspects of the program, follow these steps:

1. Check the Table of Contents and the Index of the Ultimate Family Tree User’s Guide for the subject 
with which you need help, or from the Help menu, choose Help or Help Topics.

2. See “Troubleshooting” in the Section 9 and online help for answers to common problems.

3. Contact Ultimate Family Tree Technical Support:

• FAX 812-829-1020

• Mail 743 E. Franklin Street, Suite B, Spencer, Indiana 47460

• CompuServe GO GENSUP

• Internet (email) pifamily@palladiumnet.com

• Telephone 812-829-4405 (8 AM–10 PM CST, M–F)

If you call for technical support, please call while you’re at your computer. Technical support is 
offered for questions or problems using Ultimate Family Tree. For questions on using your computer,
sult the Macintosh User’s Guide or contact Apple at (800) SOS-APPL.

Getting Ready to Install

System Requirements
Ultimate Family Tree is a Macintosh program designed for System 7.0.1 or higher, 68040 or PowerM
8 MB RAM (16 MB strongly recommended for better performance), 22 MB free hard disk space (plus 
per thousand names, and an additional 11 MB if installing AT&T WorldNetSM), a color monitor, and a dou-
ble-speed CD-ROM drive. A modem (9600 bps minimum; 14.4 kbps or greater recommended) and In
access are required to use the Go Online feature.

A word processor is also required. Ultimate Family Tree prepares charts and reports to be disp
and printed with any word processor capable of importing Rich Text Format (RTF) files. Microsoft Wo
recommended. Box charts are sent directly to your printer.

Note If you have less than 16 MB of physical RAM you must turn on Virtual Memory to run Ult
mate Family Tree. Using Virtual Memory will significantly slow the performance of your Macintosh.

If AppleScript™ and AppleScriptLib™ are not found, they will be installed (these system ex
sions are required to run Ultimate Family Tree, and must be enabled by rebooting).
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Make Sure You Have Everything You Need
Your Ultimate Family Tree package should include:

• Ultimate Family Tree User’s Guide

• Registration card

• On-Line Guide

• AT&T WorldNet Guide

• Ultimate Family Tree CD-ROM

Customer Registration
Fill out and mail the enclosed registration card immediately. This card qualifies you to receive free tec
support and notification of upgrades.

Installing Ultimate Family Tree
To install Ultimate Family Tree as a new program, follow these steps:

1. Insert the Ultimate Family Tree CD-ROM.

2. Double-click the Ultimate Family Tree Install icon.

3. A warning will appear if you have less than 16 MB of RAM, and you will be prompted to continu
quit (if you have more than 16 MB of RAM you will not see this warning). It is possible to compl
the installation with less than 16 MB of RAM, but the product will suffer performance problems.

4. The Ultimate Family Tree start-up logo appears. Click Continue.

5. The README box appears. The README file contains late-breaking information regarding the
product that could not be included in the manual. You have the option to read, print, or save the
README file to disk. Make your choice and then click Continue.

6. At the SETUP window, click Install if you have never installed the program before. This will insta
of the Ultimate Family Tree Deluxe software.

7. When all products have been installed, you will be prompted to restart your Macintosh.

On-Line Guide
After you have installed Ultimate Family Tree you must run the Browser Setup program to enable the
line functionality of the program. Refer to the instructions in the enclosed On-Line Guide to configure
browser for use with the Palladium Interactive Members Only Web Site. Double-click the Browser Se
Icon and follow the on-screen instructions.
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Reinstalling Ultimate Family Tree
1. Insert the Ultimate Family Tree CD-ROM.

2. Double-click the Ultimate Family Tree Install icon.

3. A warning will appear if you have less than 16 MB of RAM, and you will be prompted to continu
quit (if you have more than 16 MB of RAM you will not see this warning). It is possible to compl
the installation with less than 16 MB of RAM, but the product will suffer performance problems.

4. The Ultimate Family Tree start-up logo appears. Click Continue.

5. The README box appears. The README file contains late-breaking information regarding the
product that could not be included in the manual. You have the option to read, print, or save the
README file to disk. Make your choice and then click Continue.

6. On the upper left corner of the SETUP window, locate the box labelled Easy Install. Click the do
arrow and choose Custom Install. To remove Ultimate Family Tree from your hard disk, choose
Remove.

7. Select the product or files you want to install: Application Files, Browser Setup, Extensions, Ima
Files, Records Requester, Family Album Maker, Social Security Death Index, Gazeteer.

8. Select Application Files to reinstall the application files only.

Warning If you select Library Files, any existing library files will be overwritten and result in da
loss.

9. Follow steps 4–7 in “Installing Ultimate Family Tree” to complete the reinstallation.

Installing a Browser after Ultimate Family Tree Has Been Installed
1. Insert the Ultimate Family Tree CD-ROM.

2. Double-click the Browser Setup icon in the Ultimate Family Tree folder.

3. Click Next.

4. Select No, please install one for me. The AT&T WorldNetSM Service Software including Netscape 
Navigator™ Internet Browser installation program opens.

5. Click Continue.

6. Read the disclaimer and click Continue.

7. Choose Easy Install and select the folder where you want to install the Browser.

8. Click Install.
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Starting Ultimate Family Tree
Before starting Ultimate Family Tree you should be familiar with your Macintosh and have Ultimate Fa
Tree installed on your computer. 

To start Ultimate Family Tree, follow these steps:

1. Open the Ultimate Family Tree folder.

2. Double-click the Ultimate Family Tree icon. If you are starting Ultimate Family Tree for the first ti
the Ultimate Family Tree splash screen appears, followed by the Welcome window with a mess
stating that Ultimate Family Tree did not find an open project.

3. You are offered the following options:

• New — Begin a new project from scratch

• Open — Open an existing Ultimate Family Tree project

• Quit — Leave Ultimate Family Tree

Figure 1-1: Ultimate Family Tree Folder

Double-click to start
Ultimate Family Tree

Figure 1-2: Welcome Window
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Ultimate Family Tree Desktop Display
Ultimate Family Tree provides two styles for desktop display: custom graphics and Macintosh colors. 
Macintosh colors establishes desktop and window colors from the Color control panel. (If your monito
set to 16 colors, Macintosh Colors are used by default.)

Figure 1-3: Individual Record with Custom Graphics Desktop Display

Open Miscellaneous,
Medical, and Media
windows

Go to top of event list

Move up one event

Move down one event

Go to bottom of event list

Figure 1-4: Ultimate Family Tree with Macintosh Colors Desktop Display

Click to edit event text

Click to edit event evidence
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Using the custom graphics display can reduce the performance of the program. If you suspect 
Ultimate Family Tree is running more slowly than it should, refer to page 163 for instructions on how 
switch to the Macintosh colors mode. Choose the option for Ultimate Family Tree according to your p
sonal preference and system performance.

Note The illustrations in this Guide were made using the Macintosh Colors option.

Creating a New Project
To start a new project in Ultimate Family Tree, follow these steps:

1. In the Welcome window or from the File menu, choose New. A New File window opens.

2. In the Type list, select Ultimate Family Tree and click OK.

3. In the Specify a New Project Name field, enter a name for the new project.

4. Select the folder for the new project. Typically, it’s called Projects. The current folder name app
above the file list.

Note Do not save to a floppy disk. Be sure you have sufficient disk space on the hard drive be
starting a new project. You need at least 2.5 MB of free disk space for every 1,000 individuals.

Figure 1-5: New File Window

Figure 1-6: New Project Name Window

Type project name

File list

Path to file

Save file
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5. Click Save. The project has now been created and the Project Information window is displayed

Note To open the Project Information window at any time, choose Project Info from the File m

6. Enter a short description of the project, such as a family name, on the Description line.

7. Enter the name of the principal researcher for this project in the Researcher field. This field is op
but you can have the researcher’s name appear in the footer on printed reports by typing a nam
and checking the Preparer box in the Page Setup window. See the note below.

8. Enter the address of the researcher. This information can be included in the footer with the pre
name, if you want. You might include “Prepared by:” before the name to have the footer of your
reports printed in this way.

Note To print the relationship of the preparer to the husband and wife on Family Group reports 
Preparer Info is checked, enter the Researcher’s record number in the Researcher # field. For a
project, enter an Individual Record for the preparer and then return here by choosing Project Inf
the File menu.

9. Key Families is a list of surnames in the project arranged in the order of frequency of occurrenc
mate Family Tree keeps track of the number of times each surname is encountered and display
the right of the name. This field is blank for a new project. Click the Update button to update the
Families surname list. When new individuals have been entered into Ultimate Family Tree, choo
Update to get a new count of the surnames.

10. The Comments field displays the source of the data used in this project, including import method
and time. Enter general information about the project in this box.

11. Click OK to close the window and save changes. The Individual Record window appears and y
ready to begin.

Figure 1-7: Project Information Window

The date the project 
was last edited

Update Key Family list

Path to the Project
Control file

Version number of project

Version number of
Ultimate Family Tree
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Opening an Existing Project
To open an existing project, follow these steps:

1. Choose Open from the File menu.

2. In the File Type list, select Ultimate Family Tree and click Open.

3. Select the folder for the existing project. Select the Sample folder if you want to open the Kenn
sample project, or the Projects folder if you’ve already converted or saved a project that you’d li
open.

4. Select the project you want to open.

5. Click Open. The Individual Record window appears and is ready to accept information about an
vidual.

Figure 1-8: Open File Window

Figure 1-9: Open File Window

Path to file
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Getting Familiar with Ultimate Family Tree
You can use your mouse or keyboard to execute most commands in Ultimate Family Tree menus an
dows. To use the mouse, position the pointer over a desired option and press the mouse button. If a s
is required, double-click the mouse button. To use the keyboard, press the appropriate shortcut key.

Menu Bar
The menu bar contains a list of words extending across the main window. It provides easy access to
aspects of the program.

To view a menu, point on the menu name, hold down the mouse button, move the pointer to highligh
choice, and release the mouse button. At certain times during operation of the program, some menu
tions are not available and appear grayed out. At other times, a different set of menu items will appea
depending on your activity in Ultimate Family Tree.

The menu items access a wide range of functions. For a description of each menu item, use On
Help by choosing Help from the Help menu.

Shortcut Keys
Several of the keyboard keys help you enter data more efficiently, find people, and access context-se
help.

Shortcut keys are a combination of the  (Command) key with a letter key. These specialized k
strokes facilitate many essential tasks, such as copy, paste, and help.

Here are some helpful and frequently used shortcuts:

• -A — Select All

• -B — Spell Check

• -C — Copy

• -D — Delete Record

• -F — Find Text

• -G — Find Text Again

• -I — Project Information

• -L — Locate (Find) Individual

• -P — Print

Figure 1-10: Menu Bar

Online help
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• -Q — Quit

• -R — Redo

• -S — Save

• -V — Paste

• -X — Cut

• -Z — Undo

• -/ — Help

See the back of the Ultimate Family Tree User’s Guide for a handy list of shortcut keys.

Reserved Characters
The following characters are reserved for special use by Ultimate Family Tree and must be considere
entering data:

• / — The forward slash is used to mark surnames. Do not use the forward slash character in nam
except to mark the beginning and end of the surname.

• # — The number sign is used in role sentence codes. Do not use the number sign in name, even
place, or date fields.

• { } — Braces are used to mark a title in a person’s name. Can be used in other fields, subject to
restrictions under Rich Text Format listed in the next section, “Rich Text Format Printing.”

Rich Text Format Printing
Rich Text Format (RTF) is a data exchange format developed by Microsoft to allow formatted text to b
moved from one application to another. Fonts, underlining, index information, footnotes, and most oth
mat instructions are preserved. For more information on RTF and printing in Ultimate Family Tree, see 
Section 5. Please be aware of the following special characters:

• \ — The backslash is used for control codes in RTF files. Do not use the backslash character in
mate Family Tree.

• { } — The braces are used for control codes in RTF files. Do not use the left or right brace chara
except to mark a title in a name.

Ultimate Family Tree and WindowShade
The Apple system extension WindowShade is incompatible with Ultimate Family Tree. WindowShade
allows you to roll up an open window into its title bar by double-clicking the window’s title bar. Using W
dowShade in Ultimate Family Tree may cause screen redraw problems. However, it will not corrupt your 
data or cause Ultimate Family Tree to crash.
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Quick Start Tutorial
The Quick Start Tutorial is designed to help you learn how to perform the following tasks:

✓ Add a new individual

✓ Add parents

✓ Create a birth event

✓ Create a marriage event and add a spouse

✓ Create other events such as a graduation

✓ Create a divorce or an engagement event

✓ Move around the Individual Record window

✓ Add evidence and text

✓ Add a child

✓ Add a sibling

✓ View a family in a Family Tree (Pedigree) window

✓ View an individual

For additional hints and tips, see “Did You Know?” on page 20.

Creating an Individual Record
All information about an individual is entered in the Individual Record window. This is a simple, fill-in-
blanks screen where an individual’s name, sex, parents, spouse, children, siblings, and life events ar
entered, as well as any text and footnotes for that person.

Other windows are for medical information and miscellaneous information such as nationality, l
guages, aliases, and social security number. A media window is used to attach images to the individu
record.

In the following exercise, you’ll add a new individual and parents, as well as create birth and ma
events.

Creating a New Record for Yourself
1. If this is a new project, the Individual Record window displays record number 1. If not, click the Indi-

vidual button at the bottom of the Individual Record window to create a new record with the next ava
record number.

2. In the Name field, type your full name given at birth. Ultimate Family Tree automatically marks 
surname with slash (/) characters when you move the cursor to the next field or click a button.

Note See Section 2, page 27 for more information on entering names which include titles.
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3. Set the sex of the individual by selecting Female, Male, or Unknown from the pop-up menu.

4. Choose No, Yes, or Unknown from the Living pop-up menu.

Note Press Tab and Shift-Tab or use the mouse to move from field to field in the Individual Re
window.

Adding Parents
1. Put the cursor in the Father field and type the name of your father. 

2. Press Tab to move to the Mother field and type the name of your mother. If either parent is alre
the project, type the first name of the parent in the appropriate field and click the Find button ne
the Spouse field. A list of everyone with that name will appear in the Candidate Individual windo
Select the correct individual and click OK. 

If you enter a full name in the Father, Mother, or Spouse field for an individual that has already 
entered into Ultimate Family Tree, a message appears when the window is being saved stating that th
has already been entered. If it is a different person, click New. If the person has already been entere
light the person’s name and click List to link that individual. If you want to make changes, click Cance
return to the Individual Record window. To edit the parents’ records, click the associated button to the
of the parent’s name—click Fa to edit the father’s record or Mo to edit the mother’s record.

If a marriage record is not found for the parents, a message appears when saving, “The marriag
for the parents of … has not been recorded. Do you wish to add a marriage event now?” Click Yes to c
marriage, No to save the record without creating a marriage, or Cancel to return to the Individual Rec
window without saving.

Figure 1-11: Individual Record Window

Click to edit event

Create a new
individual

Open father’s
individual record

Open mother’s
individual record

Open spouse’s
individual record

Open event window
(add new event)
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Creating a Birth Event
1. Move the cursor to the Birth event date field.

2. Type your birth date using any format you want. See Section 8, page 164 for information on se
date preferences.

3. Press Tab to move to the Place field and type the place of birth.

Note You can select an event name and click the numbered button to the left of the event nam
open the Events window where you can enter more detailed information. See page 28 for more
mation on the Events window.

Creating a Marriage Event and Adding a Spouse
1. If your spouse is not yet in the project, click the Spouse button at the bottom of the window to cr

new Individual Record along with a marriage record. If a marriage event has not yet been creat
your parents, you are given the option to add one now.

2. A new Individual Record opens. Type the name of your spouse in the Name field.

3. Move the cursor to the date field of the newly created marriage event and type the date on whic
marriage took place.

4. Press Tab to move to the Place field and type the location of the marriage.

5. Click the S button to the right of the spouse’s name field to return to your Individual Record. (For 
tional information, see “Creating a New Marriage Event” on page 33.)

Note Use the transport buttons to the right of the Events list to move up or down the list. An ind
ual can have a virtually unlimited number of events recorded for his or her life. Next to the Place
in the Events list are two columns of status boxes for Event Text and Event Evidence. An X in the sta-
tus box indicates text, evidence, or both are present.

Creating Other Events
1. Click the Event button at the bottom of the window to add a new event. The Events window ope

2. Select any event from the list. To view the entire list of events, use the scroll bar or type the firs
of the event you want.

3. With the event highlighted, type the free-form date in the Date field. The structured and sort date
are automatically calculated and entered when you select another field in the Events window.

4. Move the cursor to the Place field and type the place name where the event occurred.

5. When certain events are created, an event detail line becomes available. For example, in the c
graduation, the detail is the institution or school from which your subject graduated. Type the de
information in the event detail line and press Return. The marriage and divorce events activate 
Spouse field where you can enter the name of the other individual linked to this event.
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6. Click OK to return to the Individual Record window.

These events use the Event Detail field:

Adding Evidence, Text, and Other Information
1. Select the Birth event you created for yourself and click the Text status box to open a window w

you can type free-form notes about this event. Up to 65,000 characters of text can be entered h
Type a few words and click OK to save the data and close the text window. An X shows that text is 
present for this event.

2. Click the Event Evidence status box to open a window where you can enter evidence to suppo
event, such as a birth certificate. (See page 39 for information about entering sources.)

Event Detail

burial cemetery

graduation and education events institution or school

resides street address

resided street address

employment occupation

emigration point of origin

immigration destination

baptism religion

LDS events temple code

Figure 1-12: Events Window

Delete event type

Create custom
event

Event definition

Role definition

Add text about
this event

Add evidence
about this event

Find a place
or person
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3. Click the Text and Evidence buttons on the Individual Record window to type notes about an in
ual (up to 65,000 characters) and attach evidence about that individual. The Individual Text and
vidual Evidence buttons work the same way as the Event Text and Event Evidence status boxe

4. Click the More button to open an Individual More window and then click Miscellaneous to open
Miscellaneous Individual Information window. Record miscellaneous information about yourself
Type your Social Security number in the last field and click OK to close the window.

5. Click the More button, and then click Medical to open the Medical History window in which you 
enter physical details and medical conditions. Click a medical condition to open a second windo
where you can type up to 65,000 characters of information about that condition. Click OK and r
to the original Medical History window. Type your weight, height, and hair and eye color in the P
ical characteristics group. Click OK.

6. Click the More button, and then click Media to open the Media Link window where you can attac
display image files linked to an individual. (See Section 7 for additional information about adding
linking media.)

7. Click Cancel to close the Media Link window and return to the Individual Record window.

Adding a Child
The Children field lists all children of the selected individual.

1. Add a child by clicking the Child button at the bottom of your Individual Record window.

Figure 1-13: Individual More Window

Open Miscellaneous Individual
Information window

Open Medical History window

Open Media Link window

Figure 1-14: Parent Selection Window

Choose to specify a
parent in the list
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2. In the parent selection window, choose the name of the other parent and click Selected. A new 
ual Record window opens with the child’s surname already entered and the parent’s names in t
Mother and Father fields.

Note If the correct parent is not listed in the parent selection window, click None. A new Individ
Record window opens. Enter the correct parent (if known) in the Father or Mother field.

3. Type your child’s given name before the surname in the name field and complete the rest of the
mation. (For additional information on editing children, see “Changing Parents” on page 21.)

Adding a Sibling
The Siblings window lists all siblings of the subject, including half-siblings.

1. From a child’s Individual Record window click the Sibling button at the bottom of the window to 
a brother or sister. A new Individual Record window opens for your child’s brother or sister with 
sibling’s surname already entered, along with your name and your spouse’s name in the parent

2. Complete the sibling’s name field and the rest of the Individual Record.

Note To use the Sibling button on the Individual Record, you must have entered a parent. If yo
not know the parents for a group of siblings, enter a name for the father or mother in one of the 
fields. For example, for an individual named John Smith, you could enter a father or mother named 
Unknown /Smith/, or (-----) /Smith/. See “Adding Parents” on page 27 for more information.

You have just entered three generations of individuals in your project and familiarized yourself w
the Individual Record window. Now you can view your data.

Viewing Ancestors in the Family Tree (Pedigree) Window
1. From the View menu, choose Family Tree to open the Family Tree window, which is also known

Pedigree chart.

2. To locate an individual, choose Locate from the Search menu or press -L to open the Find Ind
window. Type the number 1 and press Return (or click Find) to find your name. Click OK.

The Family Tree window opens with your name in the focus position with generation 1 displ
beneath it. You can view up to five generations of a family at once. Your children are listed at the
left and, if you have entered any of your siblings, they are listed at the bottom left. A plus (+) sig
the left of a name in the Child or Sibling window means that this person has descendants.

The generation number changes depending on the generation of the focus person in relatio
original starting person displayed at the upper left of the Family Tree window.

3. Double-click your name in the upper-left corner of the window to bring yourself back to the focu
position. Click Close to close the window.
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Viewing a Family Group
1. From the View menu, choose Family Group. The husband and his parents (if known) are displa

the top, the wife and her parents are displayed in the center, and their children appear at the bo
the window.

Figure 1-15: Family Tree (Pedigree) Window

Focus person

Scroll down to
other siblings

Return focus to
previous subject

Switch to spouse’s
Family Tree

When green,
indicates that
line continues

Figure 1-16: Family Group Window

View parent’s Family GroupView any additional spouses

Number of children
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2. To change the focus of the window, click the Parents button to move your parents into the Husb
and Wife fields. Select a child in the Child list box and click the Child button to change the focus
that child.

3. Select your name and click Close to close the window.

Viewing an Individual Summary
1. From the View menu, choose Individual Summary to view all the information recorded about you

This window can be sized smaller or larger for ease of reading.

Note Some event details are displayed twice when viewing an Individual Summary. Because t
Individual Summary shows a summary of all the information entered for an event, it displays the
that will be printed in the report as well as the basic data entered in the detail field. What you se
duplicate detail on the computer screen will not print in your report.

2. Scroll through the text to review the information you entered.

3. Close the window by clicking the Close box or by pressing Escape.

If you have entered data for your family during this tutorial session, you can now add to it. If you
would like to delete this tutorial project and start anew, follow the steps in the next section.

Figure 1-17: Individual Summary Window

Close box

Scroll through text
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Deleting a Project
1. Choose Delete Project from the File menu. A warning window opens with this message, “ARE Y

SURE? ### records will be PERMANENTLY deleted if you choose OK.”

2. Click OK.

3. Another window appears with this message, “ARE YOU SURE? This project will be PERMA-
NENTLY erased if you choose OK.” Click OK.

Did You Know?
There are some important features and short cuts built into Ultimate Family Tree designed to make e
your data easy. Read through this section for a description of some of these features. See “Frequent
Questions” in the Appendix for answers to common questions.

Go Menu
The Go menu has two functions. It gives you the ability to move through lists and to quickly return to 
recently edited records. Choose Top to move to the first person in the project. Choose Bottom to mov
last person. Choose Up List or Down List to move to the next person in the list. The person’s position
list is determined by the order in which you last selected and viewed an individual list. If the last list y
opened resulted from a search, the focus will change to those individuals in the search list.

Up to ten individual names are displayed in the Go List. Each time you open an Individual Recor
name of that individual is moved to the top of the list. From the Go menu, choose any name in the lis
return to that individual’s record.

Figure 1-18: Delete Project Warning
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Changing Parents
In the course of your research, you may find that you have the wrong parent(s) attached to a child’s r
To change a parent for a person, follow these steps:

1. From the Build menu, choose Individual Record.

2. To find the individual whose parent(s) you want to change, click the main Name field, and click 
Find button to the right of the Spouse field.

3. Scroll through the list by pressing the first letter of the given name of the person you want to fin

4. Select the name and click OK.

5. Highlight the entire name of the parent you want to change.

6. Press the Delete key on the keyboard.

7. Choose Save from the File menu to save this record.

Note If you attempt to change the parent before saving the record, you’ll get a message statin
the person’s name was and what it is now. You are asked if this is the same person or a new ind
To avoid confusion, save the record after deleting the wrong parent and before entering the corr
ent name.

8. Enter the correct parent by following the steps on page 27.

The New Spouse Button
To enter a new spouse for an individual, choose the New Spouse button. This button automatically cr
new marriage event. An Individual Record window opens allowing you to enter the name and other in
tion for the new spouse. You can return to the first spouse by clicking the S button to the right of the name on
the Spouse field or by selecting the name from the Go menu. The marriage information can be enter
either record.

If the spouse is already in the project, choose New Event rather than New Spouse. Select Marr
from the list and type the first part of the given name in the Spouse field. Click Find to open the Cand
Individuals list with individuals whose names begin with the letters you typed in the list. Select the nam
click OK. If you type the complete name instead of choosing Find, a message appears when you sav
record asking if the person is an existing person from the list. If so, click List. If it is a new person, clic
New.

Changing a Spouse in a Marriage Event
In the course of your research, you may find that you have the wrong spouse attached to a marriage
To change a spouse, follow these steps:

1. Open the Individual Record for the person who is correctly connected to the marriage event.

2. Click the numbered button to the left of the marriage event you want to edit. This will open the E
window.
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3. Highlight the name in the Spouse field and press the Delete key on your keyboard to remove th
spouse.

4. Click Save from the File menu.

5. Type the spouse’s name in the Spouse field. If the spouse is already in your project, enter a pa
name (or simply highlight -unknown-) and click the Find button to open the Candidate Individuals li
Highlight the name and click OK.

Note If you enter a full name in the Spouse field for an individual that has already been entere
Ultimate Family Tree, a message appears when the Individual Record is being saved stating th
name has already been entered. If it is a different person, click New. If the person has already b
entered, highlight the person’s name and click List to link that individual. If you want to make 
changes, click Cancel to return to the Individual Record window. 

Text and Evidence Status Boxes
Event text and evidence can be added in the Events window or in the Individual Record window. Two
umns to the right of the Event Place field in the Individual Record window contain Text and Evidence 
boxes. Click the Text or Evidence status box to open the associated window. An X in the status box indicates
that data is present.

Click the numbered button next to an event name to open the Events window where you can ch
the Text or Evidence button to enter additional information.

Using Undo
If you click the New Individual, New Spouse, New Child, or New Sibling button and decide not to creat
new record, choose Undo from the Edit menu to delete the record and return to the previous record.

Note Undo is not available if the record has been saved. As you enter information, the record 
saved automatically. To delete a saved record, from the File menu, choose Delete Record.

Date Preferences
You can specify the date format for the free-form date field. Set your preference to have dates displa
print exactly as you’ve entered them or set a date format default such as 12 JUL 1943.

From the Utilities menu, choose Desktop Preferences, and then Miscellaneous from the subme
Scroll through the date options and select the format you want. If you select any option other than “A
entered,” modifiers will be converted to full words in the free-form date field, such as ABT to about. Dates 
entered before selecting a date preference are unchanged.

Graphics Display
Ultimate Family Tree provides two styles for desktop display, custom graphics and Macintosh Deskto
ors. The custom graphics mode can reduce the performance of the program. If you suspect that Ultim
Family Tree is running more slowly than it should, switch to the Macintosh Colors mode.
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From the Utilities menu, choose Desktop Preferences and then Miscellaneous from the submen
Choose Use Macintosh Desktop Colors to change to Macintosh colors. Restart Ultimate Family Tree
complete the change.

When you open certain windows while in the graphics mode, the message, “Picture colors may
incorrect. Do you wish to use Macintosh Colors?” may appear. Choose No to ignore the message an
the window. Choose Yes to change the desktop display to Macintosh Colors. Exit and then restart Ult
Family Tree to change to Macintosh colors. This message will appear if your graphics monitor is set 
colors. If your monitor is set to 16 colors, the Macintosh Colors are used.

Editing Place Names
If you want to edit or combine place names, create a new Individual Record for a temporary person. 
“an unknown location” on the birth event field and click the Find button. A list of all places in the Plac
Library is displayed. Scroll through the list to find place records you want to edit. Highlight a place na
and click OK. Edit the place name and choose Save from the File menu or press -S. A message ap
stating that the place name has been changed. Click OK to save the spelling change. Because the P
Library is common to all projects, changing the spelling will change it globally throughout the open pr
and all other projects.

To edit another place, highlight the place name in the Individual Record and press the Delete ke
Choose Save from the File menu and then click the Find button to reopen the Place List. Select anoth
from the list.

Note See page 161 for information on combining duplicate place names.

When you have finished editing place names, choose Delete Record from the File menu to dele
temporary record from the project.

Finding Individuals
There are several ways to find new subjects for the Individual Record window besides using the Find
vidual window.

• Put the cursor in the main name field in the Individual Record window and click the Find button t
right of the spouse field to open a list of all individuals in the project. The list is alphabetical by g
name. Press any letter on the keyboard to move to the given names in the list which start with t
ter. Select a name and click OK to edit that person’s record.

• To choose a name from the Individual List, from the View menu, choose Individual List, then By
name from the submenu. Scroll through the list and double-click a name to open the Individual R
for that person.

• From the Go menu, choose any name to move to that person’s Individual Record. Up to ten of t
individuals edited are displayed in the Go list.

Note See page 76 for information on using the Find Individual window.
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Using Existing Records for Parent and Spouse Fields
If you enter a full name in either the parents or the Spouse fields for an individual that has already be
entered into Ultimate Family Tree, a message appears when the window is being saved stating that th
has already been entered. If it is a different person, click New. If the person has already been entere
light the person’s name and click List to link that individual. If you want to make changes, click Cance
return to the Individual Record window.
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If you completed the Quick Start Tutorial, you know that information about an individual is entered in 
Individual Record window. This is a simple, fill-in-the-blanks screen where an individual’s name, sex,
ents, spouse, children, siblings, and events are entered, as well as any text and footnotes for that pe

The Individual Record window also provides an easy way to navigate through your family from 
ents to children or children to parents. Because of its importance, the Individual Record window is alw
the desktop.

Additional windows are provided for medical information and miscellaneous information such a
nationality, languages, aliases, and social security number. A media window can be opened for attac
images.

In this section you will learn how to:

✓ Enter an individual’s name, sex, parents, spouse, children, and siblings

✓ Enter events and places for an individual

✓ Enter evidence to support your information

✓ Record family stories and anecdotes

✓ Enter miscellaneous information such as aliases, religion, nationality, and more

✓ Enter addresses for creating Mail Labels

✓ Enter medical information about an individual

✓ Display pictures connected to a person or a family
2 5
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✓ Create a Marriage Record

✓ Delete a person’s record, an event, and a place

✓ Create or edit a source and footnote

For hints and tips, see “Did You Know?” on page 20.

Creating an Individual Record
Follow these steps to create an Individual Record:

1. If you are in another window, choose Individual Record from the Build menu. You can also use o
the following methods:

• Select the Individual Record window by clicking on it (if it is displayed behind an open window).

• Double-click a name in a View list.

• Select a name from the Go menu.

2. Click the Individual button at the bottom of the Individual Record window to create a new record
the next available record number. (If you do not want to save this new record, choose Undo from
Edit menu. You will be returned to the last selected individual.)

Figure 2-1: Individual Record Window
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3. With the cursor in the Name field, type the person’s complete name. The name can include give
names, surname, and title in any order. Ultimate Family Tree marks the last name entered as the s
by enclosing it within slash (/) characters. If you enter names in a different order, you can manu
enter the slash (/) characters. If a name is longer than 52 characters, enter a shortened version 
enter a name of up to 65,000 characters in the Long Name text box opened from the Miscellan
Individual Information window. See page 46.

Note Mark a title by enclosing it with braces { } to distinguish it from a surname, for example, John 
/Smith/ {Jr.} or Jane /Smith/, {Ph.D.}. The slashes and curly braces do not appear on printed repo
To remove them from the displayed names in Ultimate Family Tree windows except the Individu
Record window, check the Hide Slashes box in the Name Format window (see page 165). Use 
one set of slash characters in the name field.

4. Next, set the sex of the individual by selecting Female, Male, or Unknown from the pop-up men

5. At the Living field, select No, Yes, or Unknown from the pop-up-menu to indicate whether the ind
ual is still living. If a death event is entered, this field is automatically set to No when you save t
record. This field is optional.

A record number is automatically assigned when a new record is created. You can also choose
own record number (any number between 1 and 9999999). Ultimate Family Tree checks to make sur
number is not already in use before accepting it.

Adding Parents
1. Move the cursor to the Father field and type the father’s name. If the father is already in the pro

type the first few letters of his name (or simply highlight -unknown-) and click the Find button. From 
the Candidate Individuals list, select the correct individual and click OK.

Note The Candidate Individuals list shows individuals in alphabetical order by first name. The 
and death years (if known) and the record number for the selected individual are displayed at th
tom of the window. For two or more individuals with identical names, check the record number a
birth and death dates to be sure you have selected the correct person.

2. Press Tab to move to the Mother field, and repeat the above step.

To edit a parent’s record, click the Fa or Mo button to the right of that parent’s name.
If you enter a full name in the parent field for an individual that has already been entered into Ult

Family Tree, a message appears when the window is being saved stating that this name has already
entered. If it is a different person, click New. If the person has already been entered, highlight the per
name and click List to link that individual. If you want to make changes, click Cancel to return to the I
vidual Record window.

If a marriage record is not found for the parents, a message appears when saving: “The marriag
for the parents of … has not been recorded. Do you wish to add a marriage event now?” Click Yes to c
marriage, No to save the record without creating a a marriage, or Cancel to return to the Individual R
without saving.
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Changing Parents
In the course of your research, you may find that you have the wrong parent(s) attached to a child’s r
To change a parent for a person, follow these steps:

1. From the Build menu, choose Individual Record if the Individual Record window is not already o

2. To find the individual whose parent(s) you want to change, click the main Name field, and click 
Find button to the right of the Spouse field.

3. Scroll through the list by pressing the first letter of the given name of the person you want to fin

4. Select the name and click OK.

5. Highlight the entire name of the parent you want to change.

6. Press the Delete key on the keyboard.

7. Choose Save from the File menu to save this record.

Note If you attempt to change the parent before saving the record, you’ll get a message statin
the person’s name was and what it is now. You are asked if this is the same person or a new ind
To avoid confusion, save the record after deleting the wrong parent and before entering the corr
ent name.

8. Enter the correct parent by following the steps above for adding parents.

Adding Events
Events are added from the Individual Record window.

1. Click the Event button at the bottom of the window, or click the numbered button to the left of a 
“none” Event field. An Events window opens. Events are listed alphabetically, with the most com
events capitalized so they appear first in the list.

Figure 2-2: Events Window
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2. Highlight an event name to select it.

Ultimate Family Tree provides many event types, including ethnic and religious events, from wh
choose. The definition of the event and the person’s role are displayed. Click the Source button to disp
source for a selected event type. Create a new event type by clicking New. (See page 32.) You can d
selected event type by highlighting it and clicking the Delete button in the Event box. Basic event type
as Birth, Marriage, Death, and Burial cannot be deleted. Clicking the Restore button restores previou
deleted event types. The information in the role field changes as you scroll through the events.

To delete an event (or unlink it from the individual), open the Events window for the event and c
the Delete button under the OK and Cancel buttons on the right.

Dates
Dates associated with events are entered in the events window:

1. Enter a free-form date in the Free-form Date field.

2. Move to another field, and confirm the results in the Structured Date and Sort Date fields.

Note When you move to any other field after entering a free-form date, the Structured and Sor
fields are automatically calculated and entered. If you enter only the year in the Free-form Date
Structured Date fields, Ultimate Family Tree sets the sort date to July 1 of that year. If you ente
the month and year, the sort date uses the 15th as the day. The sort date does not print in repo

Dates can also be entered directly in the Date field in the Individual Record window. Dates ente
here are free-form dates. The converted sort and structured dates can be viewed and edited by acce
Events window.

A variety of date types can be entered:

• Free-Form Date — The Free-form Date field permits the date of an event to be entered exactly a
was found in the original source. This field will accept partial or incomplete dates, date modifiers
date ranges in any order.

When typing a free-form date, do not use the number sign (#) in the date field because the n
sign is used internally in Ultimate Family Tree sentence codes. See Section 8, page 164 for info
tion on setting date preferences.

• Structured Date — Ultimate Family Tree converts the date you enter in the Free-form Date field i
several components: a date modifier such as BEF (before), AFT (after), CA (Circa); the day; the 
(three-letter abbreviation such as JAN); and the year. This converted date appears in the Struct
Date field and the Sort Date field. The structured date is used in reports, such as the Pedigree,
space is limited.

•  Sort Date — The sort date, used by the program to establish the order of events, doesn’t appea
reports. Use the sort date to order events where you don’t know the dates but you do know the 
for example, the birth order of children.

If you do not know a date for an event such as a birth, but you do know the birth order of so
one’s children, you can enter an approximate date for the individuals in the Sort Date field. It is i
tant to note that the order of events will be proper, but no dates will appear for this event in repo
because only a sort date has been entered. Enter a full date (MM/DD/YYYY) in the Sort Date fi
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You can edit the structured and sort dates created by Ultimate Family Tree without affectin
free-form date you’ve entered. However, revising and then exiting a free-form date field resets t
structured and sort dates. Dates entered as text (thirteenth) instead of numbers (13) are not co
to the Structured Date or Sort Date fields. In this case, you must manually enter the day in the S
tured Date field. It is then reflected in the Sort Date field.

• Unusual Dates — Because the free-form date field accepts any variation of a date, you can hand
uations that would otherwise be impossible. For example, you can enter Quaker or Jewish date
can also record dates that are normally outside the range of Ultimate Family Tree. Dates must fall b
the limits of 100 AD to 3000 AD to be properly sorted. You can, however, record BC dates, or da
following any other calendar system, in the free-form date field. If you want to record BC dates, 
lish the order of events by using a fictitious year in the sort date field that is within the normal lim
100 AD to 3000 AD. If you choose the year 100 for BC dates, 365 separate BC dates can be en
and ordered properly by assigning each BC date to a unique sort date (for example, 01/01/0100
through 12/31/0100). Using this technique, the order of events occurring before the year 100 ca
established.

• Double Dates — If you encounter dates prior to 1752, double years such as 1725/26 might be lis
This double dating results from an alteration to the calendar. In 1582 it was found that the Julian c
dar, which had begun with Julius Caesar, was inaccurate by 11 minutes and 14 seconds a year a
to the cycle of the sun and moon. In 1582 Pope Gregory XIII corrected the discrepancy. The ca
lost ten days as the Pope decreed that October 4 would be followed by October 15.

Countries accepted the new Gregorian calendar at different times, and England and the Am
colonies did not do so until 1752. By then the discrepancy between the Julian and Gregorian ca
was 11 days. This difference was compounded by the celebration of two New Year’s days by En
and its colonies. The government celebrated New Year’s on March 25, and the masses celebra
holiday on January 1. Depending upon which calendar you used and when you celebrated New
Day, there would be a difference in dating. To satisfy both conventions–until 1752 when the Jan
New Year’s celebration was made official–double dates sometimes were recorded.

You can enter the double date year in the Free-form date field. The double date will print o
reports, such as the Genealogy report. The Structured date will display the second year in the d
date and will print on structured reports such as the Family Group Report.

Adding a Place
To enter a place for an event, move to the place field, type the first few letters of the place, and click th
button if the place you want is already in your project. If the place is not already in your project, type 
entire place name.

Although up to 60 characters can be typed for a place name, a place name of that length will no
play entirely in the place field unless you scroll to the right. Long place names will be abbreviated in 
tured reports where space is limited, such as the Family Tree (Pedigree) and Family Group reports. H
the entire place name will print in text reports such as Family Journal (Genealogy), Text Descendant
Ahnentafel reports.

Note The number sign (#) is used in Ultimate Family Tree role sentence codes. Do not use the
ber sign in Ultimate Family Tree place fields.
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Removing a Place from an Event
1. To remove a place from an event, highlight the entire place name.

2. Press the Delete key on your keyboard, or type a new place name.

3. If you type a new place name, you’ll get a message when saving the record stating what the ev
place was and what it is now. You are asked if these places are the same. If you are just chang
spelling of the name, click Yes. If you want to create a new place, or use the existing place, clic

Editing a Place Name
1. To change the spelling of a place name, highlight the place name in the place name field in the 

ual Record or Events window and type the correct place name.

2. Choose Save from the File menu or press -S to save the spelling change.

3. A window opens stating what the event place was and what it is now. Click Yes to change the n
(For additional information, see page 23.)

Event Details
You can add important details to some events.

When you choose one of these events from the Event Choice list, the Event Detail line, directly 
the Place field, becomes available. Type the detail, such as the name of the cemetery for the burial e
this field. Use up to 32 characters.

Do not use the number sign (#) in Ultimate Family Tree event detail fields as it is used internally
creating role sentences. Instead, use No., Number, etc. to indicate a building or apartment number.

Event Detail

burial cemetery

graduation and education events institution or school

resides street address

resided street address

employment occupation

emigration point of origin

immigration destination

baptism religion

LDS events temple code
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Deleting Event Types
Deleting Event Types from the list allows you to shorten the list to include only those event types that
use on a regular basis. Basic event types such as Birth, Marriage, Death, and Burial cannot be delet

1. Click the Event button at the bottom of the Individual Record window.

2. Highlight the event type in the Event Choices list.

3. Click the Delete button in the Event box.

Note Deleting an event from the list does not affect events you have already entered. If you w
restore all event types, click Restore.

4. Click Cancel to return to the Individual Record without creating a new event for the individual.

Creating a New Event Type
1. To create a new event type, click the Event button at the bottom of the Individual Record.

2. Click New under Event Choices in the Events window.

3. In the New Event Type window, type the name for an event, the name or abbreviations that you w
appear on reports, and the role that the individual plays in this new event.

4. Add a GEDCOM tag for the event and the role. Use any name you want, usually four or five upp
characters, that will be used if you transfer this data via GEDCOM. If the name you choose for 
event tag is already in use as a GEDCOM tag, you cannot use it. Try another.

Note  You can create your own event and role tags for export when Event GEDCOM is selecte
When creating your own tags, start the GEDCOM tag with an underline character, for example,
_MEMSER for an event called Memorial Service. The GEDCOM tag should be somewhat descr
of the event or role. See page 145 for more information about GEDCOM.

Figure 2-3: New Event Type Window

Type event name

Create your own
GEDCOM tags

Create a sentence

Type abbreviations to
be used on reports

Enter role for event

Type verb(s) for your event
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5. Complete the sentence in the Verb box: First name _______ place date. If you are creating a memorial
service event, for instance, enter the words was memorialized on the blank field in the Verb box. The 
role sentence might then read Mickey was memorialized in Windsor, California, May 1, 1996.

6. Complete all fields in the window.

Marriages
You can create a marriage by clicking the Spouse button at the bottom of the Individual Record wind
by clicking Event. In both cases, a marriage event is added.

When you click the Spouse button, a new Individual Record opens where you enter the new spo
you click the Event button, the Events window opens where you can choose Marriage from the Even
In this case, a spouse field appears. The Spouse field is used for engagement, prenuptial agreemen
riage, domestic partnership, annulment, separation, and divorce events. The label for the Spouse fie
depends on the event and the sex of the individual whose record you’re entering.

Some of the spouse titles include:

• Fiancee or Fiancé for engagement and premarriage events

• Bride or Groom for marriage events

• Divorcee or Divorcé for divorce events

• Husband or Wife for LDS sealing of spouse, Get (Jewish religious divorce), and separation event

• Partner1 or Partner2 for a domestic partnership event

• Man or Woman for an annulment

• Novio or Novia for diligencias matrimoniales, matrimonio and velación (Hispanic marriage event

Creating a New Marriage Record
Follow these steps to create a new marriage event if the spouse has already been entered in the Pro

1. Click the Event button at the bottom of the Individual Record window to open the Event window

2. Select Marriage from the Event list.

3. Enter the free-form date.

4. Move the cursor to the place field and enter a place name. If the place has already been entere
project, type a partial place name (or simply highlight an unknown location), and click the Find b
to open the Candidate Places list. Highlight the place name you want to enter for the event and
OK.

5. Type the spouse’s name in the Spouse field. If the spouse is already in your project, enter a pa
name (or simply highlight -unknown-), and click the Find button to open the Candidate Individuals
list. Highlight the name and click OK.
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Note If you enter a full name in the Spouse field for an individual that has already been entere
Ultimate Family Tree, a message appears when the Individual Record is being saved stating th
name has already been entered. If it is a different person, choose New. If the person has alread
entered, highlight the person’s name and click List to link that individual. If you want to make 
changes, click Cancel to return to the Individual Record window.

Changing a Spouse in a Marriage Event
In the course of your research, you may find that you have the wrong spouse attached to a marriage
To change a spouse, follow these steps:

1. Open the Individual Record for the person who is correctly connected to the marriage event.

2. Click the numbered button to the left of the marriage event you want to edit. This will open the E
window.

3. Highlight the name in the Spouse field and press the Delete key on your keyboard to remove th
spouse.

4. Click Save from the File menu.

5. Type the correct spouse’s name in the Spouse field. If the spouse is already in your project, ent
tial name (or simply highlight -unknown-) and click the Find button to open the Candidate Individua
list. Highlight the name and click OK.

Note If you enter a full name in the Spouse field for an individual that has already been entere
Ultimate Family Tree, a message appears when the Individual Record is being saved stating th
name has already been entered. If it is a different person, click New. If the person has already b
entered, highlight the person’s name and click List to link that individual. If you want to make 
changes, click Cancel to return to the Individual Record window. 

Adding Text for an Individual or Event
You can add text for every individual and event. To add text for an individual, click the Text button in t
upper right corner of the Individual Record window. To enter text for a specific event, click the Event T
status box to the right of the event. Alternatively, you can click the numbered button to the left of the e
name to open the Events window and then click the Text button. Enter up to 65,000 characters in any
form text field. Many reports can include individual and event text.

Choose one of the three types of event text:

• Text or Biographical Text — Prints in the body of free-form reports.

• Footnote — Prints selected text as a footnote in reports. The selected text is displayed in the Te
dow, but will print only as a footnote.

• Research Notes — Records information about past, ongoing, or future research on this event or i
vidual.
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You may format selected portions of text in reports using the Font Style Format buttons: Underl
Bold, and Italics. Highlight the text and then click a format button. See “Text Formatting,” below, for m
information.

Do not use the following characters in text because of conflicts with the Rich Text Format (RTF) fe

• \ — Backslash character.

• { } — Left or right curly brace character except to mark a title in a name.

International Characters
To create diacritical marks such as acute accents and umlauts, you must use a special key combinat
example, type letters with acute accents, first press Option-E then release these keys and type the le
want to appear with an accent. For umlauts, first press Option-U then the character you want. (See yoMac-
intosh User’s Guide for more information on other international characters.)

Text Formatting
Use the font style options to instruct Ultimate Family Tree how to display and print the text in reports.
familiarizing yourself with the formatting codes available, you can use the font style buttons or you ca
the codes in the text windows. Formatting codes are displayed in text windows but are not printed in 

Automatic word wrap occurs at the end of lines unless the Enter key is used to end a line. Blan
are preserved in Ultimate Family Tree reports. Press the Space Bar once at the beginning of a new pa
to indent the first line.

The formatting codes appear around the selected text:

• [BO:This text is bold.:BO] This text is bold.

• [UL:This text is underlined.:UL] This text is underlined.

• [IT:This text is italicized.:IT] This text is italicized.

Figure 2-4: Event Text Edit Window

Choose type of event text

Enter free-form text
about an event

Import text from
another source

Format text
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How to Select Text
You can use the mouse or the keyboard to select text. To use the mouse:

1. Position the mouse cursor over the first character to be selected.

2. Press the mouse button and hold it while dragging the mouse across the text to be selected.

3. Release the mouse button.

To use the keyboard:

1. Position the cursor to the left of the first character to be selected.

2. Press and hold the Shift key. Press the Right Arrow key repeatedly until the text is selected.

3. Release the Shift key.

Note Double-click text to select entire words. Triple-click to select entire lines of text.

Checking Spelling
The Spell Check feature includes a dictionary of 140,000 words and 10,000 proper names. You can c
spelling in Edit Text windows and all text data fields.

1. To check spelling in an editable window, click the Spell button, choose Spell Check from the Ed
menu, or press -B.

2. If Spell Check does not find a misspelled word, the Spell Check window does not open. When 
Check finds a word that is not included in its dictionary, the word is highlighted and displayed in
Word In Context box. Highlighted words are shown in lowercase letters but are saved as shown
Replace With Word field.

Figure 2-5: Spell Check Window

Ignore misspelled
(or unrecognized)

Replace misspelled

Edit misspelled word

Replace all
occurrences of 

Add word (or name)
to dictionary

Undo last command

word

word misspelled word
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3. A list of closely matched words is displayed in the Possible Spellings box. If the word you want t
is in the list, select the correct word and click Replace.

4. To edit the misspelled word, click Edit. After editing, click Replace.

5. To stop checking spelling and return to the Edit window, click Done.

The following is a list of buttons in the Spell Check window:

• Add — Adds the word to the dictionary.

• Done — Ends the spelling check.

• Edit — Allows you to edit the misspelled word.

• Ignore — Ignores the current misspelled word.

• Ignore All — Ignores the current misspelled word and continues to check spelling. This word is 
ignored during the rest of the spelling check.

• Look-Up — Checks the spelling of the current text in the Replace With Word field.

• Replace — Replaces the misspelled word with the current text in the Replace With Word field.

• Replace All — Replaces all occurrences of the misspelled word.

• Suggest Words — Updates the Possible Spellings list box with more suggested words.

• Undo — Reverses the last Replace or Replace All command.

Importing External Text 
You can import external ASCII text (up to 65,000 characters) into any Ultimate Family Tree text window. 
The text should not contain any control codes, such as those found in word processor files.

1. Open any Ultimate Family Tree text window by clicking the appropriate Text button.

2. Click Import.

Figure 2-6: Open Dialog Box

Select file

Verify folder
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3. Change to the folder that contains the text you want to import.

4. Highlight the file and click Open.

5. From the Edit menu, choose Select All (or highlight the selected text).

6. From the Edit menu, choose Copy.

7. Close the external text file by clicking the Close box (or pressing the Escape key).

8. Position the cursor in the Text window where you want to insert the text.

9. From the Edit menu, choose Paste.

10. Click OK to close the window and save changes.

Exporting Text
To transfer text to an external text file, use the clipboard. The following method describes how to crea
external text file and copy text from any Ultimate Family Tree text window to this file:

1. Open any text window in Ultimate Family Tree.

2. Select the text you want to export. (See page 36 for instructions on selecting text.)

3. From the Edit menu choose Copy (or press -C).

4. Click OK to close the Text Edit window.

5. From the File menu, choose New.

6. Select Text from the Type list.

7. Click OK.

8. Enter the file name in the File Name field.

9. Select the folder in which you want to place the text file.

10. Click Save to open the new external text file.

11. From the Edit menu choose Paste (or press -V).

12. Click the Close box to close the file. The file is automatically saved.

Evidence
The Evidence window, accessed from the Individual Record and Events windows, provides tools to e
and organize evidence used as proof for information contained in a Ultimate Family Tree project. Evi
can include formal source citations and free-form notes.
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Source Record
The same sources can be used many times in a genealogical project. The source, once entered, is s
the Source Library. Often, however, additional information, such as a page number, is unique in spec
dence. A source that might require additional text makes the Text button available. The additional info
tion must be entered as text. The purpose for this text, originally established by the source type, is sh
the Edit Text window.

A source can be entered into the Source Library either before you add it to an Evidence window
while you are in the Evidence window. Follow these steps to create a source from the Build menu:

1. From the Build menu, choose Source Record.

2. Click New.

Figure 2-7: Evidence Window

Create footnote
from sourceAdd new sources

Add existing source

Displays how
footnote will print
(without codes)

Figure 2-8: New Source Type Window

Sample of selected
source type

List of source types
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3. Select a template from the 47 templates provided in the Source Types list. The Source Type He
at the right side of the window provides a description of the template you select. Click OK.

4. Type Abbreviation 1 and 2 names for the type of source you’re entering. Abbreviation 1 is used to
tify the source in lists. Enter a unique Abbreviation 1 so that the source is easily identifiable in lists.
must create a duplicate Abbreviation 1, be aware of it when you add sources to evidence window

5. Choose the first component (by double-clicking the component, or highlighting it and pressing 
Return), and enter the information about that component in the Component Contents box. Do n
ending punctuation because it is added automatically when the report is printed. Do not add en
punctuation, except for with the Free-form Text source type.

6. Repeat step 5 for the remaining component lines.

7. After completing the components, click Preview to see how your source will look when it’s printe
Look for source components that are incomplete or that need further editing. Make any correcti
the associated Source Component field.

8. Click Close to close the Preview window.

9. Click OK to save the source and to close the Source Record window, or click New to create ano
new source.

Adding Evidence
To enter Evidence for an Individual, click the Evidence button in the Individual Record window. To en
evidence for an event, click the Evidence status box on the appropriate event line or click the numbe
ton to the left of the event name and click the Evidence button in the Events window.

You can create new structured or free-form sources. Existing sources can be also be accessed
ing the Find/Add Structured Source button. Clicking the Footnote button creates a footnote from the 
information you have entered. Click the Edit Source button in the Evidence window to make editing ch
to an existing source.

To add an existing source to the Evidence window, click the Structured button in the Find/Add S
group in the Evidence window. The Add Evidence window opens.

Figure 2-9: Add Evidence Window

Select a source
from the list
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1. Scroll through the list of sources to find the correct source, select it, and click OK. The selected 
is displayed in the Sources Type list in the Evidence window.

2. Click Text in the Edit group (if available) to open the Edit Text window, and then enter the approp
data, such as the specific page number you want to cite for this proof.

Note Do not type ending punctuation because it is added automatically when the reports are p

3. Click OK to close the Edit Text window and return to the Evidence window.

4. Repeat the previous procedure to add additional sources of evidence for proof.

5. Click the Footnote button to create a footnote.

Creating a New Source from the Evidence Window
Sources can also be entered into the Source Library directly through the Evidence window:

1. From the Evidence window, click the Structured button in the Add New Source group to create 
source and add it to the Evidence window.

2. In the New Source’s Type window, select a source type. If the specific source type you want is 
the list, choose Free-form Text from the list. Help for the Source Type is displayed in this windo

3. Click OK.

4. Type the Abbreviation 1 and Abbreviation 2 names. Help for the type you have selected is displa
the Help for Type box.

5. Choose the first component (by double-clicking, or highlighting and pressing Enter), and type th
information about that component in the Component Contents box. Do not add ending punctuat
the component lines except for with the Free-form Text source type, because it is added autom
when the report is printed.

Figure 2-10: New Source’s Type Window

Selected source type

Description and sample
of selected source
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6. Repeat step 5 for the remaining component lines.

7. Click OK.

8. Click Text in the Edit group (if available) to open the Edit Text window, and then enter the approp
data, such as the specific page number you want to cite for this proof (for example, page 20). Do not 
type ending punctuation.

9. Click OK to close the Text window and return to the Evidence window.

10. Repeat the above procedure to add additional sources of evidence to the Evidence List.

11. Click the Footnote button to create a footnote.

Creating Free Notes
Use Free Notes as evidence in a proof.

1. To add a Free Note to the Source List, click the Free-form button in the Evidence window.

2. Enter the Free Note in the Edit Text window and use formatting buttons if desired.

Note Ultimate Family Tree does not add ending punctuation to Free Notes. Add ending punctu
to the Free Note, if desired.

3. Click OK to save any text entered and return to the Evidence window.

Creating Footnotes
Evidence that is formatted as a footnote will appear as End Notes. Evidence that has not been forma
footnotes will not appear in reports.

1. In the Individual Record window, click the Evidence button or Evidence Status box for an event

2. After adding a source, click the Footnote button in the Save/Build group to create a footnote.

Figure 2-11: Evidence Window

Add a Free Note
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footnote will print
(without codes)

Format a footnote
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Note The footnote appears in the Footnote box. You can customize the footnote for printing if n
sary. See Customizing a Footnote, below.

3. Click OK to save and close the Evidence window.

Customizing a Footnote
Customizing footnotes is not necessary, but you might want to rearrange footnotes for printing.

1. Create a footnote. (See “Adding Evidence” on page 40.)

2. Edit the footnote as follows:

• Enclose each Source or Free Note in your footnote in code brackets, for example, [FR: :FR] or 
[SO#: :SO]. The pound symbol (#) represents the record number of the evidence for that source

• Do not change formatting inside the SO: source code brackets. When Ultimate Family Tree prints a
footnote, it reconstructs the footnote from the sources in the Source Library and from Free Note
text added to sources. Changes made within the Source or Free Note code brackets in the Foot
window are not reflected in the Source Library record or the Added Text window, and will not be
included in end note reports.

Formatting is added automatically to text within the source code brackets according to the s
template in use. You can, however, manually customize the formatting in a footnote outside the 
code brackets by typing the format codes before and after the appropriate text. For example:

[BO:This text is bold.:BO] This text is bold.

[UL:This text is underlined.:UL] This text is underlined.

[IT:This text is italicized.:IT] This text is italicized.

Note Do not type directly into the Footnote text window. Any text you typed will be deleted whe
you rebuild footnotes using the automatic Rebuild Footnote option in the Check window, when y
add additional text to this window, or when you click the Save/Build Footnote button. See page 1
more information on using Check.

• You can Cut and Paste text inside the footnote to customize the way it displays and prints, as lo
you move sources and free notes with their codes.

3. Click OK to save your changes and close the Evidence window, or click Cancel to close the Ev
window without saving changes.

Editing a Source from the Evidence Window
To edit an existing source from the Evidence window, select the source and click the Source button in
Edit group.

Note Any changes made to the source record will affect all footnotes using this source.
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Deleting a Source from the Evidence Window
1. From the Source List in the Evidence window, select the source to be removed for an individual o

2. Click Selected in the Delete group, or click All to delete all evidence.

3. Click OK to delete the source and footnote reference (if present), or click Cancel to return to th
dence window without deleting the source.

Adding Children
The Children box on the Individual Record window lists all children of the subject.

1. In the Individual Record window, double-click a child’s name to make that person the subject of
Individual Record window. If you want to make a parent or spouse the subject, choose the appr
button to the right of his or her name.

2. To enter a new child for a selected individual, click the Child button at the bottom of the window

3. In the Specify Other Parent window, select the other parent for this child. Click Selected. A new
vidual Record window opens for that child with the child’s surname already entered in the name
and the child’s parents (if known) already in the Mother and Father fields. Type the remaining in
mation. If you choose not to create this new record, choose Undo from the Edit menu. You will b
returned to the last selected individual. If the other parent is not listed, click Cancel or None in th
ent window. A new Individual Record window opens showing the parent. Enter the other parent 
appropriate parent field. (For additional information, see “Changing Parents” on page 28.)

Adoption
Ultimate Family Tree provides ways to indicate that a child is adopted. Begin by entering the adoptive
ents as the Father and Mother in the child’s Individual Record window. You then can add an adoption
for the child with information concerning the birth parents (if known), or the adoption itself, in the Eve
Text window. Another method to indicate adoption is simply to use the Miscellaneous window to add 
“adopted” flag for the child.

Figure 2-12: Other Parent Window

Click to choose other
parent from list
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Children of Unmarried Parents
A marriage is not required to connect parents to their children. In addition, you can enter one parent 
other parent is not known. When reports print for these families, no mention of the unmarried status i
printed (unless you use the Unmarried event or include the information in the Individual or Event Tex
windows).

Adding Siblings
The Siblings window lists all siblings and half-siblings of the subject.

1. From the Individual Record window, add a brother or sister for that person by clicking the Siblin
ton at the bottom of the window. A new Individual Record window opens for a brother or sister w
the sibling’s surname already entered, along with parent names.

2. Complete the sibling’s name field and the rest of the Individual Record. If you choose not to crea
new record, choose Undo from the Edit menu. You will be returned to the last selected individua

To use the Sibling button on the Individual Record, you must enter a parent. If you do not know
parents for a group of siblings, enter a name for the father or mother in one of the parent fields. For ex
for an individual named John Smith, you could enter a father or mother named Unknown /Smith/, or (-----)
/Smith/.

Additional Information
Ultimate Family Tree provides a way to add additional information for an individual. In the Individual 
Record window, click the More button to open the Individual More window. A green indicator next to t
button shows if information is already present.

Click Miscellaneous to open the Miscellaneous Individual Information window where you can reco
information such as aliases, nationality, languages, individual flags, ancestor and descendant interest le
Social Security number. Click Medical to open the Medical History window where you can enter informa
about the individual’s physical characteristics (height, weight, skin, eyes, hair, etc.) as well as any know
ical conditions. Click Media to attach images from the Media Library to the individual you’re editing.

Figure 2-13: Individual More Window

Open the Miscellaneous
Individual Information window

Open the Medical History window

Open the Media window
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Miscellaneous Individual Information
Ultimate Family Tree provides a way to add miscellaneous information for an individual. In the Individ
Record window, click the More button, and then click Miscellaneous to open the Miscellaneous Indivi
Information window.

• Long Name — Opens a text window for entering a name of up to 65,000 characters for the selec
individual. The long name is not displayed in Build or View windows, but is used in Family Journ
(Genealogy) reports. Remember to use slash characters (/) to define the surname and curly bra
to define a title.

• Mail Label — Opens the Mail Label window where you can enter an address of up to 34 characte
line and a telephone number for the individual. You can specify mailings such as a newsletter to
to this person. (See page 109 for more information about printing mailing labels.)

• Interest Level — Optional Ancestor and Descendent Interest levels are required in Tiny-Tafel rep
The Tiny-Tafel is a summary of your research interests that can be distributed to others so you c
people who are researching family lines in which you have an interest. Ultimate Family Tree int
designations are as follows:

0 People who will not be used to establish a family line.
1 People in whom you have no further interest or for whom your data is marginally reliable

and therefore of no interest to anyone else. These people can be included in a Tiny-Tafel
for reference to establish a family line.

2 People in whom you have little interest, but your data is a high quality and might be of
interest to another researcher.

3 People in whom you have moderate interest. The data is either good or poor.
4 People in whom you have great interest. The data is good or poor.

Figure 2-14: Miscellaneous Individual Information Window

Open a long name
text window

Open a mail
list/label window

Alias names

User-defined flags
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• Individual Flags — Flags designate special information that you might want to include in your 
project. Ten flags are available for each individual. They can be defined differently for each indiv
Examples of possible flags include attendance at a certain college, needs more research, or ca
death. Up to ten characters of text can be entered in each Flag field.

• Birth field — Enter N(ormal), T(win), M(ultiple), S(tillborn), I(llegitimate), L(egitimate). This field i
optional.

• Immigrant — Check this box if the individual you are entering was an immigrant. The Immigrant fi
is used in Family Journal reports to establish the correct generation number reference.

A person identified as an immigrant in the Miscellaneous Individual Information window is n
bered as generation 1 in Family Journal reports. In Descendant Family Journal reports, each ge
tion of this individual’s ancestors is identified with an alphabetic character beginning with A, while
descendant generations are assigned the usual generation numbers, beginning with 2. In Reve
ister Family Journal reports, opposite from Descendant reports, each generation of descendant
given an alphabetic character, beginning with A, while the ancestor generations are each assigned 
generation number beginning with 2.

• Last Edit Date — The last edit date is the date this record was last saved. Ultimate Family Tree u
your computer’s system date. The last edit date cannot be changed manually.

• Reference — If you have your own system for referencing and would like to use it, enter your dat
the Reference field. Any combination of letters, numbers, and punctuation marks can be used u
characters.

• Common Name — You can enter a commonly used name such as Johnny or Mary Jo. This name prints 
instead of the first name in reports where first names print without a surname. If a report has lim
space for an individual’s name it is truncated and the common name is substituted for the first n
For example, if Mary Jo is not entered here, Ultimate Family Tree uses Mary as the first name.

• Alias 1 — First alias for the individual. This is a good place to record a woman’s married name, 
French Canadian dit name, nickname, or the way you’d like a person’s given and surname(s) to ap
in printed reports. Remember to use slash characters (/) to define the surname and curly brace
define a title.

• Alias 2 — Second alias for the individual. Use slash characters (/) to define the surname and cu
braces { } to define a title.

For printed reports, Ultimate Family Tree provides choices for names in the Page Setup wi
For example, you can choose Alias 1 as the first choice and Main (the Individual Record name)
second choice. Ultimate Family Tree uses the Alias 1 name if it is present and then, if it’s not pr
the Individual Record name. The name choice is useful if you want to use a name other than a 
name on printed reports. The name you designate as your first choice is the one used by Ultima
ily Tree. The name options are Main, Alias 1, Alias 2 and Religious name.

• Signature — How the individual signed his or her name, for example, M. A. Smith.

• Nationality — Nationality of this individual.
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• Language 1 — Primary language for this individual.

• Language 2 — Second language for this individual.

• Religion 1 — First religion for this individual.

• Religion 2 — Second religion for this individual.

• Religious Name — Religious name for this individual. Use slash characters (/) to define the surna
and curly braces { } to define a title.

• Web Link — The Universal Resource Locator (URL) that links an individual to any other Internet U
in an Instant Web Page. This link can be to images, sounds, or other genealogies. For example, 
link John F. Kennedy to a genealogy at another Web site. If this genealogy were to be found at 
http//www.anothersite.com/jfk.html, you could enter this address in the Web Link field for John F. Kenne
Someone browsing your genealogy could then click on the link to move to the new page for JFK
link is included in Instant Web Pages.

• Ances. File # — Identifying number for LDS Ancestral File.

• Social Security No. — Individual’s Social Security number.

Mail Label
Open the Mail Label window by clicking the More button in the Individual Record window. Click Misce
neous, and then click Mail Label in the Miscellaneous Individual Information window. Use the Mail La
window to enter an address and phone number for the individual. There is also a list you can use to de
specific mailings. The name entered in the addressee field can be different from the name in the Indi
Record window, such as Mr. and Mrs. Thomas Smith.

1. Enter a name and address for the individual on the appropriate lines. You can enter up to 34 ch
per line.

2. Designate specific mailings to send to this person, such as a newsletter. Check any of the appr
option boxes.

3. Click OK to return to the Miscellaneous Individual Information window.

Figure 2-15: Mail Label Window

Name and addresses

Phone number

Check boxes to include
individual on special
mailing lists
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Medical History
Click the More button in the Individual Record window, and then click Medical to open the Medical His
window.

You can enter information about the individual’s physical characteristics (height, weight, skin, ey
hair, etc.) as well as any known medical conditions.

Clicking a medical condition opens a free-form text window where you can enter up to 65,000 c
ters of information. Click the Other button at the end of the list of medical conditions to add any medi
conditions not listed in this window.

Figure 2-16: Medical History Window

Open a medical
condition text
window

Enter physical
characteristics
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Media
Click the More button, and then Media to open the Media Link window where you can attach images
the Media Library to the subject individual.

1. To add an image, in the Add Media Link group, click Existing Media to open a Media Select win

2. In the Media list, highlight the item you want to add and click Add to copy it to the Linked Media

3. Click OK.

4. Click OK to close the Media Link window.

See Section 7 for more information on the Media Link window and building a Media Library.

Figure 2-17: Media Select Window

List of existing media

Description of
selected media

Add selected
media to list

Linked media list
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Use the View menu to choose ways to display information you have entered in your project. The follo
formats are available: Family Tree, Family Group, Individual Summary, Descendants, Kinship, Name
Record No, Slide Show, Photo, and Lists. Use the list windows to display information about individua
marriages, and sources in table (row and column) format. Use lists to help analyze data in your proje
well as to locate records for editing.

You will learn how to:

✓ Move around the Family Tree window displaying up to five generations per screen with pictures

✓ Display a Family Group window

✓ View all information entered about an individual in story form

✓ View the descendants of a selected individual

✓ Determine the relationship between any two individuals in your project

✓ View a slide show for an individual or family

✓ See a person’s full name and record number

✓ View all individuals in your project by record number, surname, given name, or birth date

✓ View a list of marriages in your project organized by surname, given name, date, or place

✓ View the list of sources in your Source Library
5 1
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Family Tree (Pedigree) Window
The Family Tree (also known as Pedigree) window displays up to five generations of a family. This w
can be used with other windows, such as the Individual Record window, to discover more about sele
family members.

1. Choose Family Tree from the View menu.

Note The indicator in the far right column will be on (green) if that line continues. A plus sign (+
displayed to the left of a subject’s child or sibling if that person has descendants.

2. To change the focus of the Family Tree, you can do any of the following:

• Choose Locate from the Search menu (or -L) to select an individual as the focus.

• Double-click a name to make that person the focus.

• Click Previous to move back to the previous subject.

• Choose a focus from the child list (by double-clicking). Use the scroll bar to move up and down a
list of children, or click once on any child and use the Up and Down Arrow keys to move through
list. Type the first letter of a name to move up or down the list to names beginning with that lette
number of children in the list is shown at the top of the list. Highlight a child’s name and choose

Figure 3-1: Family Tree (Pedigree) Window

Focus person

Switch to spouse’s pedigree Return focus to previous subject

Indicates line
continues when
green
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Individual Record from the Build menu to display the Individual Record for the selected child. W
you return to the Family Tree window, that child will be the focus.

• Double-click a sibling to make that person the focus. All siblings are listed, including those who
only one parent in common. Use the scroll bar, the Up and Down Arrow keys, or the first letter o
name to move up and down the Siblings list. Choose Individual Record from the Build menu to 
play the Individual Record window for a selected sibling.

3. Click the Spouses button to display spouses of the focus person. Click Cancel to return to the F
Tree window for the original person, or OK to return to the Family Tree with the selected spouse 
new subject. Click Edit in the Spouses window to open the spouse’s Individual Record window.

Note To return the focus to the original individual, double-click his or her name at the top of the win

4. Click Photo to display the preferred image (if any) for the selected individual. See page 136 for
mation on selecting a preferred image for someone.

5. Click Close to close the Family Tree window and return to the Individual Record window. The la
selected individual in the Family Tree window will be the new focus of the Individual Record.

Family Group Window
The Family Group window displays a family unit including a husband, wife, their parents, and their 
children.

1. Choose Family Group from the View menu.

Figure 3-2: Family Group Window

View any additional spouses

Marriage date and place

Number of children

View parents’ family group

Focus person
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Note If a marriage record for the husband and wife is found, the date and location of the marri
shown in the center of the Family Group window. Otherwise, you’ll see “marriage record not fou
Parents who are not married or do not have a marriage record are considered parental partners
children for this husband and wife are shown in the list box next to Child and the number of child
displayed under Child. This list contains all common children for this couple. Use the scroll bar o
Up and Down Arrow keys to move up and down a long list of children. You can also type the first 
of the name to move down the list to that child’s name. A plus (+) sign in front of a child’s name
cates that his or her descendant line continues. Type a plus sign to move up or down the list to 
with a plus sign.

2. To select a new focus, choose Locate from the Search menu (or -L). Remember, you can cho
Individual Record from the Build menu if you’d like to display the Individual Record window for t
or any selected individual.

3. Click +Wives or +Husbs to display a list of spouses or parental partners. Select a spouse or pa
partner from the list to display his or her associated family, or click Cancel to return to the Fami
Group window. These buttons are dim if no other spouses are found.

4. Click Parents to display the family for the husband’s or wife’s parents. These buttons are dim if n
ents are found.

5. To shift the focus forward one generation, highlight the child in the child list box and click the C
button, or double-click the child. When “no children” appears in the Child list box, the Child butto
dim.

6. Click Photo to display the preferred image (if any) for the selected individual.

7. Click Close to close the Family Group window and return to the Individual Record window.

Individual Summary
To view all the information you’ve entered for an individual, follow these steps.

1. Select an individual in any window, and then choose Individual Summary from the View menu.

Note The selected individual’s information is displayed in story form. Individual text, plus footn
and research notes, are shown in their entirety. Information in the Individual Summary window c
viewed but not edited. To change information appearing in the Individual Summary, edit the info
tion in the Individual Record window.

2. To close the Individual Summary window, press Escape or click the close box.

Note Some event details might be displayed twice. This is normal.
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Descendants Window
The Descendants window shows a list of descendants, one generation at a time, for a selected individ
example, you can use the Descendants window to view all grandchildren of the focus person. Up to 1
erations can be viewed.

1. Choose Descendants from the View menu.

Figure 3-3: Individual Summary Window

Click to close window

Figure 3-4: Descendant Window

Select a generation number
to view descendants in a
specific generation

Descendants of focus person

Generation number,
number of individuals

Parents of selected person

Focus person
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2. To choose a new focus for the Descendants window, choose Locate from the Search menu (or -L

3. Choose a generation number from the Generation Gauge on the left side of the window to view
descendants in a specific generation. To choose a generation number, highlight the number or 
responding number line in the gauge.  Alternately, you can click the gauge and use the Up and 
Arrow keys.

4. Use the scroll bar if the list of descendants in a generation is longer than the box. Individuals in
generation are shown in alphabetical order by given name. The number of persons in that gene
are shown above the list, as is their relationship to the ancestor. The parents of the focus person
played at the bottom of the window.

Note To edit an individual record, select the individual and choose Individual Record from the B
menu to open the Individual Record window.

5. Click Close to close the Descendants window.

Kinship
You can find the relationship between any two individuals through birth or marriage. If a relationship e
Ultimate Family Tree displays a list of common ancestors. The relationship between the selected indiv
is computed through 16 generations.

1. Choose Kinship from the View menu.

2. Start with subject 1. Uncheck subject 1’s Lock button if it is checked. Choose Locate from the S
menu (or -L) to find a new individual. Click OK when done.

Figure 3-5: Kinship Window

Relationship of
individuals 1 and 2

Common ancestors

Select to view how the
individuals are related

Lock in selected individual

Select to view
redundant ancestors
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3. Check Lock to lock in subject 1.

4. Uncheck the Lock button for subject 2. Choose Locate from the Search menu (or -L) to find s
2 for the relationship check. When the person is found, click OK.

Note You must unlock a subject before the Find Individual feature will work. Be sure to lock 
subject 1 before moving on to subject 2.

5. Click Start to compute the relationship between the two subjects.

6. The Related Thru group displays how the two individuals are related through birth or marriage, a
as any events they may have in common.

• Select Birth to find a blood relationship.

• Select Marriage to display relationships through marriage.

• Select Events to display the events that the two individuals have in common.

7. To find the nearest common ancestor of the two subjects, select Birth from the Related Thru gro
Nearest in the Show group.

8. Select Redundant1 from the Show group to display the redundant ancestors and the number of
tions from subject 1 to all individuals in the list. To display the redundant ancestors and the num
generations to subject 2, select Redundant2.

Note Birth must be selected to access the Redundant options. Redundant ancestors occur wh
is more than one line from an individual to his or her ancestor. Redundant lines result when cou
marry. If subjects 1 and 2 have common redundant ancestors, the number of generations to bo
played. If the number 999 is displayed after an individual, there is no relationship between the se
subject and the individual in the list.

9. Select Generation from the Number group to display the number of generations from each ance
each subject. The resulting Relationship list contains the nearest common ancestors of the two
jects, and the number of generations from subject 1 and subject 2. This is the default selection 
the Kinship window is first opened. Birth and Nearest must be selected to access the Generatio
option.

10. In the Number group, select Ahnentafel to display the Ahnentafel number for subjects 1 and 2. 
and Nearest must be selected to access the Ahnentafel option.

11. To display the degrees of consanguinity (kinship) between each ancestor and subject, select C
from the Number group. Birth and Nearest must be selected to access the Consan option.

12. Click Close to close the Kinship window.
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Name and Record Number
Choose Name + Record No from the View menu to display a selected individual’s full name and reco
number. Click OK to close the window.

Slide Show
Use the Slide Show window to view slide shows that you have created. See page 138 for steps on cr
slide show.

1. Choose Slide Show from the View menu to open this window.

2. Click Selected to view the show you highlighted or All to view all of the shows.

Viewing a Photo
Choose Photo from the View menu to display the preferred image for the selected individual. If no im
linked to this individual have been selected as the preferred image, this feature is not available. See p
for instructions on selecting a preferred image.

Individual, Marriage and Source Lists
• Individual List — Displays a list of all individuals in your project. Choose Individual List from the 

View menu and choose one of the options: By Record Number, By Surname, By Given Name, o
Birth Date.

Figure 3-6: Slide Show Window

List of slide shows
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• Marriage List — Displays a list of the marriages in your project. Choose Marriage List from the V
menu and choose one of the options: By Husb. Surname, By Wife Surname, By Husb. Given, B
Given, By Date, or By Place.

• Source List — Displays a list of all your sources in the Source Library.

1. To open the right side of a List window, position the cursor on the resize box on the lower-right c
of the List window, hold down the mouse button, and drag the pointer to the left. When the right
of a List window is opened, the information in a record is displayed vertically and you can view 
fields in that record. 

2. When text is available in a text or note field, you’ll see Memo in the list with an uppercase M. When no 
text is available, memo is displayed with a lowercase m. If text is available, you can view the text by 
pressing -PgDn with Memo selected.

3. Text in List windows can be viewed, but not edited. To edit text, events, sources, or other inform
displayed in an Individual List window, select the individual’s name and choose Individual Reco
from the Build menu to open the Individual Record window. Click the appropriate button to acce
text, event, or source windows and make editing changes. In a Marriage list, double-click to ope
Individual Record for the person on the left side of the list. In a Source list, double-click a select
field to open the Source Record window.

Note Use the vertically positioned arrows to scroll up and down the list. Use the arrows along 
bottom of the window to scroll horizontally through the list.

Figure 3-7: Individual List Window

Use arrows to
scroll horizontally
through list

Hold mouse
button here and drag
pointer to the left
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Section 4:

Searching for Individuals
oject. 
Ultimate Family Tree provides a powerful set of search routines designed to locate individuals in a pr
In this section you will learn how to locate individuals by:

✓ Name and/or SOUNDEX code

✓ Citations

✓ Events in an individual’s life

✓ User-defined flags

✓ Mailing label information

✓ Linked pictures 

✓ Information contained in the Medical window

✓ Information contained in the Miscellaneous window

✓ Relationships

✓ Biographical, research or footnote text

✓ Event details

✓ Vital statistics

✓ Record number or part of the name
6 1
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Using Search Windows
Each Search window provides options for defining the scope of your search. Ultimate Family Tree loca
records for which the contents of the specified field matches the search criteria. Information entered 
Search window is retained when you close the window. You can close a Search window, and then op
again to conduct another search using either the same or modified search criteria.

Search windows contain a pop-up menu with the following options:

• Replace the list with those found — Starts a new search list. This option replaces an existing search
with the results from the current search. Individuals already in the list are removed, and the new
saved.

• Add them to the name list — Builds a composite list from two or more searches. This option adds 
results of the current search to an existing search list. For example, if five individuals are already
list from a previous search, and seven new individuals are found and saved with this option, the
list will contain 12 individuals.

• Remove them from the name list — Narrows an existing search list. This option removes the results
the current search from an existing search list. If five individuals are in an existing list, and two i
viduals from a new search are already in that list, they will be removed. The new search list will
tain three individuals.

• Keep if already in the name list — Matches items in an existing search list. This option keeps the 
results of the search if they are already in the existing search list. If five individuals are in an ex
list and a new search finds two who are already in that list, the new list will contain two individua

Other options common to all search windows are:

• Close — Closes the search window

• Search — Creates the Search list

• Results — Views the results of the last search

• History — Shows how the search list was built

• Group — Replaces the Grouping List with the results of the selected search

• Preview — Displays the results of a search without committing the results to the search list

Steps for Completing a Search
The following basic steps are used to conduct a search.

1. Open any search window from the Search menu.

2. Make selections for defining the search. The search criteria are shown at the top of the search 
as you make your selections. This information is also added to the History window after a searc
complete.
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3. Choose one of the options (Replace, Add, Remove, or Keep) from the pop-up menu at the bott
the window for the desired Search list.

4. To check the search without committing the results to the search list, click Preview. Press Esca
return to the Search window.

5. Click Search to create the Search list and view the results.

6. Click Group to replace the Grouping List with the results of the current search.

7. Click Close or press Escape to close the Search Window.

Note Click Results to show the last completed search list. Double-click any name to open the 
vidual Record for that person. Click History to see a summary of how the Search List was built.

Name Search
You can locate a person in a Ultimate Family Tree project by name or names. Various options provid
bility in defining the Name search. The following rules apply when entering names in the Name Sear
Find Individual windows:

• Name searches are not case sensitive—use uppercase or lowercase letters. 

• Enter more than one name for a person if you want to be specific. For example, if you are looki
John Fitzgerald Kennedy in your project, you can type john fitzgerald in the top field.

• Type either full or partial names. For example, you can type hn fit to locate John Fitzgerald Kennedy.

• Use special characters called wild cards. The question mark wild card character (?) is used to repres
a single unknown character. For example, jo?n finds the names John and Joan. The asterisk wild card (*) 
is used to represent more than one consecutive character. For example, ho*r finds Howard and Homer.

Figure 4-1: Name Search Window

Conduct search

See search list

See list of all steps taken
to create the search list

View a preliminary search
list without committing the
results to the permanent
search list

Search options list

Move contents of search
to Grouping List
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• Use forward slash characters (/) to specify surnames. For example, by typing /smith/ you find all those 
individuals having the surname Smith. If you enter smith without slash characters, Ultimate Family 
Tree finds all individuals whose names contain smith anywhere in their names.

• Use braces {} to specify titles. For example, typing {Sr.} finds all those individuals having the title Sr.

• Search for surnames in the top text field of each name specification box by SOUNDEX code. E
surname without the slash characters or a valid SOUNDEX code in the first name field. If you e
surname, Ultimate Family Tree converts the name to the SOUNDEX code for that name, and re
the name in the text field with the code.

Note SOUNDEX is a code used by the United States Government to index early census record
used to find names with the same sound, no matter how they are spelled. Each SOUNDEX cod
made up of a letter and three numbers. The letter is the same as the first letter of the surname.

Searching for a Simple Name
1. Choose Names from the Search menu.

2. Type a name in the first name field of the top Name Search box. Use wild cards if desired and a
combination of uppercase and lowercase letters.

3. Complete the search as described on page 62, “Steps for Completing a Search.”

Searching for a Surname by SOUNDEX
1. Enter a surname (without slashes) or a valid SOUNDEX code in the top name field. If you ente

name, Ultimate Family Tree converts the name to the proper SOUNDEX code for you. (The SO
DEX search only finds surnames.)

2. Check the SOUNDEX box in the appropriate Name Specification box.

3. Make sure all other name fields are empty.

4. Complete the search as described on page 62, “Steps for Completing a Search.”

Figure 4-2: Name Search Window

Type name here

Check here to exclude
names containing
characters entered below

Check here to search
by SOUNDEX code
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Completing a Complex Name Search
1. Enter the search information using any combination of the four name fields available. Select the

SOUNDEX and the NOT conditions that you want to use. The two name fields in each Name S
cation box are used together.

2. Check the NOT box to exclude names from the search.

Note The characters entered in both fields must be present in an individual’s name for that indiv
record to be included in the search list. If the OR name specification fields (lower name specific
box) are used with the upper name specification box, a record must match one or the other to b
included.

3. Specify surnames by using the forward slash, for example, /Smith/, and titles by using braces, for 
example, {Jr.} .

4. Complete the search as described on page 62, “Steps for Completing a Search.”

Searching for Individuals Linked to Citations
The Citation Search locates individuals who are connected through a citation to specific sources in th
Source Library. Open the Citation Search window by choosing Citations from the Search menu. The C
Search window contains a list of all sources in the Source Library, and options to narrow your search

The search criteria are displayed at the top of the search window as you make your selections.
information is also added to the History window after a search is complete.

1. Select the Any radio button in the Source group or the Selected button to match only a specific 
in the search.

2. If you chose Selected in step 1, select the source you want to include in your search from the S
List. The Source List includes all the sources in the Source Library. The list shows the Abbrevia
name for each source.

Figure 4-3: Citation Search Window

Search for individuals
with citations

Search for events
with citations

Search for all citations
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3. Narrow your Citation search by specifying where the citation was used. Three location options 
provided:

• Individuals — Searches for the selected source when used in citations for information in the Indiv
Record window

• Events — Searches for the selected source when used in citations for events

• ALL — Searches for the selected source when used in any citation

4. Complete the search as described on page 62, “Steps for Completing a Search.”

Individual Events Search
The Individual Events Search looks for individuals connected to events in your project based on the e
entered in the Individual Record window. The search criteria are displayed at the top of the search win
you make your selections. This information is also added to the History window after a search is com

1. Choose Events from the Search menu.

2. Select Selected Event or All Events in the lower-left corner of the window.

3. If you chose Selected Event in step 2, select an event from the Possible Events list that shows 
event types used in the current project. Scroll through the events using the Up and Down Arrow
or by typing the first letter of the event you want to search.

4. To search for events that happened in a selected place, check Selected in the Places group, an
click Place to open the Find Place window. If you are not including places in the search criteria, s
step 9.

5. Type in the first few characters in a place name.

Figure 4-4: Individual Events Search Window

Select to search on
a specific event

Select to search on
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Type in before and
after dates to limit
a search
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6. Click Exact for all place names with an exact match or click Like and use any characters includ
wild card characters. The question mark wild card (?) is used to represent a single unknown cha
The asterisk wild card (*) is used to represent more than one consecutive character.

7. Click Show to see the list of places found.

8. Select a place and click OK to close the Find Place window. The place to be included in the sea
added to the criteria at the top of the window.

9. To search for an event that took place in a certain time period, enter dates for the time period. D
of the following:

• Enter the date in the After field in the Dates group to search for events occurring after a given d

• Enter the date in the Before field to search for events occurring before a given date.

• Leave both the After and Before fields blank to search for events that occurred on an unknown 
(the event date fields are blank).

Note If a date is entered in the Before field and the After field is left blank, the search includes e
with a blank date field and events having dates after 1/1/100. If a date is entered in the After fie
the Before field is left blank, the Before date defaults to today’s date.

10. Complete the search as described on page 62, “Steps for Completing a Search.”

Flags Search
The Flags Search locates individuals whose Individual Records contain specific user-defined flag info
tion. The search criteria are displayed at the top of the search window as you make your selections. 
information is also added to the History window after a search is complete.

1. Choose Flags from the Search menu.

Figure 4-5: Flags Search Window

List of individual flags

Select to search for all flags
set to True, False, or Either
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2. Select a flag from the list of individual flag fields. All flag labels assigned to the project are includ
the list.

3. In the Status group, select True to search for flags marked True, False to search for flags marke
or Either to search for individuals linked to the selected flag marked as either True or False.

4. Complete the search as described on page 62, “Steps for Completing a Search.”

Mail Search
The Mail Search window locates individuals by information entered in the Mail Label window, opened 
the Miscellaneous Individual Information window. The search criteria are displayed at the top of the s
window as you make your selections. This information is also added to the History window after a se
completed.

1. Choose Mail from the Search menu.

2. Scroll down the list of options in the label field and select the criteria to be used in the search.

3. If you select one of the label fields that contains text, such as an addressee, enter the words to s
the Text field.

4. Select a mailing list from the Label Fields (such as Family Association, Newsletter, Birthday, Ho
and Other 1 and 2) to enable the buttons in the Included in Mail List box.

5. Select Yes to search for individuals included in the selected mailing list, or No to find those not 
included in that mailing list.

6. Complete the search as described on page 62, “Steps for Completing a Search.”

Figure 4-6: Mail Search Window

Search for individuals
who are included in one
of the Mail List options

Type text for which
to search
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Media Search
The Media Search searches for individuals who are connected to a selected image. The search crite
displayed at the top of the search window as you make your selections. This information is also adde
History window after a search is complete.

1. Choose Media from the Search menu.

2. Select the image you want to include in the search from the Media list.

3. Complete the search as described on page 62, “Steps for Completing a Search.”

Medical Search
The Medical Search looks for individuals for whom you have added medical information. The Medica
tory window is opened from the Individual Record window. The search criteria are displayed at the top
search window as you make your selections. This information is also added to the History window af
search is complete.

1. Choose Medical from the Search menu.

2. Select one of the three options located under the Medical Conditions list: Selected, All, or Ignor
you select Ignore, the Medical conditions are ignored and only the Measure and Misc. groups a
available to be searched.

3. If you chose Selected in step 2, select the medical condition from the Medical Conditions list. S
through the list by using the Up and Down Arrow keys or by pressing the first letter of the condi
you want to search.

4. Select Any Text in the Text group to search for text entered in the Medical Condition text window
select Specific Text and enter the words you want to search for.

Figure 4-7: Media Search Window
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5. Type a weight and/or height to search for. Enter a minimum and maximum number for each crit
You can specify either pound/foot/inch (pd/ft/in) or kilogram/meter/centimeter (kg/m/cm).

6. Type specific criteria such as hair color, eye color, skin color, or blood type.

7. Complete the search as described on page 62, “Steps for Completing a Search.”

Miscellaneous Search
The Miscellaneous Search window locates individuals with information entered in the Miscellaneous 
vidual Information window. The Miscellaneous Individual Information window is opened from within th
Individual Record window. The search criteria are shown at the top of the search window as you mak
selections. This information is also added to the History window after a search is complete.

1. Choose Miscellaneous from the Search menu.

Figure 4-8: Medical Search Window

Check option to
include medical
conditions
in search

Type specific weight
and height data to
be searched
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Figure 4-9: Miscellaneous Search Window

Type text to be found
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2. Select a field from the Miscellaneous Fields list. Use the scroll bar or the Up and Down Arrow ke
move through the list.

3. Type the text you wish to search for in the Search group, or if you have selected Ancestral Inter
Descendant Interest, type the interest limits in the Low and High fields in the search group.

4. Complete the search as described on page 62, “Steps for Completing a Search.”

Relationship Search
The Relationship Search looks for individuals who are related directly or through collateral lines to a 
fied person. The search criteria are displayed at the top of the search window as you make your sele
This information is also added to the History window after a search is complete.

1. Select (from any window) the individual you want as the starting subject of the search.

2. Choose Relationship from the Search menu.

Note Choose Locate from the Search menu to find a new starting person for the search. See p
for information on using the Find Individual window.

3. Select one of the following Relationship Options:

• Ancestors Only — Searches for ancestors to a specified generation limit

• Ancestors Plus Their Descendants — Searches for ancestors to a specified generation limit, and 
descendants of those ancestors to a specified descendant limit

• Descendant Only — Searches for the selected individual’s descendants to a specified generation

• Descendants Plus Their Ancestors — Searches descendants to a specified generation limit, and a
tors of those descendants to a specified ancestor limit

Figure 4-10: Relationship Search Window

Enter limits of
generations to be
included in search

Add other spouses
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• Ancestors Plus Descendants — Searches ancestors and descendants to a specified generation lim
each direction

• Siblings — Searches for the start person’s siblings (generation limit not used)

4. Use the Limits group to specify the number of generations (up to 999) to include in your search
Limits group includes three fields:

• Generation — Enter the number of generations to search in the direction you are searching (anc
descendants or both).

• Descendant — Enter the number of generations of descendants to include when Plus Their Des
dants is selected.

• Ancestor — Enter the number of generations of ancestors to include when Plus Their Ancestors
selected.

5. Check the Add Other Spouses box to add spouses not already included in the search.

6. Complete the search as described on page 62, “Steps for Completing a Search.”

Note The starting individual is always included in the list.

Text Search
The Text Search locates individuals whose records contain text in a free-form text field. The search c
are displayed at the top of the search window as you make your selections. This information is also a
the History window after a search is complete.

1. From the Search menu, choose Text.

Figure 4-11: Text Search Window
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2. To search on a specific field, select the Individual, Event, or Media text field from the Text Field
Scroll through the list using the Up and Down Arrow keys or by typing the first letter of the even
want to search. Click Selected Field below the Text Fields list.

3. To search all fields, click All Text Fields below the Text Fields list.

4. Click Any Text or Specific Text (if you chose Specific Text, type the specific text for which you w
to search in the Text box).

5. Complete the search as described on page 62, “Steps for Completing a Search.”

Vital Statistics Search
The Vital Statistics Search locates individuals on the basis of their vital statistics, such as age at a ce
event. The search criteria are shown at the top of the search window as you make your selections. Th
mation is also added to the History window after a search is complete.

1. From the Search menu, choose Vital Statistics.

2. Select a vital statistic from Vitals Search Options list.

3. Enter the appropriate search code or limit in the Search group.

Note Vital statistics can be specified either by code (such as Y for yes, N for no) or limits (such as 
low age and high age). Appropriate search conditions are available for each vitals search option

4. Use the Vitals Search Options, Age at first (event) and Age at last (event) to choose any event y
wish. For instance, you can choose Age at first (event) from the Vitals Search Options and then
an event type included in your project from the Possible Events list. Enter the age to be searche
limit box.

5. Complete the search as described on page 62, “Steps for Completing a Search.”

Figure 4-12: Vital Statistics Search Window

Enter T (true), F (false),

Enter low and high
ages or number
limits
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Grouping
The Grouping option merges search lists generated through the individual search routines. Use the G
List to hold only the names of individuals on whom you want to focus. It can also be used as a basis 
printed reports and new projects. Each search window has a Group button that replaces the Groupin
with the results of the selected search. Use the Grouping window to merge the contents of several se

1. From the Search menu, choose Grouping.

2. Select a search routine from the Individual Search list. The Individuals In group displays the nu
of individuals in each of three categories:

• Selected Search — Displays the number of individuals in the search routine selected from the Se
list

• Entire Project — Displays the total number of individuals in the project

• Grouping List — Displays the number of individuals in the current Grouping List

Note You must run a search in the selected routine before you can add it to the Grouping List.
number of individuals found in the selected search appears next to Selected Search in the Indiv
In group. If this number is zero, a search has not been run and a Grouping List cannot be creat

3. Click History for Selected to see a summary of how the results were obtained for the selected s

4. Check the Invert Selected box to include all individuals not in the selected search.

5. Select one of these options from the pop-up menu for the resulting search list:

• Replace grouping list with selected list — Starts a new search list. This option replaces an existing
search list with the results from the current search list. Individuals already in the list are remove
the new list is saved.

Figure 4-13: Grouping Window

Selected search

Number of people
found in selected search
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• Add selected list to grouping list — Builds a composite list from two or more searches. This option
adds the results of the current search to an existing search list. For example, if five individuals a
already in the list from a previous search, and seven new individuals are found and saved with 
option, the new list will contain twelve individuals.

• Remove selected list from grouping list — Narrows an existing search list. This option removes the
results of the current search from an existing search list. If five individuals are in an existing list,
two individuals from a new search are already in that list, they will be removed. The new search
will contain three individuals.

• Keep in selected list and grouping — Matches items in an existing search list. This option keeps th
results of the search if they are already in the existing search list. If five individuals are in an ex
list and a new search finds two who are already in that list, the new list will contain two individua

• Add spouses to grouping — Adds spouses for all individuals in the Grouping list.

6. To check the search without committing the results to the permanent search list, click Preview. 
Escape to return to the Grouping window.

7. Click Search to create the Grouping list.

Note Click Results to show the list. Double-click a name to open the Individual Record for that
son. Click History to see a summary of how the Grouping List was built. Click Close or press Es
to close the Grouping window.

Adding an Individual to the Grouping List
You can add an individual to the Grouping List.

1. From the Search menu, choose Grouping.

2. Click Results to open the Grouping List.

3. Choose Locate from the Search menu to open the Find Individual window.

4. Find the person and click OK. The Grouping List will close. Click Results to open the Grouping 
again with the individual’s name highlighted.

Removing an Individual from the Grouping List
You can remove an individual from the Grouping List.

1. Open the Grouping List by choosing Results in the Grouping window.

2. Highlight the name of the individual.

3. From the File menu, choose Delete Record.

Note This procedure removes an individual from the Grouping List, but it does not delete the p
from the project. When removing an individual from the Grouping List, the change is not reflecte
the list until you have closed and reopened the list.
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Finding an Individual 
The quickest, simplest way to find an individual is the following:

1. Click the main name field in the Individual Record.

2. Click the Find button to the right of the Spouse field. The Candidate Individuals window opens. 

3. Press the first letter of the first name of the person you want to find to move to that place in the

4. Select the individual you want and click OK. 

Another way to find an individual is to use the Find Individual window.

1. Choose Locate from the Search menu to open the Find Individual window.

2. Type the first few characters of the name (or the record number, if known) and press Enter, or c
Find to display the first occurrence of that name in your project.

Note If you type a full name, use slash (/) characters to mark the surname. See the next sectio
other rules on entering names in searches. If you have typed characters, Find locates all individ
the project whose names contain those characters and places them in a list. The first name foun
played in the Find Individual window.

3. Click Find Next and Find Previous to move through the list. To display the entire list and make a
tion, click Show.

4. Highlight the name of the individual you want in the Find list and close the window (click the Clo
box or press Escape) to return to the Find Individual window.

5. Click OK to return to the original window with the focus changed to the newly found individual.

A third way to find an individual is to use the View list.

1. From the View menu, choose Individual List and then By Surname.

2. Use the scroll arrows to scroll through the list.

3. Double-click the name you want, or select the name and choose Individual Record from the Bu
menu to open that person’s Individual Record.

Figure 4-14: Find Individual Window



U S I N G T H E  GO  M E N U 7 7

tzger-

ent 

ited 
ecord, 

p to 
r Down 
ou last 
will 
Rules for name searches
• Names are not case sensitive—use uppercase or lowercase letters.

• Enter more than one name for a person if you want. For example, if you are looking for John Fi
ald Kennedy in your project, you can type john fitzgerald.

• Type either full or partial names. For example, you can type hn fit to locate John Fitzgerald Kennedy.

• Use special characters called wild cards. The question mark wild card character (?) is used to repres
a single unknown character. For example, jo?n finds all those named John or Joan. The asterisk (*) is 
used to represent more than one consecutive character. For example, ho*r finds Howard and Homer.

Note Wild cards cannot be used in a SOUNDEX search.

• Use forward slash characters (/) to specify surnames. For example, by typing /smith/ you find all those 
individuals having the surname Smith. If you enter smith without slash characters, Ultimate Family 
Tree finds individuals whose names contain smith at any place.

• Use braces {} to specify titles. For example, typing {Sr.} finds all those individuals having the title Sr.

Using the Go Menu
The Go menu gives you the ability to move through the individual list and quickly return to recently ed
records. Up to ten individual names are displayed in the Go List. Each time you open an Individual R
that individual’s name is placed at the top of the list.

From the Go menu, choose any name in the list to open that individual’s record. Choose Go To
move to the first person in your project. Choose Go Bottom to move to the last person. Choose Up o
to move the previous or next person in the list. The next person is determined by the order in which y
opened individual records. If the last individual record you opened resulted from a search, the focus 
change to those individuals in the search list.

Figure 4-15: Go Menu
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Ultimate Family Tree provides a wide variety of genealogical charts and reports, from simple lists to f
indexed and documented books. Many different formats are provided which you can customize to yo
preferences. Reports are sent to a Rich Text Format (RTF) file that can be imported into most word p
ing programs, including Microsoft Word and ClarisWorks version 4.0 and later. The Box Chart report i
directly to your printer.

In this section you will learn how to:

✓ Use page setup to set name format and preferences, and to choose fonts and page layout

✓ Use print 

and to create the following reports:

✓ Title Page

✓ Family Journal (Genealogy) report with pictures

✓ Portrait

✓ Family Tree (Pedigree) report

✓ Ancestor (Ahnentafel) report

✓ Text, Direct Drop, or Indented Descendant report

✓ Box Chart

✓ Relationship List
7 9
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✓ Free-form text

✓ Family Group report

✓ Individual or Project Summary

✓ Individual, Marriage, Source, and GEDCOM Exception Lists

✓ Mail Lists and Labels

✓ Tiny-Tafel reports

Rich Text Format 
The RTF standard developed by Microsoft describes a method of encoding formatted text for easy tr
between applications. With the RTF standard, documents composed under different operating system
with different software applications can be transferred between those operating systems and applica

Ultimate Family Tree supports the RTF standard for exporting report formatting, text justification,
attributes (size, bold, italic, superscript), indexing, footnotes, table of contents entries, headers, and foo
using RTF, most Ultimate Family Tree reports can be sent to Microsoft Word or other word processing pro

The following characters should not be used when entering data:

• \ — Used for control codes in RTF files. Do not use the backslash character in Ultimate Family 

• { } — Used for control codes in RTF files. Do not use the left or right curly brace character in Ultim
Family Tree except to mark a title in a name.

Using the Page Setup Window
To set print options that affect how most reports appear, choose Page Setup from the File menu, and
following options:

Figure 5-1: Page Setup Window (left side)

Select how names
appear in reports

Select preferred name field
to be printed in reports

Prints name in reverse order

Select word processor After printing, open RTF file
with specified application
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• Book Title — Prints in the header on every page. Limited to 25 characters.

• Name Format — Capitalizes and uses bold text for given names or surnames. Select Surname 1
print the surname before the given name.

• Name Preference — Prints the preferred name in reports. Specify your first and second choices f
which names Ultimate Family Tree prints. If your first choice is blank for a given individual, Ultim
Family Tree uses your second choice. If your second choice is blank, Ultimate Family Tree defa
the Main name field (on the Individual Record window). This gives you the option to use a wom
married name instead of her maiden name, for example. You can also use aliases or religious n
(entered on the Miscellaneous Individual Information window, accessed by clicking the More bu
on the Individual Record window). If a name is entered in the Long Name field of the Miscellane
Individual Information window, the Long Name is used on free-form reports such as Family Jou
reports.

Note Some reports, such as the Family Journal reports, override the Name Format selections 
ply with National Genealogical Society and New England Historic Genealogical Society styles. 
the Descendant Box Chart functions independently of the Page Setup window. Use the Box Cha
Setup window and the Chart window itself to select page and formatting options for Box Charts

• Index Additions — Adds information to names in the index. Select Include Index to include RTF 
indexing codes in reports. Select Birth/Death Years to add birth and death years to names in the
Select Record Numbers to add record numbers.

• Page Layout — Sets the page layout in reports. Check Reverse Odd/Even to print the page numbe
alternating edges of the page for double-sided printing. Check Preparer to include the preparer’s n
the footer of the report. If you check preparer, select either Name or Name/Address. Check Date to 
the date in the footer. Check Header/Footer Lines to insert header and footer lines on each repor

• Footnote Style — Prints footnotes in long form, in long then abbreviated form, or in long form first a
then in abbreviated form followed by Ibid.

Figure 5-2: Page Setup Window (center)

Use odd/even page number layout

Insert header and footer

Include preparer’s name in footer

If preparer is included,

lines on each report page

select either option

Fully justify text

Include date in footer

Add birth/death years

Add record numbers

to names in index

to names in index

Select footnote style
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• Word Processors — Printed reports can be opened automatically by your word processor. Check
Launch box and specify your word processor by choosing Microsoft Word, ClarisWorks version 
and later, or Generic. If Launch is unchecked, the RTF file is saved in the folder you chose whe
print the report, and you must manually start your word processor to open, edit, and print the re

Note If you select Generic, your word processor is not launched automatically. The report files
saved with the file type TEXT, allowing them to be opened in the word processor of your choice
When Generic is chosen, the Launch check box is inactive.

Changing Font Style and Size
To select different fonts for the various components of a report, choose Page Setup from the File me

The Ultimate Family Tree default fonts are Helvetica and Times. Suggested font sizes for each c
nent follow:

• Book Title 16

• Page Number 12

• Chapter Name 14

• Section Name 12

• Text 10

• Small Text 9

• Preparer/Date 8

Figure 5-3: Page Setup Window (right side)

Report components

Font type and size for
selected component

Change font type and size
for selected component
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Specific fonts, font styles, and font sizes can be changed for various components of a report. Po
fonts can be used in Ultimate Family Tree reports. However, Ultimate Family Tree determines both th
style and size in all List reports. In Family Tree reports, only the font size is set by Ultimate Family Tr
you can change the font style if you want. The index uses a fixed number of lines on a page. It is desi
use a 9-point font. White space will occur at the bottom of the page if you use a smaller font size. A l
font size can cause overflow to the next page.

1. Select the report component (for example, Book Title).

2. Click the Fonts button.

3. Select a font from the Font list.

4. Select a font style: Regular Italic or Bold.

5. Select a font size.

6. Click OK to close the Font dialog box.

7. Repeat steps 1–6 for each of the remaining report components.

Basic Steps for Printing Reports
Each report window provides options for customizing and tailoring a report to your needs. Ultimate F
Tree uses the options you set to format and create the reports. Report windows share some or all of t
options. The following basic steps are used to print Ultimate Family Tree reports.

1. Before printing a report, set your basic options for printed reports in the Page Setup window. (Se
80.)

2. Choose a report from the Reports menu.

Figure 5-4: Font Dialog Box

List of available fonts
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3. Choose Locate from the Search menu to find the individual you want to use as the focus of the
(See page 76 for information on using the Find Individual window.) Some reports, such as List re
do not require a focus person.

4. Type a chapter title if desired (up to 40 characters).This title is used as the chapter name and ap
the beginning of the report.

5. Set the available options for customizing the report.

6. Enter a number in the Generation limit field (if available) to limit the number of generations inclu
in the report.

7. To include an introduction in a report, check Introduction, and then click Intro Text to open a free
text window where you can write introductory text for the report or chapter. The text window con
of an area for entering text and a set of buttons for formatting the text. (See page 35 for more in
tion on formatting text. See page 37 for information on using the import button if you want to im
introductory text from an external text file.)

8. To use a subset of the individuals in your project, locate and list individuals in your project that 
your criteria and add them to the Grouping List. You can then use the options in Grouping to limi
printed reports to those individuals in the Grouping List. Check the appropriate boxes to include
following options:

• Use List (in the Grouping box) — Prints a report which includes only those individuals who are in
Grouping List.

• Add Asterisk — Prints a report including all individuals but with an asterisk to indicate those in th
Grouping List.

Note The Grouping option is available in Family Tree (Pedigree), Descendant, Relationship, F
Group, and List reports.

9. Click Print on the report window or press -P.

If you check the Launch box in Page Setup, the word processor you specified will open.

1. Edit and/or print the report. Refer to the user’s guide for your own word processor for informatio
editing and printing.

2. Choose Save to save the report as a Rich Text Format file.

3. Enter a file name.

If you choose Generic in Page Setup as your word processor, or did not check Launch, a Save As wi
opens.

1. Type a file name for the report file, select the folder where you want to save it.

2. Click Save.
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Preparing to Print a Book
Before printing the first page of your book, you should prepare an outline. It does not have to be elabo
simple list of the reports, in order, will do. This is also the time to make decisions about what other in
tion to include and where to place it. Use your outline to keep track of formatting and to make other n
yourself for printing. Here is a sample outline:

• Title Page

• Table of Contents

• Introduction

• Family Tree (Pedigree) Report

• Map (two page spread, start on left page)

• Reverse Register Report

• Relationship List

• Index

Suggestions on Style
Two of the most common ways to arrange genealogical records in a book are in ancestral order and descen-
dant order.

Ancestral-Ordered Book An ancestral-ordered book is the history of an individual back to his
her distant ancestors. Many people choose to prepare a book about parents or grandparents, and in
complete history of their family or just a portion of it. Here is a typical format:

• Title Page

• Table of Contents

• Introduction (Text Report)

• Family Tree (Pedigree) Report for the person the book is about

• Reverse Register Report (Family Journal Report)

• Ancestor (Ahnentafel) Report

• Relationship List Report

• End Notes

• Index

Descendant-Ordered Book A descendant-ordered book singles out an ancestor and traces h
her children, grandchildren, and all other documented descendants to the present day. If you choose
mat and have a large family, you might find there is so much information to be presented that you sh
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divide the book into separate volumes (one or two children of the ancestor per volume). Here is a po
format:

• Title Page

• Table of Contents

• Introduction (Text Report)

• Descendant Report

• Register Report (Family Journal Report)

• Relationship Report

• End Notes

• Index

Note The table of contents and index are generated by your word processor based on the cod
embedded in the RTF reports. You can customize your reports by changing margins, moving te
rewriting sentences, and adding pictures. Any page numbering changes are reflected in the tab
contents and index subsequently generated by the word processor.

Title Page Report
The title page normally contains the book title, subtitle (if applicable), author, publisher, date, and loc
of publication. To open the Title Page window, choose Title Page from the Reports menu.

The following fields are available in this window:

• Title — Enter the title of the book in this field (up to 40 characters). For example, you might title 
book The Kennedys. The title prints in a large font centered in the upper third of the page.

• Subtitle — Enter a subtitle for the book (up to 48 characters). For example, The Descendants of Joseph
Patrick Kennedy. The subtitle prints below the title in a smaller font.

Figure 5-5: Title Page Report Window

Click to open text window
for title page
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• Title Page Text — When chosen, this check box opens a free-form text window where you can e
text to be printed on the title page. You can include the preparer’s name, the date the book was 
publisher information, or any other text.

Note The Title Page Text is printed centered at the bottom of the title page. The text can be form
as bold, italic, and/or underline. To create a new paragraph, leave a blank line between paragra

Family Journal Report
The most widely accepted formats for publishing a genealogy in the United States are the New Engla
toric Genealogical Society’s Register and the National Genealogical Society’s Modified Register plans. You 
can use options available in the Family Journal Report window to create either of these formats. The 
ities between the two are substantial; the differences are slight but significant.

Family Journal Report Styles
Both formatting plans begin with one person. This person is given the number 1, indicating the positi
the first person in this first generation. The children of this progenitor are assigned, in order of birth, a
Roman numeral (i, ii, iii). In addition, each child can be given an Arabic number (1, 2, 3) that establishe
child’s overall placement in both the specific family and the larger family described in the report. Thes
numbers (both Roman and Arabic) precede the name. All family members are placed in their respect
erations, with generation numbers appearing as superscripts following the first name. In the report, e
mary person’s name is followed by a back reference, in parentheses. The back reference includes th
names and generation numbers of each person in the line back to the progenitor.

Here are the differences between the plans:

• In the Register format, only children whose lines continue are given Arabic numbers. In the Mod
Register format, all children receive an Arabic number. In both cases, these numbers are in birth
and begin (for the eldest child) with the next number after the last one used in the previous gen

• In the Register format, children whose lines continue are clearly identified with an Arabic numbe
the Modified Register format, with all children bearing such a number, a plus (+) is placed in fro
the number to indicate children whose lines continue.

• In the Register format, the main individuals’ names print in bold, uppercase letters. In the Modifi
Register format, the main individuals’ names print in bold, upper/lowercase letters.

• In the Register format, notes are embedded in the text. In the Modified Register format, the note
as end notes.
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Printing a Family Journal Report
1. Choose Family Format from the Reports menu.

2. Choose one of the following styles:

• Modified Register (National Genealogical Society style, NGS) — Select this style to print footnote
end notes, number all children, and a use a plus sign (+) to indicate a child whose line continue
main individuals’ names print in bold upper/lowercase letters.

• Register (New England Historic Genealogical Society style, NEHGS) — Select this style to inclu
footnotes as embedded notes and to number only those children whose lines are continued. Th
individuals’ names print in bold, uppercase letters.

3. Choose Section New Page to start each generation on a new page.

4. After establishing the style of Family Journal report, choose one of the following options to dete
the order in which your data will print:

• Descendant — The Descendant Family Journal Report starts with a progenitor (the selected ancesto
traces his or her family line to the present. The individual selected is the subject of the first gene

• Family — The Family Report creates a descendant-style report for all families in the project with
family in a chapter in alphabetical order. Note that an end-of-line progenitor female must have e
spouse or father entered to be included because the Family Report is based on male surnames

• Reverse Register — The Reverse Register Family Journal Report starts with a descendant (the se
individual) and traces his or her line back through all ancestors. The numbering system used in
reports is the same as that used in the Register or Modified Register, but in reverse. Here you b
with a selected individual and move backwards in time.

Figure 5-6: Family Journal Report Window

Choose report style

Start each generation
on a new page

Include event text

Estimate any missing
birth dates

Choose order in which
family data prints

Include introduction
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5. Choose to include any of these options in your report by clicking the corresponding boxes and 
buttons:

• Events — choose to include All Events, Basic Events (Birth, Marriage, Death, and Burial), or No E

• Event Text (includes text entered for events)

• Estimate Missing Births (estimates the birth date from other events when no birth date is availa

• Indiv Record Number (includes the individual record number)

• Indiv Reference (includes the reference data entered in the Reference field of the Individual Mis
neous window)

• Indiv Text (includes text entered in the Individual Biographical Text window)

• Flags (includes individual flags entered in the Miscellaneous window)

• All Spouse Data (includes all data entered for spouses)

• Parent Images (includes the preferred image for all main individuals in the report)

• Child Images (includes the preferred image for all children in the report)

• Introduction (includes text entered after clicking Intro Text)

6. Enter number of generations to allow in the report in Generation Limit.

7. Print the report. (See page 83 for basic steps for printing reports.)

Ancestor Reports
Ultimate Family Tree provides two kinds of ancestor reports, Family Tree (Pedigree) and Ancestor (Ahnen

Family Tree (Pedigree) Chart
The Family Tree Chart graphically traces ancestral lines back through an individual’s parents, grandp
and so on. In Ultimate Family Tree you can print four generations on each page of a report. You can 
print a blank Family Tree Chart.

The Family Tree Chart allows room for a variety of data. Information on a Family Tree Chart incl
the date and place of the birth, death, marriage, and resides events for each individual. If dates and p
unknown, the corresponding line on the chart is blank.

A number is associated with each person’s position on the Family Tree Chart. These numbers a
erencing system to keep track of a pedigree that fills more than one page. The Family Tree Chart can
back 54 generations. For a line that continues past the last generation on a page, Ultimate Family Tre
a “continued on later chart” reference.

To print a Family Tree (Pedigree) Chart:

1. From the Reports menu, choose Ancestor, and then Family Tree.
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2. Check Use List to include only those individuals in the Grouping List.

3. Check Add Asterisk to print an asterisk next to the name of each individual in the Grouping List

4. Select Blank Report to produce a Family Tree Chart form for use in research.

5. Check Omit Redundant Ancestors, if desired. (Redundant ancestors occur when cousins marry
Omit Redundant Ancestors is checked, the first occurrence of a redundant ancestor includes al
or her information. Any recurrence of the redundant information is referred back to the first occu
rence, by citing the previous chart, and the redundant line is not continued.

6. Print the report. (See page 83 for basic steps for printing reports.)

Space available for names is limited in the Family Tree Chart. If necessary, Ultimate Family Tre
shortens names by abbreviating the middle names, one at a time, and then the first name, until the n
in the available space.

Abbreviations for events included in the report print before the event:

• b. birth

• d. death

• m. marriage

• r. resides (prints if the person has a resides event or is still living)

Ancestor (Ahnentafel) Report
An Ancestor Report is a Family Tree Chart in text rather than graphic form. The Ancestor report lists 
tors for up to 50 generations. All ancestors included in the Ancestor report are given a number from t
Ahnentafel system. In this system, a unique number is assigned to each position in the pedigree rega
whether or not a person is occupying that position. Ahnentafel numbering assigns the number 1 to th
ing individual. The father’s number is two times his child’s number, and the mother’s number is two tim
her child’s number plus one.

Figure 5-7: Family Tree (Pedigree) Chart Window

Include only those
in Grouping List

Add asterisk to those
in Grouping List

Chapter title for report

Print blank family tree
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With these position markers you can quickly determine exactly how any person on the chart is r
to the starting person. For example, the label, great-great-grandfather, reveals that the ancestor is fo
ations back and is male. A great-great grandfather can be any one of eight people. Ahnentafel numb
however, is the maternal grandfather’s mother’s father (for the selected individual).

To print an Ancestor (Ahnentafel) Report:

1. From the Reports menu, choose Ancestor, and then Ancestor Report.

2. In the Events group, choose whether or not to include the individual’s events on the report, or c
to create an abbreviated Ancestor report that contains only Ahnentafel numbers, names, and d
birth and death.

Note If you select Birth/Death Dates or No Events, the option to include Event Text cannot be 
selected.

3. Check to include options in the Other group, or to add an introduction.

4. Print the report. See page 83 for basic steps for printing reports.

Descendant Reports
Ultimate Family Tree provides four different styles of descendant reports: Indented, Text, Direct Drop
Box Chart.

Indented Descendant Report
The Indented Descendant Report window prepares a descendant chart that starts with the progenito
family line and follows all descendant lines to their ends. Each generation is indented from the previo
eration. Up to 16 generations can be included.

Figure 5-8: Ancestor Report Window

Remove white spaces
from report

Print lines between
generations

Print ancestor names
in bold

Check to include
on report
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1. From the Reports menu, choose Indented Descendant.

2. Choose to include any additional options from the Contents group. Check Other Spouses to inc
spouses from marriages with no children.

3. Check Use List to include only those individuals in the Grouping List.

4. Set the number of generations (up to 16) for the report.

5. Enter a number in the Extra Indent box (from 1 to 10) if you want to increase the number of char
that each generation is indented for ease of reading. When Extra Indent is 0, generations are in
three characters. This option is useful when there are only a few generations or when names a

Note The space for names is determined by the options selected to be printed: generation num
birth and death dates, and record numbers. If a name does not fit in the available space, Ultima
ily Tree shortens the name so it will fit. If a common name has been entered in the Miscellaneo
Information window, that name is used to shorten.

6. Print the report. See page 83 for basic steps for printing reports.

Descendant Text Report
The Descendant Text Report is a descendant report in text style that offers several generation numb
styles: Generation Number, Henry Number, Modified Henry, and D’Aboville. Information included in t
report is dependent on the options chosen in the report window.

1. From the Reports menu, choose Descendant Text.

2. Choose a numbering style:

• Generation Number — The generation number for each descendant is included with his or her na

Figure 5-9: Indented Descendant Report Window

Include only those
in Grouping List

Set number of
generations for report

Include spouse from
marriages with no
children

Increase generation
indent
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• Henry Numbering System — A genealogical numbering system where the progenitor, or a selecte
individual, is given the number 1. The oldest child is number 11, the next child the number 12, et
oldest child of number 11 is number 111, the next is 112, etc. When there are more than nine ch
the numbers are placed in parentheses.

• Modified Henry Numbering System — A genealogical numbering system that is similar to the Henr
system except that instead of using 10, 11, 12 in parentheses for the tenth, eleventh, and twelft
dren, the letters A, B, and C are used. If there are more than 35 children, lowercase letters are use
example, a, b, c, for the thirty-sixth, thirty-seventh and thirty-eighth children.

• D’Aboville Numbering System — A genealogical numbering system where the progenitor, or selec
individual, is given the number 1, the first child is given the number 1.1, the second child is give
number 1.2, etc. This system is similar to the Henry Numbering System, except that each indivi
number includes periods to separate generations. For example, 1.2.2 indicates that an individua
second child of the second child of the progenitor for this family line.

3. Choose one of the options in the Events group to determine which events will be included in th
report: All Events, Basic Events (Birth, Marriage, Death, and Burial), or No Events.

4. Include additional options from the Other group.

5. Include only individuals found in the Grouping List by checking Use List. See page 74 for inform
on grouping.

6. Choose Add Asterisk to add an asterisk to individuals in the report who are in the Grouping List

7. Print the report. See page 83 for basic steps for printing reports.

Figure 5-10: Descendant Text Report Window
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in Grouping List
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Direct Drop Descendant Report
The Direct Drop Descendant chart shows how two people are connected through a direct line. It star
an ancestor and traces his or her direct family line to any descendant you choose.

1. From the Reports menu, choose Direct Drop.

2. After choosing a start person, click the Choose button to open the Choose Descendant List win
The list includes the starting person and descendants.

3. Select the descendant you want as the ending person on this report, then double-click the nam
close the Choose Descendant window by pressing Escape or clicking the Close box.

4. Choose to include any additional options from the Contents group: Record Number, Birth and D
Dates, and introduction.

Note The space for names is limited. If a name does not fit in the available space, Ultimate Fa
Tree shortens the name so it will fit, abbreviating middle names (one-by-one) and finally the firs
name.

5. Print the report. See page 83 for basic steps for printing reports.

Note If you choose to include introductory text, the Direct Drop report starts on the next full pa

Descendant Box Chart
Ultimate Family Tree includes an option to print a beautiful family tree or Box Chart as either a page 
included in a family history book, as a wall chart, or as a web page. There are many styles, fonts, and
options from which to choose to customize a unique chart. The contents of charts can be edited and s
future sessions. Up to 16 generations of descendants can be included. This report is sent directly to 
printer rather than saved to an RTF file.

Figure 5-11: Direct Drop Descendant Report Window
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Creating a New Box Chart

 

1. From the Reports menu, choose Box Chart.

2. Click New in the Open Chart group. The New Chart window opens.

3. Press -L to locate a new starting person for the report.

4. Type a name of up to eight characters in the Chart Name field. This is the control name that appears in 
the Charts list.

5. Type a title (optional) for the chart in the Chart Title field (up to 39 characters). This title appears at the 
top of the chart window and can be included on printed charts.

6. Enter a number in the Generation limit field if you want to limit the number of generations to be 
included in the chart.

7. Choose Use List if you want to limit the report to only those individuals in the Grouping List. Use 
Ultimate Family Tree search routines to locate and list individuals in your project who meet your crite-
ria, and add them to the Grouping List. See page 74 for information on grouping.

8. Click Design from the Contents group to open the Box Chart Design window.

Figure 5-12: Descendant Box Chart Window

List of

Create new
box chart

View existing

Printing
options

available
charts

box chart

Figure 5-13: New Chart Window

Type control name

Include only those
in Grouping List

Design box chart

(8 characters max.)
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9. Choose the options you want included in the chart. The sample window in the lower-right corne
plays how the chosen options will appear in the boxes on the chart.

10. Select any of the following options from the pop-up menus in Event Line 1 and Event Line 2 gro

• Blank — Leaves corresponding event line blank

• Line — Includes a line in place of corresponding event data

• Birth — Includes birth event data on event line 1.

• Death — Includes death event data on event line 2.

• Birth and Death Dates — Includes birth and death dates on corresponding event line

• Birth and Death Years — Includes birth and death years on corresponding event line

• Selected Event (First) — Includes event chosen from Events list. Select this option and click the 
Events button. Select the event you want included in the report and click OK. Only the first occur
of the selected event is used.

• Date — Includes only the date for selected event

• Place — Includes only the place for selected event

• Date and Place — Includes date and place for selected event if checked

Note The birth and death dates and years options override selections in the Dates group.

In the Marriage group, choose from these options:

• Blank — No marriage information

• Marriage Date — Marriage date

• Marriage Date and Place — Date and location of marriage

• Include Other Spouses — Includes other spouses for whom there are no descendants

Figure 5-14: Box Chart Design Window

Options for

Include place
Event Line 1

Options for
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modifier

Displays how
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on chart
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In the Dates group, choose from these options:

• Year — Year of the selected event

• Short — Day, month, and year of selected event

• Structured — Date from structured date field, including the date modifier

• Long — Free-form date for the selected event

Note The Dates group options are not used if the Birth and Death dates or Birth and Death ye
options are selected in the Event Line 1 or 2 groups.

In the Event Name group, choose from these options:

• None — No name or abbreviation for the event

• Short — Short version of event name before event data (e.g., b. for birth)

• Medium — Medium abbreviation of event name (e.g., bir for birth)

• Long — Long version of the event name

In the Places group, choose from these options:

• First and Last — First and last levels of a place name (normally city and state)

• Last Two — Last two levels of a place name (normally county and state)

• Full — Full place name

• Modifier — Place modifier (e.g., in)

11. After making your selections, click OK to return to the New Chart window.

12. Click OK in the New Chart window to open the Chart window you have designed.

Note The Box Chart Design sets the overall design of a chart. Once the chart is created, the b
design options cannot be altered. However, changes, additions, and customizing details can be
from the Descendant Box Chart window, the Box Chart Page Setup window, and on the Box Ch
itself. These changes are reversible.

13. Choose Exit from the File menu to return to the Descendant Box Chart window.

Preparing a Box Chart for Printing
1. From the Reports menu, choose Box Chart.

2. In the Descendant Box Chart window, choose whether you want to print a chart that will fit on a
dard page and can be included in a book, or one that is designed to be displayed on a wall, by s
either Book or Wall Chart in the Chart Setup group. Choose Book to print charts with the Ultima
Family Tree headers and footers, or choose Wall Chart to print charts without headers and foot

3. Select the chart you want to print and click Existing.
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4. From the File menu, choose Page Setup.

Note If Page Setup is dim, uncheck HTML Mode in the Chart menu.

5. Select a paper size from the Paper Size pop-up menu.

6. Choose to print the chart in either Portrait or Landscape mode.

Note Selections made in the Box Chart Page Setup window are used only for printing box cha
They do not affect the default printer settings.

7. Set the margins for the box chart.

Note This is particularly useful if you are printing a wall chart. Be aware that some printers (La
Writers, for example) will not print on the outer edges of the pages. In these cases, setting the m
to less than 1/4 inch will not be reflected on the printed page.

8. Click OK to return to the chart.

9. From the Chart menu, select one, two, or no events for the chart you want to print.

10. Choose whether or not to include individual record numbers on the printed chart by selecting R
Numbers in the Chart menu.

Note To further customize the chart, see the Chart Window section below. The original Box Ch
Design sets the overall design of a chart. Once the chart is created, the basic design decisions
be altered. However, changes, additions, and customizing details can be made from the Box Ch
Page Setup window, and on the Box Chart itself. These changes are reversible.

11. With the selected chart open, choose Print from the File menu.

Chart Window
Use the options in the Chart menu to modify the displayed chart. Use Graphics to change the overall
of the chart, Colors to make color selections, and Fonts to change the fonts used.

Figure 5-15: Box Chart Page Setup Window

Choose paper size

Choose page margins
for Box Chart

and orientation
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Graphics You can select the number of boxes to be printed across and down on each page, the
border style, the line thickness between boxes and around the outside of the report, and the footer p
for the chart title.

1. From the Charts menu, choose Graphics to open the Select Graphics window. In the Page Lay
group, select the number of boxes to be printed across and down on each page.

Note The number of boxes per page in the list depends on the page size and orientation choic
made in the Page Setup window.

2. In the Box Style group, select the style of box you want for the chart. The options include: Plain
Notched, Fancy, Ovolo (concave corners), Cavetto (rounded corners), and None.

3. Select the size of the lines that connect descendants by choosing the appropriate radio button 
Line Width group. Measurements are in points (72 points = 1 inch).

4. Select the size of the lines that connect spouses by choosing the appropriate radio button in th
riage Line Width group.

5. Select a border for the entire chart by choosing the appropriate radio button in the Chart Border

6. Edit an existing chart name or enter a new chart name in the Text field of the Title Position grou

7. Choose the placement of the title by choosing the appropriate radio button in the Title Position 
The title can be left justified, centered, or right justified. Choose None if you do not want a title pr
on the chart.

8. Click OK to close the Select Graphics window.

Figure 5-16: Select Graphics Window
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Fonts From the Chart menu, choose Fonts to open the Select Fonts window where you can mak
and formatting choices. 

Available choices include:

• Record Number — The unique identifier for each individual.

• Event — The text for included events.

• Given Names — The given name for each individual.

• Surnames — The surname for each individual.

• Chart Title — The title you have selected for the report.

• Chart Legend — The key for color selection in the box chart.

1. Select a field from the Text Item list.

2. Choose the Change button to open the Font selection window.

3. Select a font from the pop-up menu.

4. Select a font size for the selected field.

5. Select Regular, Italic, Bold, or Bold Italic from the pop-up menu to print the selected data in the
format of your choice.

6. Repeat steps 1–5 for each data item you want to change.

Note Use narrow fonts to allow more information to be included in each box. If the font size is 
large, the names and events will print outside the box. Choose Separate Surname from the Cha
to print the given names and surnames on separate lines. Choose Auto Edit Text from the Char
to automatically truncate names to fit inside the boxes.

7. Click OK to close the Select Fonts window, and click OK again to return to the chart.

Figure 5-17: Select Fonts Window
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Colors From the Chart menu, choose Colors to open the Select Colors window where you can s
colors for the various boxes. For example, you can choose to have boxes for males in red and boxes
females in green.

Four color options are available: black, red, green, or blue. If a color is not selected, the default is bla

1. Select a field from the Flag list such as Male, Female, or Spouse.

2. Select a color for this field in the Color list.

3. Click the arrow button next to the associated field: First, Second, or Third.

Note The First color option overrides the Second and Third color choices.

4. Repeat steps 2 and 3 for the remaining color options.

5. Check the Legend box to include the color legend on the chart.

6. Click Close to view the changes on the chart.

Additional Options for Display
1. From the View menu, choose Screen settings to open the Screen Settings window.

Figure 5-18: Select Colors Window

Figure 5-19: Screen Settings Window
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2. Select an option from the Zoom display list to change the zoom factor for the chart.

3. Check Rulers to display ruler guides for the chart.

4. Check Page Layout to display page boundaries and numbers. The page layout depends on the
made in the Page Setup window. You can also choose the Rulers and Page Layout Lines menu i
the View menu.

5. Click OK to close the window.

Printing a Chart
1. With the chart open, choose Print from the File menu.

2. Select All to print all pages, or select From and enter the page range.

3. Click OK to print the report.

4. Choose Exit from the File menu to close the chart.

Deleting a Chart
1. In the Descendant Box Chart window, select a chart in the Charts List.

2. Click the Selected button in the Delete Chart group.

3. If you want to delete all charts, click All in the Delete Chart group.

Relationship List Report
The Relationship List report provides a list of everyone in the project related by blood to a specified in
ual. Grouping allows you to customize the list. You could list those individuals with a specific SOUND
code, for example, or show those who are male and who were married more than once.

Relatives are listed in order of degree of consanguinity, which is the number of steps in a family
between people. Ultimate Family Tree calculates the relationships for this report through 16 generati

1. Choose Relationship List from the Reports menu.

Figure 5-20: Relationship List Report Window

Use these options to
customize your list

Include additional
information with
the person’s name
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2. Include any additional options from the Contents group.

3. Print the report. See page 83 for basic steps for printing reports.

Text Report
The Text Report allows you to create a free-form text report such as an appendix or an introductory c
for your book. This report can include a header, footer, and title.

1. Choose Text from the Reports menu.

2. Type a title for the Text report and click the Text button to open an Edit Text window.

3. You can type up to 65,000 characters of text. Click Import in the Edit Text window to import a tex
See page 37 for information on importing text. The indicator next to the Text button is green whe
is present.

4. Click Print. See page 83 for basic steps for printing reports.

Portrait Report
The Portrait report prints an image and text connected to the image. Ultimate Family Tree prints blac
white and color images if your printer supports color. 

Printing a Portrait Report
1. Choose Image Portrait from the Reports menu.

2. Select the Image you want to print from the Digitized Images list. The name (if used) of the sele
image is displayed at the top of the window.

3. Check the Caption and Description boxes to include the caption and description you entered fo
image in the Media Library. If you have not entered a caption or description in the Media Library
can do so at this time. Captions and descriptions entered here will not be saved in the Media Li

Figure 5-21: Text Report Window



1 0 4 SE C T I O N 5 : RE P O R T S

caption 

chil-
e it pro-
dow to 
k Fam-
4. If a caption has been entered, choose Top or Bottom to select the position for the caption. The 
should be limited to 50 characters or fewer.

Note A caption must be selected to activate the Top and Bottom options.

5. Print the report. See page 83 for basic steps for printing reports.

Family Group Report
The Family Group Report contains detailed information about a family unit (father, mother, and their 
dren). The Family Group Report is useful during the research phase of a genealogical project becaus
vides a ready reference to facts about the family. You can use options on the Family Group Report win
customize the form depending on your needs. Ultimate Family Tree provides an option to print a blan
ily Group Sheet for research purposes.

1. Choose Family Group from the Reports menu.

Figure 5-22: Portrait Report Window

List of available
images

Figure 5-23: Family Group Report Window

Print blank
report page

Print research
report

Print single report
for selected person
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2. Choose Locate from the Search menu to find the starting individual.

Note To print a blank Family Group report, check Blank Report.

3. Choose from the following options:

• Basic — Includes only Birth, Marriage, Death, and Burial events on the report.

• Extended — Prints all applicable events.

• Break Child Blocks — When not checked, moves the block of information for a child to the next p
if the entire block does not fit on the current page. Ultimate Family Tree does not move the bloc
doing so leaves more than 15 blank lines at the bottom of the page. When checked, splits block
child information across page boundaries to reduce white space.

• Mother/Father — Prints Mother and Father labels instead of Wife and Husband.

• Place Modifiers — When checked, the report includes the place modifier in.

• Preparer Info — Includes Preparer relationship information in the report.

Note To include the preparer name and address in the footer of the report, check Preparer in th
Setup window. When Preparer Info is selected as an option, the preparer relationship informatio
includes the relationship of the preparer to the husband and wife. Only blood relationships are 
included, not relationships by marriage. The preparer relationship information prints above the f
on the first page. If the researcher’s individual record number is entered in the Researcher # field
Project Information window, the blood relationship to the husband and wife is shown. If you do n
want the relationship to show, enter 0 in the Researcher # field.

4. Choose one of the options from the Family section:

• Selected — Prints a single Family Group Report for the selected individual

• Plus Descendants — Prints Family Group Reports for the selected individual plus his/her descen

• Plus Ancestors — Prints Family Group Reports for the selected individual plus his/her ancestors.

• All — Prints Family Group Reports for every individual in the project

Note If you select Plus Descendants, Plus Ancestors, or All, use the Grouping option. You sho
complete a Vital Statistics search for those individuals who are married and/or have children. M
this search into the Grouping List and choose Use List in the Grouping section on the Family G
Report window. By using these features, Family Group Reports will be printed only for those ind
uals who are married and/or have children.

5. If you choose Plus Descendants or Plus Ancestors in step 4 and want to set the number of gen
to print, enter the number in the Generation limit field.

6. Choose any additional options from the Other group.

7. Choose one of the following options in the Child Marriage group:

• First (print only the first marriage for each child)

• Last (prints only the last marriage for each child), All (prints all marriages for each child)

• None (excludes child marriages)
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8. Check the Research box to print a research version of the report. Research notes entered in the
ual Record Text and the Event Text window print as text if the Individual Text and the Event Tex
options have been selected.

9. Print the report. See page 83 for basic steps for printing reports.

Note If an individual has more than one spouse, Ultimate Family Tree asks you to select one o
spouses from a list. Single Family Group reports contain vertical lines to separate columns of in
tion. Multiple Family Group Reports do not use vertical lines.

Individual Summary Report
The Individual Summary provides a comprehensive report for individuals in your project. You have th
option of including any or all of the information that you’ve entered for selected individuals. By using 
Grouping List, you can create a customized report for whatever purposes you need. All information e
footnotes is included.

1. From the Reports menu, choose Summary, and then Individual.

2. Choose Locate from the Search menu to find the individual for whom you want to print the repo

3. Choose the options you want to include in the summary.

Note To print multiple Individual Summary reports, place the individuals in the Grouping List a
check Use List in the Grouping section of the report window. See page 74 for information on usin
Grouping window.

4. Print the report. See page 83 for basic steps for printing reports.

Figure 5-24: Individual Summary Report Window
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Project Summary Report
The Project Summary Report contains comprehensive information on the current project. This report
include the project information, a file list, project statistics, and a system summary.

1. Choose Project from the Summary submenu in the Reports menu.

2. Include any of the options by checking the appropriate boxes.

3. Check Introduction and click Intro Text to enter an introduction.

4. Print the report. See page 83 for basic steps for printing reports.

The following information is provided in the Project Summary report when the System Summar
option is selected:

• Processor — The microcomputer chip detected by Ultimate Family Tree. 

• Graphics Card — The graphics card or system detected by Ultimate Family Tree.

• Default Volume — The partition where the Ultimate Family Tree application is located

• Folder — The current folder.

• Start Folder — The folder where Ultimate Family Tree was started.

• Disk Size — The size of the default volume.

List Reports
The List Reports create tables of information for individuals, marriages, and sources. They also print m
lists or mailing labels, and provide a list of the data not transferred into Ultimate Family Tree via a GE
COM file. For more information on GEDCOM, see page 145.

Figure 5-25: Project Summary Report Window

Include information from
Project Info window

Include list of data
files used in project

Include project statistics
(number of people,
places, etc.)

Information about
computer being used
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Individual, Marriage and Source List Reports
1. Choose Lists from the Reports menu, and then choose Individual, Marriage or Source from the

menu.

2. To select the items to include in the report, double-click each item in the Field List (or highlight 
item and press Return). To insert a selected field from the Field List into the selected list, select
field below which you want the first field to be. Click the insert button. When fields are added to
Selected list, the Columns Used display is updated.

The fields print in the order shown in the Selected list. To remove an item from the Selecte
using the mouse, double-click the item. Using the keyboard, select the item and press the Return
remove it.

Note The Level 2 category for Birth and Death place names is generally used for the county.

3. Check the Skip 1st Col box to omit the first column in the Selected list from printing. This gives 
the ability to sort the list on the first column field, but not actually print the first column informatio
You can then attach many reports side-by-side that are sorted using the same field without hav
print the redundant column over and over.

4. Check the Line Numbers box to include them to the left of the first column.

5. Select one of the following font size options:

• Small — Allows the most information to be printed on a single page

• Medium — Uses a larger font size and therefore prints fewer columns

• Large — Uses the largest font size and prints the least amount of information

Note Selecting a font size determines the number of columns available for the report. The sma
the font, the more columns you are able to print.

6. Print the report. See page 83 for basic steps for printing reports.

Figure 5-26: Individual List Report Window
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Mail List Report
The Mail List Report contains a complete or selected list of mailing addresses and phone numbers fo
viduals in your project. This list can be formatted and printed as mail labels. You enter mailing address
phone numbers for an individual in the Miscellaneous Individual Information window opened through
Individual Record (see page 46).

1. From the Reports menu, choose Lists, and then Mail from the submenu.

2. Select the order in which you want the addresses to be printed in the Order group.

Note The name entered in the addressee field can be different from the name in the Individua
Record window, such as Mr. and Mrs. Thomas Smith instead of Nancy Smith. Ultimate Family Tree 
does not differentiate between first and last names in the Mail Label window. Mr. and Mrs. Thomas 
Smith will print in the mail list before Nancy Smith, if the Label Name radio button is selected, becau
M comes before N in the alphabet.

3. Choose Report Format to print the mail list as a report page, or choose Label Format to print on
labels.

4. Enter a title you want to be printed at the top of the mail list. This field is available only when Re
Format is selected from the Format group in this window.

5. To include introductory text in your report, check the Introduction box, click the Intro Text button,
enter the text in the Edit Text window. These options are available only when Report Format is 
selected.

6. Print the report. See page 83 for basic steps for printing reports.

Figure 5-27: Mail List Report Window

Use name from
Mail Label window
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GEDCOM Exceptions List Report
The GEDCOM Exceptions List prepares a list of data that did not transfer into Ultimate Family Tree v
GEDCOM import. You can also view the missing data on screen by choosing Project from the Utilities 
and GEDCOM Exceptions from the submenu to open the GEDCOM Exceptions window.

1. After importing a GEDCOM file, choose Lists from the Reports menu and GEDCOM Exception
from the submenu.

2. To select the items to include in the report, double-click each item in the Field List (or highlight 
item and press Return). To insert a selected field in the Field List above the selected field in the
Selected list, click the Insert button. When fields are added to the Selected list, the Columns Us
play is updated.

The fields print in the order shown in the Selected list. To remove an item from the Selecte
using the mouse, double-click the item in the Selected list. Using the keyboard, select the item 
press the Return key to remove it.

3. The choices in the Field List include:

• File Position — The position in the GEDCOM file (number of characters from the start) where th
exception is located

• Level — The level number of the excepted item in the GEDCOM file. For example, the BIRT tag
an individual is level 1 and the DATE tag under the BIRT tag is level 2

• Error Tag — The GEDCOM tag to which the exception belongs, such as PLAC or DATE

• Error Text — The text or information that did not import into Ultimate Family Tree

• Indiv No — The individual record number in Ultimate Family Tree for the individual associated w
the exception

• Event Type — The name of the event in Ultimate Family Tree (such as Birth) that is associated w
the exception

Figure 5-28: GEDCOM Exceptions Report Window



T I N Y - T A F E L  RE P O R T 1 1 1

you 
n. 

ing to 

 

line of 
t family 
ndants 

 
rward 

els are 

ave 

 the 
st 

w to 
e. For 
ecent 
4. Check the Skip 1st Col box to omit the first column in the Selected list from printing. This gives 
the ability to sort the list on the first column field, but not actually print the first column informatio
You can then attach many reports side-by-side that are sorted using the same field without hav
print the redundant column over and over.

5. Check the Line Numbers box to include them to the left of the first column for this report.

6. Select one of the following options for font sizes:

• Small — Prints the most information on a single page

• Medium — Uses a larger font and therefore prints fewer columns

• Large — Uses the largest font and prints the least amount of information

Note The selection you make determines the number of columns available for the report. The 
smaller the font, the more columns you are able to print. Col/Page indicates the number of columns 
available at the selected font size. Col Used indicates total columns used when selections are made
from the Field List. Col Left indicates the number of columns still available.

7. Choose Print in the report window. See page 83 for basic steps for printing reports.

Tiny-Tafel Report
The Tiny-Tafel Report is a shortened version of an Ancestor (Ahnentafel) list. The report contains one 
text for each family line. It also contains the surnames, time periods, and locations represented by tha
line, plus codes to signify the degree of interest in receiving information about the ancestors or desce
of that line.

Every family consists of a number of family lines. A Tiny-Tafel family line starts with an ancestor
(with a particular surname) for whom you have assigned an Ancestor Interest (AI) level and extends fo
in time to all descendants for whom you have set a Descendant Interest (DI) level. These interest lev
assigned in the Miscellaneous Individual Information window from the Individual Record.

Note If more than one DI level is set in a family line, a new Tiny-Tafel line is created. You can h
two or more lines for the same family line with different interest levels.

For Ultimate Family Tree to establish a family line and create a Tiny-Tafel Report, you must set
Ancestor Interest (AI) level for the earliest ancestor and the Descendant Interest (DI) level for the late
descendant in a line.

Adding Ancestor and Descendant Interest Levels
You can easily add interest level flags to an existing project. For the AI level, use the Pedigree windo
spot the gaps in your family tree and identify the individuals whose line you want to extend back in tim
the DI level, use the Descendant window to move forward through a family line and identify the most r
individuals.
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To get the most out of the Tiny Tafel report, follow these interest level ranking guidelines when s
the AI and DI levels in your project:

• 0 — The individual is not used to establish either the Ancestor or Descendant end of a line.

• 1 — No interest, and reliability of the data is marginal, making it of little interest to others, but us
establish one end of a family line.

• 2 — Low interest, but contains high quality data that might be of substantial interest to other res
ers.

• 3 — Moderate interest, data quality is good or poor.

• 4 — Highest interest, data quality is good or poor.

1. Choose Individual Record from the Build menu to open the Individual Record window.

2. Choose Locate from the Search menu to find the earliest ancestor in a family line you are intere

3. Click the More button, and then click Miscellaneous to open the Miscellaneous Individual Inform
window.

4. Enter the AI level.

Note Set the AI level only on the earliest ancestor in a family line you are interested in. Becaus
Descendant Interest Level setting higher than 0 will result in a separate Tiny-Tafel line for each 
vidual so marked, set the DI level only if you are interested in receiving Tiny-Tafel information fo
selected individual.

5. Click OK.

6. Choose Locate from the Search menu and select the most recent individual in the family line.

Figure 5-29: Miscellaneous Individual Information Window

Ancestor Interest Level

Descendant Interest Level
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7. Click the More button and then click Miscellaneous.

8. Enter a DI level.

Note In most cases, a DI level is used to indicate that you are interested in all descendants ac
family line, so you can select the most recent individual in the family line for the interest level se

9. If you have a gap in a family line, use AI and DI to indicate that you would like to fill in the gap. 
the DI on the older end of the gap (because that individual’s descendants are missing) to 4, and
AI on the younger end (you want information on that individual’s ancestors) to 4.

Printing a Tiny-Tafel Report
1. Choose Tiny-Tafel from the Reports menu.

2. Choose one of the AI/DI Threshold options.

Note Eight radio buttons are available to select what appears in the Tiny-Tafel report; four radi
tons are for the AI level, and four radio buttons are for the DI level. Select the appropriate radio b
in each column for the lowest interest level to be included in the Tiny-Tafel. If you select 2, then
est levels 2, 3, and 4 are included. If you select 4, only interest level 4 is included.

3. Check the Use List box if you want to use the Grouping List to limit the individuals included in th
Tiny-Tafel Report.

Note To create a Tiny-Tafel for one family line, use the Relationship Search feature to identify 
line, and then add the results to the Grouping List. You can also use the Miscellaneous Search w
to search for an Ancestor and/or Descendant Interest level, and add the resulting people to the
ing List.

4. Click the Submitter button. A submitter is the person offering his or her selected genealogical d
along with requests for further information.

5. Enter the submitter’s name (up to 38 characters). Enter your name exactly as you do when you
to a bulletin board system. For example, if you use John Doe for the bulletin board, do not use John H. 
Doe in the header. This field is mandatory. The report cannot be created if the Submitter name i
entered. The remainder of the header fields are optional:

Figure 5-30: Tiny-Tafel Report Window
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• Address — Your mail address, up to four lines of 38 characters each

• Telephone — Your telephone number, up to 38 characters

• Services — The communication services where you can be contacted, up to 3 lines of 38 charac
each. Generally, these lines will be in the form, name of service/login name.

• BBS — Enter the name of the BBS you’re using as name of BBS/telephone number, up to 38 charac-
ters.

• Remarks — Remarks about the Tiny-Tafel. For example, how to send information other than on fl
disks.

• Disk Format — The disk format that you prefer to exchange information with other researchers. 
Other selection specifies no specific disk format. If you want to receive Tiny-Tafel information by
phone or in writing, state your preference on the Remarks line.

6. Click OK to return to the Tiny Tafel Report window

7. Print the report. See page 83 for basic steps for printing reports.

8. If the Tiny-Tafel is not automatically opened by your word processor, open the Tiny-Tafel RTF fi
manually and save the report as a plain text file. You can now upload your Tiny-Tafel to a BBS.

Figure 5-31: Tiny-Tafel Submitter Window
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Ultimate Family Tree can create Instant Web Page Family Journals and Descendant Box Charts suita
publishing on the World Wide Web (WWW or Web). The Modified Register Family Journal report form
used for the Family Journal Instant Web Page. Actual family histories submitted by users of Ultimate F
Tree can be seen at http://www.uftree.com.

In this section, you will learn how to:

✓ Plan your online family history — style, format, and graphics

✓ Create or identify images in the Media Library you want to use

✓ Specify Preferred Images for each individual

✓ Create the Family Journal Instant Web Page using the Web option 

✓ Create the Box Chart Instant Web Page

✓ Preview the Instant Web Page

✓ Register online with Palladium to reserve your Web space

✓ Upload your Instant Web Page
1 1 5
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Cautions
• In preparing your Web page, be sensitive to the wishes of other family members who may not w

certain information to be placed on the Web.

• Be sure to include your email address so other researchers and family members can contact yo

• Remember that genealogical information is only as useful as its documentation. Cite your sourc

Creating an Instant Web Page
A Family Journal Instant Web Page contains the following information:

• Family history name as entered in the Book Title field in the Page Setup window

• Contact information for the author of the family history including an email link and the researche
name, address, and telephone number as entered in the Project Info window.

• Link to an optional GEDCOM file for downloading

• List of surnames included in the report

• Introduction

• Family Journal (genealogy) report in the Modified Register format, using Descendant, Family or
Reverse Register

• Footnotes and references linked to text in the report

• Index of names in the report

• Ability to suppress information about living family members

• Images connected to the Title, Introduction, or any individual in the report

• Audio files in any accepted format. Currently these include .WAV, .AU, and .AIF

• Links to other Universal Resource Locators (URLs). A URL in the Web Link field of the Miscella
neous Individual Information window links an individual to any other Internet URL. This link can
to images, sounds, or other genealogies. For example, you can link John F. Kennedy to a gene
another WWW site. If this genealogy is found at URL http://www.anothersite.com/jfk.html, enter this 
address in the Web Link field for John F. Kennedy. Someone browsing your genealogy can then
the link to move to the new page for JFK.
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A Box Chart Instant Web Page contains the following information:

• A starting individual and his or her descendants up to 16 generations

• Birth and death years (optional) for all individuals listed in the box chart

• Option to suppress information on living people

File Organization
Ultimate Family Tree provides a number of options for saving a family history file. The family history ca
saved as:

• One file

• Multiple files in a single folder

• Multiple files in multiple folders

The option you choose depends on the size of the family history you wish to create and the capa
of the WWW server you will be using.

The main reason to use multiple files is to improve the speed. A large file takes a long time to lo
while small files can be accessed by a browser much more rapidly. The multiple-folder option allows a
number of files to be divided into separate folders. Use multiple files in multiple folders for uploading t
Palladium Ultimate Family Tree Web site.

Figure 6-1: Miscellaneous Individual Information Window

Enter URL to link 
individual to that URL
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Multiple File Option
The following files are created by Ultimate Family Tree:

• INDEX.HTM — The main family history file containing the table of contents, surname list, and in
duction.

• Innnnnnn.HTM — Files for each main individual in the report. The record number of the individua
uses the format nnnnnnn, preceded by zero's. For example, a file for a person having record nu
would be I0000008.HTM.

• SOURCES.HTM — The source citations for the report.

• NINDEX.HTM — The name index for the family history.

• HTMFILES.TXT — A list of files created for this family history.

• name.ZIP — Zip compressed archive when Web option is selected.

Multiple Subfolder Option
Ultimate Family Tree places the main individual files in separate subfolders. The subfolders are crea
automatically below the starting folder if they do not already exist. The number of files in each folder c
set from the Options window, described on page 121. All other files listed previously are located in th
ing folder.

The subfolders created by Ultimate Family Tree have the name Dnnn, where nnn is the number of the 
folder starting with zero. If you have 500 files and have set the file per folder limit to 200, Ultimate Fa
Tree will create three subfolders, D0, D1, and D2.

Linking Files

Images
If a preferred image (see page 136) is linked to an individual who is included in the Web Page report,
be automatically extracted from your Media Library and located in the Ultimate Family Tree HTML 
GRAPHICS subfolder.

Additional image links are provided:

• Background — Provides a background texture for the family history. Not all browsers support ba
ground images.

• Header Graphic — Displays at the top of the first page. Use this for a family picture or graphic.

• Title Graphic — Appears at the top of the first page under the header graphic. Use this for a gra
version of your title. It replaces the chapter title.

• Bullet Graphic — Precedes the names of the children the first time they are introduced following
parents in each generation.
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• GEDCOM Graphic — Precedes the URL for immediate downloading of the GEDCOM file specifi
on the entry line, left aligned. Available for the Web option only. Be sure to specify a GEDCOM 
name as described later.

• Email Graphic — Appears left aligned at the end of the document preceding the URL for sendin
immediate email. Available for the Web option only. Be sure to include your email address as 
described later.

• Table of Contents — Appears left aligned at the end of each page to go back to the main HTML p
It precedes the phrase, “Table of Contents.”

• Next Page Icon — Appears at the bottom of a page in multiple-page HTMLs.

• Previous Page Icon — Appears at the bottom of a page in multiple-page HTMLs.

• Horizontal Rule — Specifies a separator bar used to separate items in the report. Normally a na
page-width image.

• Audio Graphic — Precedes the URL for transmission of a sound file. Be sure to specify the audi
name.

A number of graphic (.GIF) files are included with Ultimate Family Tree for your use. These gra
files are located in the Images subfolder.

Sounds
You can also include a sound file.

• Audio File — Links a .WAV, .AU, or .AIF sound file.

Immediate GEDCOM
You can specify a GEDCOM file so a viewer can display onscreen or save to disk a specific GEDCO
This file can be a compressed file created with a utility such as StuffIt or ZipIt.

Connecting to Palladium Interactive
To connect directly to the Ultimate Family Tree Web site, from the Online menu, choose Connect to Pall
net. Your browser must be set up in Ultimate Family Tree to connect to the Ultimate Family Tree Web
(see page 3).
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Family Journal Instant Web Page Tutorial
The following tutorial presents the sequence of steps you take to create a Family Journal page on th

1. From the Online menu, choose Instant Web Page.

2. From the Instant Web Page window, click Family Journal.

3. Specify the report options and starting individual for your report. The options on the Instant Web
window are similar to the options on the Family Journal report window. See page 88.

4. Select Hide Living Info to suppress information about living family members. The names of livin
individuals and the connections to their families remain intact, however events, including dates 
places, will not be included. The notation, “(still alive),” prints after the name. Ultimate Family Tr
determines individuals who are still alive by checking for a Y(es) in the Living field in the Individ
Record window.

Figure 6-2: Web Page Window

Figure 6-3: Instant Web Page Window
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5. Select the Local or Web option in the Destination group as desired:

• Local — Creates HTML files for local viewing and is not meant for the Internet. This option omits
URL email and download links you have configured in the program, and will not archive the files
you.

• Web — Prepares the HTML files for uploading to your server. This option inserts all URLs as 
configured.

6. Click Options to open the Instant Web Page Options window.

Select any options as described below:

• Parent Images — Checks for images for all main individuals in the report. If found, the image is 
inserted in the Web page describing the individual.

• Child Images — Checks for images for all children in the report. If found, the image is inserted in
Web page for children.

• Project Information — Include information from the Project Information window in your Web page

• Link to Palladium Interactive — When checked, includes a link on the family history Web page th
connects to the Palladium home page. Visitors can find out more about genealogy, the Ultimate 
Tree program and Palladium Interactive.

• Left Align/Center — Controls placement of images and section titles. Not all browsers support ce
ing; some simply ignore it.

• Single File — Creates one large family history file. Do not select this option if creating a Web pag
uploading to Palladium Interactive.

• Single Folder — Specifies a single folder when single file is not checked. Do not select this optio
creating a Web page for uploading to Palladium Interactive.

• Files Per Folder — Specifies the number of files you want in each subfolder. Do not enter a num
larger than 500.

Figure 6-4: Instant Web Page Options Window

Select options to
include on Web page

Enter email address
(or leave blank)

Optional FTP address
for GEDCOM file
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• Email Address — Provides your email address. When this field is left blank, your email address i
included in the Instant Web Page.

• FTP Address for GEDCOM File — Location displayed on Web pages from which a file can be FTP

Note This is an optional way to provide a GEDCOM file for your Family History. Normally it is b
to include the GEDCOM file with the Instant Web Page.

7. Click OK.

8. Click the Graphics button in the Instant Web Page window.

9. Select any field and click Browse to find an existing graphics file, or type the names of the vario
sound and graphic files in the appropriate field.

10. Select GIF files for each option you want to use, and click OK.

11. Enter a GEDCOM or audio file in the appropriate field for inclusion in the Instant Web Page.

12. Select any field with a graphic entered and click Preview to view the graphic. Click OK to return 
Graphics window.

13. Click Save As. Select from the existing list, or enter a name for the Instant Web Page. Ultimate F
Tree creates a subfolder with the name you have chosen. The main Web page file is named ind

14. Click OK to create the Web Page.

Figure 6-5: Instant Web Page Graphics Window

Type file name, or
click Browse to
automatically add
file name
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Box Chart Instant Web Page Tutorial
The following tutorial contains the steps to create a Box Chart Instant Web Page:

1. From the Online menu, choose Instant Web Page.

2. In the Web Page window, click Box Chart.

3. Click the Options button to open the Instant Web Page Options window. For information on usin
window, see page 121

4. Click OK.

5. Click the Graphics button to open the Instant Web Page Graphics window. For information on u
this window, see page 122.

6. Click OK.

Figure 6-6: Save Web Page As Dialog

Enter new Web page name

List of Web pages created

Figure 6-7: Descendant Box Chart Web Page Window
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If you want to create a Web page for a new Box chart, follow these steps (or skip to step 9 for existing c

7. Click New to create a new Box Chart. The New Chart window opens with options to include Bir
Death dates for individuals, and an option to hide information for living individuals.

Note In preparing your Web page, be sensitive to the wishes of family members who may not 
certain information to be made available on the Web.

8. Select the options for the Box Chart Instant Web page and click OK. Skip to step 10.

If you want to create a Web page for a new Box chart, follow these steps:

9. Select the chart name and click Existing.

10. Enter a name for the new Web page in the Save Web Page As Window and click OK.

Note The following Chart menu options are not available while in HTML Mode: Graphics, Font
Colors, No Events, One Event and Two Events. Instead of events, only birth and death years ar
included in the Box Chart web page. The Ruler and Page Layout lines options on the View men
not available in HTML Mode.

11. Choose Separate Surnames from the Chart menu to print given names and surnames on sepa

12. Choose Auto Edit Text from the Chart menu to automatically truncate names to fit inside the bo

13. Choose Record Numbers from the Chart menu to include record numbers on the Web page.

14. From the File menu, choose Create HTML. The Create Web Page window opens.

15. Click Create HTML Files.

Previewing an Instant Web Page
1. From the Online menu, choose Preview Instant Web Page.

2. Select a Web page from the pop-up menu.

3. Click OK. The Web browser you configured in Ultimate Family Tree opens with the Web page y
selected. See page 3 for information on configuring a browser for Ultimate Family Tree.

4. After viewing your Web page, exit the browser to return to Ultimate Family Tree.

Deleting a Family Journal Instant Web Page
1. From the Online menu, choose Instant Web Page.

2. Click Family Journal.

3. Click Save As.

4. Select the Web page you want to delete and click Delete.
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Deleting a Box Chart Instant Web Page
1. From the Online menu, choose Instant Web Page.

2. Click Box Chart.

3. Select the chart to delete and click Selected. Click All to delete all Box Chart Web pages.

Going Online from Ultimate Family Tree
If you have a manual dialer (such as FreePPP), you must take certain steps to ensure the smooth ope
the Ultimate Family Tree online functions.

Make sure that your browser is not running before you choose Connect to Palladiumnet from the 
Online menu. Choosing Connect to Palladiumnet will start your browser automatically. Use the Applic
menu (the icon at the far right side of the menu bar) to switch between applications. Do not choose C
to Palladiumnet to return to your already running browser.

When using a manual dialer, after you choose Connect to Palladiumnet from the Online menu, 
mate Family Tree will display a message reminding you to manually connect to the Internet. Switch t
Finder and launch your dialer. After dialing up, bring the program called ADMIN to the front. This sho
redisplay the message box. Click OK.

Whether you dialed manually or connected through a network, Ultimate Family Tree will now st
your browser and take you to the Ultimate Family Tree Web Site, which contains a “Members Only” se
available only to Ultimate Family Tree CD-ROM owners.

Before you go online from Ultimate Family Tree, follow these steps:

1. Quit your browser if it is running.

2. Select Connect to Palladiumnet from the Online menu.

3. Dial your Internet service provider (ISP) manually, if necessary.

Before you upload Web pages from Ultimate Family Tree, you must go online and register in th
Members Only section. Then follow these steps:

1. Select Upload Web Page from the Online menu.

2. Dial your ISP manually, if necessary.

3. Wait while Ultimate Family Tree uploads your Web page to the Palladium server, then close you
nection, if still connected.

When you quit your browser, Ultimate Family Tree will display a reminder that you may close your Int
connection. However, this is unnecessary if you plan to go online again soon. In any case, click OK t
miss the reminder.
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Registering with Palladium Interactive
You must register with Palladium Interactive before uploading your Instant Web Pages.

1. From the Online menu, choose Register Online.

2. Click Go Online. Ultimate Family Tree will automatically connect with the Palladium Interactive W
site. The program pauses until the connection is made. Not all browsers will automatically dial y
phone and connect to your Internet Service Provider (ISP). If your browser does not connect au
ically, it will be necessary for you to connect to your ISP first. Once your online session is throug
sure to disconnect from your ISP.

3. From the home page of the Ultimate Family Tree Web site, click the Publish Your Page link under th
Family Web Pages icon.

4. Follow the instructions on the screen to complete your registration.

Uploading Your Web Page
After creating a Web Page and registering with Palladium, you can upload the Web page to the Palla
Interactive Web site. During this process, Ultimate Family Tree will attempt to connect to the Palladiu
server and send your Web page. While in progress, do not switch applications. If you want to cancel 
operation, click Cancel.

1. From the Online menu, choose Upload Web Page.

Figure 6-8: Upload Instant Web Page Window
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Note If you are using a manual dialer, Ultimate Family Tree will display a message reminding y
manually connect to the Internet. Switch to the Finder and launch your dialer. After dialing up, b
the program called PDFTP to the front. The reminder message should reappear. Click OK.

2. Read the disclaimer (see Figure 6-9). Click the I Accept button to accept the terms of the agreem
you do not want to see the disclaimer each time you upload a Web page, select that option befo
choosing I Accept. If you click I Decline, you will be returned to Ultimate Family Tree.

3. Select the Web page you want to upload from the pop-up menu.

4. Type the title of your family history.

5. Type the author’s name. This is normally your name.

6. Type a short description of the family history.

Note The title, author’s name, and description are used by Palladium to create an online card c
of all family histories that are available.

7. Type the name and password you used to register online with Palladium.

8. Click Upload. Ultimate Family Tree will now create a Zip compressed file for uploading to the Pa
umnet server.

Figure 6-9: Palladium Disclaimer

Palladium Interactive Notice
We are pleased that you want to create a “Family Tree” Web page. In order to ensure enjoyment by all of our customers, w
must establish some basic rules.

Third Party Content In creating your World Wide Web page to be uploaded on the Palladium World Wide Web site 
(“Site”), you may not use any material that is protected by copyright of a third party without first obtaining permission from 
the copyright owner. You, not Palladium, are responsible for any damages such as copyright infringement or any other har
that results from Palladium's use of any items submitted by you. You agree to indemnify and hold Palladium harmless from
any claims, reasonable expenses, or attorneys' fees relating to any violation of these rules or submission of any material toal-
ladium. Remember that submission of such material to Palladium for use on the Site grants to Palladium the right to use, 
reproduce, modify, distribute, publicly perform and publicly display such material.

Objectionable or Defamatory Content Users are prohibited from posting or transmitting any obscene, hateful, def-
amatory, racially or otherwise objectionable language, images, software or content of any kind, including without limitation
any material that would constitute libel, slander, defamation, or invasions of publicity or privacy of any third party in any juris-
diction. You will indemnify, defend, and hold harmless Palladium and its representatives from any and all losses, claims, lia
bilities, obligations, reasonable expenses or attorneys’ fees which arise in connection with objectionable or defamatory 
content in the materials submitted by you.
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Troubleshooting
If you have a slow browser or modem, you may want to disable automatic image loading (found in th
erences of most browsers). The resulting text-only pages will load quickly, and give you the same inf
tion without the accompanying graphics. Some browsers will then allow you to display graphics by cli
on their placeholders. (Consult your browser’s online help or user’s guide.)

Ultimate Family Tree will not open your browser if you change it’s name or location on your har
drive. If you do so, or want to upgrade or switch to a different browser, run the Browser Setup Wizard
Ultimate Family Tree folder.

Note From time to time, you will see various dialog boxes informing you about the state of Ultim
Family Tree. You must dismiss these dialogs before returning online.

Supported Macintosh Browsers

Netscape Navigator™ 2.0 or later
Microsoft Internet Explorer 2.0 or later

Supported Macintosh TCP, Open Transport, and Dialers

MacTCP 2.0.4 or greater
Open Transport 1.1 or greater
MacPPP 2.0.1 or greater
FreePPP 1.0.5 or greater

Quitting Your Browser

If you quit your browser and your dialer does not hang up automatically, you can do so manually by u
the Finder to bring forward the dialer program and quitting to avoid further connect charges.

Netscape Navigator™ and Internet Explorer allow you to open mulitple Web page documents. C
the last (or only) Web page will not quit the browser. Make sure that you use the pulldown menu to qu
browser and return to Ultimate Family Tree.
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Using the media features in Ultimate Family Tree, you can create family-oriented slide shows and dra
library of images. Images can be displayed and included in printed reports. The image formats suppo
PICT (16.7 million colors, 24-bit), CompuServe GIF (256 colors, 8-bit), Aldus TIFF (16.7 million color
24-bit), and Joint Photographic Experts Group (JPEG) (16.7 million colors, 24-bit).

Note Apple QuickTime must be active for JPEG format to be supported.

Media is stored and maintained in the Ultimate Family Tree Media Library. Once entered in the 
Library, media can be linked to as many individuals and slide shows as you wish. The material is also
able to all projects. You can enter information about an image once and then use it an unlimited num
times in any project. Digitized images that are stored in a file on your computer can be displayed or p

It is important to note that all media (except referenced) must be in a digitized format for use in 
mate Family Tree. There are various ways in which this can be accomplished, from using media captu
ware and graphics programs to image scanners.

In this section you will learn how to:

✓ Add or delete media files

✓ Display images

✓ Select a preferred image (to display in various view windows)

✓ Create a Slide Show
1 2 9
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Referenced Media
Much of the media that is important to a genealogist cannot be digitized. Ultimate Family Tree provid
way to record, retain, and display a complete reference to this material. Referenced media records c
information about the identity and location of important external media, from books to lithographs. Yo
link these easily accessible records to the appropriate individuals and store the information about them
Media Library.

1. From the Build menu, choose Media Library.

2. Click the New button in the Add Media box. The New window opens.

3. Select Referenced in the Media Type box.

4. Scroll the list of media types and highlight the type you want to reference.

5. Enter a unique name (up to 20 characters) in the Ref Name field in the Media Details group. Th
Name is required because it is used in Media List boxes.

6. Enter a descriptive name (optional) for the media in the Name field. This becomes the title nam
descriptive name is limited to approximately 35 characters.

7. Enter a date (optional) for the image (up to 30 characters) in the date field.

8. Enter the physical location (optional) of the media, for example, the album number for a photog
Use any description you wish (up to 33 characters).

9. Enter the condition (optional) of the media, such as poor, fair, good, or excellent. Use any description 
you wish (up to 33 characters).

10. Click Description (optional) to open an Edit Text window where you can enter up to 65,000 char
of text describing the media. The description can include the names of the people, location of th
media, or any other information you wish. Click Import to take you to an Open dialog box where
can select external text to copy and paste into the Description text window.

11. Click OK to close the New window.

Figure 7-1: New Window
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Direct Media
Direct media are items that are digitized and stored on your hard disk. Images can be stored in a wide
of formats, such as PICT, GIF, TIFF, and JPEG, and can be incorporated into your Ultimate Family Tr
gram. When any of these file formats containing 24-bit data are imported into Ultimate Family Tree, th
compressed using the JPEG specification.

Using Media in Ultimate Family Tree
Once media is stored in the Ultimate Family Tree Media Library, it can be linked to individuals and sli
shows.

Media Library
The Media Library is the repository for all Ultimate Family Tree media files. These files are added or d
from the Media Library window. This window contains detailed information about the images in Ultim
Family Tree projects. You can use this window to enter new images, to modify existing media records
export image files, or to delete media records.

Adding a Digitized Image
1. From the Build menu, choose Media Library.

2. Click New in the Add Media group to open the New window.

Figure 7-2: Media Library Window

List of available
media
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3. Select Digitized Image in the Media Type group.

4. Click File in the Add New Media From group.

5. Select the folder where you placed the image file. A list of image files appears in the Select Ima
window.

6. Select the image you want to add to the library and click Open. If you choose an image, a wind
opens where you can preview it. Click OK to return to the Media window, or Cancel if you chang
your mind.

7. In the New media window, enter a unique name (up to 20 characters) in the Ref Name field in t
Media Details group. The Ref Name is required because it is used in the Media List boxes.

8. Enter a descriptive name (optional) in the Name field. This becomes the title name. The descrip
name is limited to 25 characters.

9. Enter the date (optional) for the image (up to 30 characters) in the date field.

Figure 7-3: New Window

Select media type

Click File to add
a digitized image
file

Figure 7-4: Open Dialog Box

List of image
files
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10. Enter the location (optional) of the media, (for example, the volume for a digitized image). Use 
description you wish (up to 33 characters).

11. Enter the condition (optional) of the media, such as poor, fair, good, or excellent. Use any desc
you wish (up to 33 characters).

12. Click Caption (optional) to open a text window where you can enter a caption for the image. Th
tion is a single line included below a digitized image when it is printed and should be limited to a
imum of 50 characters.

13. Click Description (optional) to open an Edit Text window where you can enter up to 65,000 char
of text describing the image. The description can include the names of the people in the image,
location of the image, or any other information. Click Import to take you to an Open dialog box w
you can select external text to copy and paste into the Description text window.

14. Click OK to close the New media window.

15. The Media Library window displays a Media Library list which includes the name you typed in t
Ref Name Field. Click OK to close this window.

Deleting Media
1. From the Build menu, choose Media Library.

2. Select the media you want to delete from the Library list on the left.

3. Click the Selected button in the Delete Media group to delete the selected media or click All to 
all media from the Media Library.

4. Click OK to delete the selected media or Cancel to return to the Media window.

Figure 7-5: Media Library Window

Delete selected media

Delete all media
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Displaying Images and Screen Resolutions
The resolution of your monitor directly affects the quality of the images you display. Resolution is det
mined by the number of pixels (picture elements) on the monitor and the number of colors per pixel. 
inch monitor, having 640 ´ 480 pixels and 256 colors (8-bit) is the minimum recommended configuratio
for displaying images. Image quality improves dramatically as the number of pixels and color depth 
increase.

If you are using a system that is limited to 256 colors, configure Ultimate Family Tree to use the
intosh Desktop Colors option. See page 164 for more information.

Displaying a Digitized Image
1. From the Build menu, choose Media Library.

2. Select the digitized image you want to view from the Media Library list.

3. Click Display in the Image group.

4. Add a caption for the image, or any descriptive text, in the appropriate fields.

5. Click Close to return to the Media Library window.

Figure 7-6: Display Window
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Exporting a Digitized Image

 

1. From the Build menu, choose Media Library.

2. From the Media Library list, select the digitized image you want to export.

3. Click Image from the Play group.

4. Click Export.

5. Select the image file format you want to create.

6. Click Save.

7. Select the folder in which you want to store the image.

8. Enter the file name for the image in the New Image Name field.

9. Click Save.

10. Click Close to return to the Media Library window.

 

Linking Media

 

You can link an unlimited number of images to an individual.

1. Click the More button in the Individual Record window, and then Media to open the Media Link window.

2. Make sure the name of the desired individual appears at the top of the window and click Existing 
Media from the Add Media Link box.

3. Select Media Library in the Media Source group to add existing media found in the Media Library.

Figure 7-7: Media Link Window

List of linked media

Link existing media

Link new media

Click to select
preferred image

View selected image
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Note If you wish to add media which is linked to another individual or an existing slide show, se
the appropriate radio button in the Media Source group. A list of individuals or slide shows will o
depending on your choice. Select the individual or slide show from the list and click OK.

4. Select the media you want from the Media Library list.

5. Click the Add button or double-click the media to move the selected media to the Linked Media

6. Click Add All to add all media to the Linked Media list.

7. Click Remove to remove selected media from the Linked Media List, or click Remove All to rem
all linked media from the list.

Note A description of the media is displayed in the Description box if a description was entere
the Media Library window.

8. Click OK to save and close the window.

Note The Insert button is active only when adding media to a slide show.

Selecting a Preferred Image for Display
You can link more than one image to an individual. Ultimate Family Tree gives you the option of selec
one of these images as the preferred one that will appear in the Family Tree, Family Group, and Des
windows (and will be included in an Instant Web Page and Family Journal Report). From the Media L
window, highlight the image you want as the preferred image and check the Preferred Image box. Cl
More, and then Media in an Individual Record window to open the Media Link window.

Adding New Media to an Individual
1. Click More and then Media in the Individual Record of the person to whom you want to add me

2. In the Media Link window, click New Media to open a New media window.

3. Select Digitized Image in the Media Type group.

4. Click File in the Add New Media From group.

5. Select the folder where you placed the image file. A list of image files appears in the Add Image
box.

6. Select the image you want to add to the library and click Open. A preview window opens where
can view the image you are adding. Click OK to return to the Media window or click Cancel if yo
change your mind.

7. In the Media window, enter a unique name (up to 20 characters) in the Ref Name field, under th
Media Details group. The Ref Name (Reference) appears in the Media List boxes. This referen
required.

8. Enter a descriptive name for the media in the Name field. This becomes the title name. The des
name is limited to 25 characters (optional).
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9. Enter the free-form date for the image (up to 30 characters) in the date field (optional).

10. Enter the physical location of the media, for example, the volume for a digitized image, or the a
number for a photograph. Use any description you wish, up to 33 characters (optional).

11. Enter the condition of the media, such as poor, fair, good, or excellent. Use any description you
up to 33 characters (optional).

12. Click Caption to open a text window where you can enter a caption that is included on a single 
below a digitized image when it is printed. This optional caption is limited to a maximum of 50 c
acters.

13. Click Description to open an Edit Text window where you can enter up to 65,000 characters of 
describing the image. The description can include the names of the people in the image, the loca
the image, or any other information. Click Import to take you to an Open dialog box where you 
select external text to copy and paste into the Description text window (optional).

14. Click OK to close the New window.

15. Click OK to close the Media Link window.

Unlinking Media from an Individual
1. Click the More button, and then Media in the Individual Record of the person from whom you wa

unlink media.

2. Make sure the name of the individual appears at the top of the window. From the Media Links l
select the media you want to unlink.

3. Click Selected in the Delete Media Link group to unlink the selected media or click All to unlink 
media from the individual.

Note The Delete Media buttons do not delete the media from the Media library. These buttons
merely unlink the media from the selected individual.

4. Click OK to unlink the media.

Viewing Images Linked to a Selected Individual
1. Click the More button and then Media in the Individual Record to open the Media Link window.

2. Select the image you want to view in the Media Links list.

3. Click Image in the Play group.

Slide Shows
One of the most exciting features of Ultimate Family Tree is the ability to create a slide show present
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Creating a New Slide Show
1. From the Build menu, choose Slide Show.

2. Click New in the Add Show group.

3. Enter a name in the Show Name field. This required name appears in the Slide Show list.

4. To add slides, click Existing or New in the Add Slide group. If you click Existing, continue with step
you click New, see “Adding a Digitized Image” on page 131.

Figure 7-8: Slide Show Window

Type name for
new slide show

List of slide shows
in project

Media type of
selected image

Set time for
selected image

Figure 7-9: Media Select Window

Media list
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5. Select the Media Library radio button in the Media Source group. Select the Selected Individual 
for media items linked to an individual. Select Slide Show to create a new slide show from an ex
slide show.

6. In the Media List, highlight the media you want to include.

7. Click Add or Add All.

8. Repeat steps 6 and 7 until all media you want to add to the slide show has been linked.

Note Click the Remove and Insert buttons to arrange the slides in the order in which you want
to be displayed. The Remove button unlinks a selected file from the slide show. The Insert butto
inserts a selected file above a highlighted item in the Linked Media list.

9. Click OK to return to the Slide Show window.

10. Highlight a slide in the Selected Show list and set the time (in seconds) that you wish the slide t
Repeat this for each slide.

11. To view any of the slides or view the complete slide show, click any of the following buttons in th
Play group:

• Image — Displays the selected image

• Slide Show — Displays the entire slide show

Editing an Existing Slide Show
1. From the Build menu, choose Slide Show.

2. Highlight the slide show you wish to edit and click any of the buttons in the Add Slide, Move Slid
Delete Slide boxes to add new slides, to change the order in which the slides are displayed, or 
remove slides from the Slide Show.

3. Click OK to save changes and close the window.

Adding all Media Linked to an Individual to a Slide Show
You can create slide shows about several different people by adding all media linked to an individual
new or existing slide show.

1. From the Build menu, choose Slide Show. To create a new slide show, follow the steps in “Crea
New Slide Show” on page 138.

2. Highlight the slide show to which you want to link an individual’s linked media and click Existing
the Add Slide group.

3. In the Media Select window, select the Selected Individual radio button from the Media Source g
A Candidate Individuals window opens listing all individuals within the project with linked media

4. Select the individual whose linked media list you want to use and click OK to open the Media S
window. The media linked to the selected individual is listed in the Media list.
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5. In the Media List, highlight the media you want to include.

6. Click Add, or Add All.

7. Repeat steps 5 and 6 until all media you want to add to the slide show has been linked.

Note Click the Remove and Insert buttons to arrange the slides in the order in which you want
to be displayed. The Remove button unlinks a selected file from the slide show. The Insert butto
inserts a selected file above a highlighted item in the Linked Media list.

8. Click OK to return to the Slide Show window.

9. Highlight a slide in the Selected Show list and set the time (in seconds) that you wish the slide t
Repeat this for each slide.

10. Click OK to close the Slide Show window.

Adding an Existing Slide Show to a Slide Show
1. From the Build menu, choose Slide Show. To create a new slide show, follow the steps in “Crea

New Slide Show” on page 138.

2. Highlight the slide show to which you want to link another slide show and click Existing in the A
Slide group.

3. In the Media Select window, select Slide Show from the Media Source group. A Candidate Slide
window opens listing all existing slide shows for the current project.

4. Highlight a slide show and click OK to open the Media Select window with the list of media linke
the selected slide show displayed.

5. In the Media List, highlight the media you want to include.

6. Click Add. To add all listed media to the slide show, click Add All.

7. Repeat steps 5 and 6 until all media you want to add to the slide show has been linked.

Figure 7-10: Candidate Individuals Window
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Note Click the Remove and Insert button to arrange the slides in the order in which you want t
to be displayed. The Remove button unlinks a selected file from the slide show. The Insert butto
inserts a selected file above a highlighted item in the Linked Media list.

8. Click OK to return to the Slide Show window.

9. Highlight a slide in the Selected Show list and set the time (in seconds) that you wish the slide t
Repeat this for each slide.

10. Click OK to close the Slide Show window.
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Section 8:

Managing Your Data
In this section you will learn how to:

✓ Merge two projects

✓ Import data from another program via GEDCOM

✓ Export data from Ultimate Family Tree to another program

✓ Save a project

✓ Backup (archive) a project

✓ Restore an archived (backup) file

✓ Open files

✓ Delete an individual from a project

✓ Delete a place from the Place Library

✓ Delete a source from the Source Library

✓ Use the Project Info window

✓ Exit Ultimate Family Tree

✓ Set desktop preferences

✓ Pack a project
1 4 3
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✓ Check and repair

✓ Reindex a project

✓ View a GEDCOM Exception List

Merging Projects
At some point you may want to combine one project with another.

Note To combine two projects that use different library files, use GEDCOM. 

1. Open the project into which you want to merge a second project.

2. Choose Open from the File menu to open the second project.

3. Select Ultimate Family Tree and click Open.

4. Select the folder where the second project is located. Select the project name from the list and
Open. The Project Merge Options window opens.

5. Enter the starting individual record number for the merged records. It can be the next available 
number, which appears automatically, or any higher number you choose. The Next Available Re
Number displayed in the Project Merge window is the highest record number used in the origin
project, plus one. Note that gaps will occur in the numbering of the merged records if gaps are p
in the records of the project that is being merged.

6. Click Proceed to merge the two projects. If you change your mind, click No Merge. Clicking No
Merge closes the first project and opens the second one.

7. A message appears, stating, “The two projects you have specified will be merged if you procee
original project will contain records from both projects. The second project will not be changed. 
OK to continue or Cancel if you do not want to merge the two projects.

Note If you merge two projects, duplicate individuals are not combined. Manually combine any
duplicates. See “Combining Individuals” on page 159.

Figure 8-1: Project Merge Options Window

Close original project
and open second

Proceed with merge

Enter starting individual
record number
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Data from Another Program
Ultimate Family Tree can import GEnealogical Data COMmunications (GEDCOM) data from any other soft-
ware program that is also GEDCOM compatible.

Important Note about GEDCOM The GEDCOM standard provides a set of rules that allows soft-
ware designers to create programs for exchanging genealogical information. The GEDCOM standard 
has changed considerably since it was first introduced in 1984, and continues to evolve. Prior versions 
of the GEDCOM standard were released in October 1987 (3.0) and August 1989 (4.0). Versions 1 and 
2 were drafts for public discussion, and were not established as a standard. The Family History 
Department of the LDS Church released the latest GEDCOM standard draft proposal, version 5.5, in 
December 1995. Version 5.5 addressed improvements in the treatment of sources and user-defined 
events. Ultimate Family Tree GEDCOM is designed to conform as closely as possible to version 5.3.

The GEDCOM standard, while providing an excellent starting point, can be interpreted differ-
ently by designers, resulting in potential incompatibilities. For these reasons, the export and import of 
GEDCOM information between Ultimate Family Tree and other programs must be approached wit
caution. You might need to edit or update the information that is not converted correctly. While tools 
are provided in Ultimate Family Tree to help with this process, it is extremely important to check all 
information imported to Ultimate Family Tree for error or omissions. It is also important to alert tho
receiving a GEDCOM file from Ultimate Family Tree (or any other advanced genealogy software) of
the possibility of incompatibility problems.

Importing a GEDCOM File
Ultimate Family Tree imports GEDCOM files that use either the ANSEL or IBM PC character sets. 

1. From the File menu, choose Open.

2. Select GEDCOM and click Open.

3. Select the folder where the GEDCOM file can be found.

4. Select the GEDCOM file to be imported and click Open. The Import from GEDCOM Options window 
opens.

Names Select one of the two name options:

• Convert AL SMITH to Al Smith — Select this option if your GEDCOM file has names in all upperca
and you want to convert those names to upper/lowercase.

• Convert Smith, Al to Al Smith — Select this option if your GEDCOM file has names entered as sur-
name, given name, and you want to reverse them to given name, surname.

Note Additional editing may be required if you choose either of these options. If you use the c
conversion option, MCLEAN is converted to Mclean, whereas you may want it to be McLean. If th
reverse surname option is used, Smith, Al Jr. is converted to Al Jr. Smith
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Free Date Format Select one of the four Free Date Format options. This converts dates in th
GEDCOM file to the format selected and places them in the Free-form Date field of the Individual Re
window. The date prints on unstructured reports such as the Family Journal Reports.

You can edit dates in the Individual Record or Events windows at any time. Free Date Format o
include:

• Month, day, year March 3, 1908

• Day, month, year 3 March 1908

• Day, abbreviated month, year 3 Mar 1908

• Day, abbreviated all caps month, year 3 MAR 1908

Note It is important to select the appropriate date format to ensure that Ultimate Family Tree a
matically enters dates correctly. If you do not choose the correct date format now, you must ma
change dates later.

Text Destinations: Individual Select one of the three individual text destinations:

• Biographical Text — Converts text notes attached to individuals to the Individual Biographical Te
field of the Individual Record window.

• Footnote — Converts text notes attached to individuals to the Individual Footnote Text field of th
Individual Record window.

• Research Notes — Converts text notes attached to individuals to the Individual Text Research No
field of the Individual Record window.

Text Destinations: Event In addition to the individual text destinations, select one of the three
event text destinations:

• Research Notes — Converts text notes attached to events to the Event Text Research Notes field
Individual Record window.

• Text — Converts text notes attached to events to the Event Text field of the Individual Record wi

• Footnote — Converts text notes attached to events to the Event Text Footnote field of the Individual R

Figure 8-2: Import from GEDCOM Options Window
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Other Check any of the six Other option boxes:

• Build Footnotes — Check this box if you want Ultimate Family Tree automatically to create the fo
note text that will print on reports, such as the Family Journal Report.

Note The Build Footnote process increases the time required to convert a file, depending on t
number of footnotes in your GEDCOM file. If you do not choose to build footnotes, evidence an
sources are imported and can be converted to footnote text later. You can also rebuild footnotes
the Check window opened from the Utilities, Project menu.

• Include Last Changed Date — Check this box if your GEDCOM file supports the CHAN tag for the
Last Edit Date for individual records. This date is placed in the Research Note text field in the In
ual Record window.

• Assume Marriage When Family — Check this box if your previous genealogy program does not d
tinguish between family records and marriage records, using instead a FAM tag (e.g., Personal

tral File®) as in the case of the PAF (Personal Ancestral File) program. If selected, Ultimate Fam
Tree creates a marriage record for all couples with a FAM tag.

• Remove Carriage Returns from Text — Check this box to remove carriage returns from text notes a
to allow Ultimate Family Tree to correctly wrap text.

• Retain Original Record Numbers — Check this box if your GEDCOM file supports the NUMB tag fo
individual record numbers. This option retains the record number from the previous program in 
mate Family Tree. If the conversion finds an individual without a NUMB tag, a message warns y
that if you proceed, record numbers will be unreliable. If you click Proceed, any individuals with
NUMB tags receive the original record number, and those without a NUMB tag receive the next
able record number. Click Cancel to abort the conversion.

• Add to Open Project — Check this box to merge the GEDCOM file into the current Ultimate Fami
Tree project. If no Ultimate Family Tree project is open, the Add to Open Project box is unavailabl
(dim). Cancel the options window, and open the project with which you want to merge the new p

5. Click OK when you have made your option choices.

6. Enter a file name for the project.

7. Select a folder if you wish. Use the Projects folder or a folder other than the Ultimate Family Tree 

Figure 8-3: Save Window
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8. Click Save to start the conversion. When the GEDCOM conversion is complete, a message sho
conversion time in minutes and the number of exceptions. An exception is data that did not conve
the GEDCOM file to the Ultimate Family Tree project. See “Viewing GEDCOM Exceptions” on page

9. Click OK to close the Save window.

10. Enter the appropriate data in the Project Information window. See page 162 for more informatio
this window.

11. Click OK to close the Project Information window.

Importing GEDCOM from Personal Ancestral File® for Macintosh
1. From the File menu, choose Export. A box will open asking, “What type of Export?”

2. Select GEDCOM File and click OK.

3. Select All of this Family Records file from the Export group, select PAF 2.1/2.31 on Another Macin-
tosh from the Destination group, and select which of your notes you want to include with your fil
Choose All Notes, No Notes, or tagged notes only.

4. Click OK.

5. If you want to save your GEDCOM file on a disk, insert a disk and click Drive to switch from you
hard drive to the disk drive. Name your file and click Save.

6. Click Done. The Submitter’s Name and Address window will appear. Enter or change the subm
information if necessary. Click OK

7. A window opens where you can add a note to the file if you like. Click OK and the GEDCOM file
be created.

8. Follow the steps starting on page 145 to convert the PAF GEDCOM file to Ultimate Family Tree F

Importing GEDCOM from Reunion ®

If your family’s data has been stored in Reunion, here’s how to transfer it to Ultimate Family Tree:

1. In Reunion, choose File, Open to open a family file.

2. Choose File, Export, GEDCOM file. This will open the GEDCOM Export window.

Note If you want to export data from Reunion’s five custom fields to GEDCOM tags that Ultima
Family Tree will understand, follow the procedure in the Reunion manual for assigning outgoing
tom field data.

3. In the Destination field, specify Other.

4. Click Export to open a Save window. Enter a file name and click Save.

5. Follow the steps starting on page 145 to convert the GEDCOM file to Ultimate Family Tree.
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Importing Unrecognized Events
When importing from other genealogy programs, events that are not recognized by Ultimate Family T
transfer with the # character in front of the event name.

When transferred, these events do not have GEDCOM tags. They will not be included in GEDC
exports. To transform them into fully recognizable and usable event records within Ultimate Family Tr
first find the events and the individuals connected to them.

1. From Search menu, choose Events.

2. Select the # event from the Possible Events list.

3. Select Use Selected Event below the Possible Events list.

4. Do not check the Selected box in the Places group.

5. Enter today’s date in the Before field of the Dates group. Leave the After field blank.

6. Choose Then replace the list with those found from the pop-up list.

7. Click the Search button. The Results list opens.

8. Double-click the first name in the list to open the Individual Record for that person.

9. Create a new event for that person using either a Ultimate Family Tree event type or a new eve
you create. See “Adding Events” on page 28 and “Creating a New Event Type” on page 32.

10. Delete the original # event by clicking the number to the right of the event name on the Individu
Record and clicking the Delete button on the right side of the Events window.

11. Click OK when prompted to delete the event.

12. Save the record by choosing Save from the File menu.

13. Go Down List from the Go menu to move to the next person in the Events Search list.

14. Repeat Steps 1–13 for any other # event types.

Figure 8-4: Events Search Window

GEDCOM 
events import like this
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Exporting Data to Another Program using GEDCOM
The GEDCOM standard was developed to provide a flexible format for exchanging genealogical data
A program that reads and writes GEDCOM data can exchange data with other GEDCOM-compatible
programs.

Ultimate Family Tree provides four GEDCOM export options: Basic, Version 4, Family GEDCOM
Version 5.3, and Event GEDCOM Version 1.0. The first three GEDCOM options have been approved 
Family History Department of the LDS Church for submitting GEDCOM format data to the LDS Ance
File™. Approval of Event GEDCOM is pending.

The Ultimate Family Tree GEDCOM files, compatible with GEDCOM Version 5.5 and earlier, co
nect individuals through families. In this sense, GEDCOM 5.5 and its ancestors are family-oriented.

Creating a GEDCOM File
1. From the File menu, choose Save As.

2. Select GEDCOM from the Select a File Type list.

3. Click Options. The Save As GEDCOM Options window opens, providing selections that determ
the format and content of Ultimate Family Tree GEDCOM files.

Figure 8-5: Save As Window

Choose GEDCOM

Figure 8-6: Save As GEDCOM Options Window

Check to export 
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4. Use grouping to create a GEDCOM export with only part of your project. To export a selected fa
line, use the Relationship Search window to define the family, and then add the results to the gr
list. Check the Use List box under Individuals in the Grouping field to export only the individuals
found in the grouping List.

5. Choose one of the four GEDCOM Format types:

• Basic — Creates a GEDCOM file that contains information about family links and the basic even
birth, marriage, death and burial. Basic GEDCOM export is useful for sending minimal data to p
grams, such as special purpose utilities used for creating genealogical charts.

• Version 4 — This format uses the GEDCOM 4.1 specifications.

• Family 5.3 — This format uses the GEDCOM 5.3 specifications. Use this option if you are trans
ring information to another genealogy program that currently supports the GEDCOM 5.3 specifi
tion.

Miscellaneous and Medical information, except for Flags and Ancestor and Descendant Int
is not exported. On the Individual Record window, Individual Text Footnote, Event Text Footnote
Research Notes are not exported. Media files are also not exported.

• Event 1.0 — This format provides the most complete information transfer. It is an extension of Fa
version 5.3 that incorporates features for transferring events, roles, sources, and images. Even
COM is designed to be compatible with lineage-linked systems, while providing extensive suppo
event-oriented systems, such as COMMSOFT’s ROOTS IV. At the current time, only Ultimate Fa
Tree, and COMMSOFT’s Visual ROOTS and ROOTS IV support Event GEDCOM.

Note Photo files are created for all linked images and are located in the folder in which the GE
COM file was saved. The files normally have an extension that indicates their format. If Ultimate
ily Tree finds a file of the same name, it converts the extension to a number from 1 to 999.

6. Create an Event GEDCOM. The Event GEDCOM group is unavailable unless you select Event
the GEDCOM Format group. The Event GEDCOM file can contain a dictionary of event and so
types. Use the Event/Source Types radio buttons to determine how much event/source type inf
tion is included in the file. Check any applicable Data option boxes:

Figure 8-7: GEDCOM Options Window

Do not include event and source
types in Event 1.0 header

Include event and source types
used in the Event 1.0 transmission

Include all event and source types
in the Ultimate Family Tree libraries
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• Individual — Includes information about individuals

• Family — Includes lineage-linked family information. This option is required to maintain compat
ity with lineage-linked family systems. It is not required when communicating with other Event V
sion 1.0 programs such as ROOTS IV.

• Event — Includes information about events

• Place — Includes information for places

• Source — Includes information for sources

• Image — Includes information about images

Note If you have created a media library in Ultimate Family Tree, linked media are exported to
external files that can be sent with the Event 1.0 file. These media are given a name that starts
followed by a linking number, and an extension that shows the type of media. Keep these medi
with the GEDCOM file.

7. In the Destination group, check the Ancestral File box, and then click the Submitter button if yo
intend to submit a GEDCOM file to the Family History Center of the LDS Church. This option in
cates that the GEDCOM transmission is intended for submission to the LDS Church Ancestral F
If you are not creating such a file, leave the check box blank and skip to step 8.

An LDS submission requires the following steps:

• Select the appropriate radio button to choose the ancestors or descendants of the starting indiv

• Enter the record number of the starting ancestor or descendant.

• Click the Submitter button.

• Enter the submitter name, address and phone number.

• Enter any comments concerning the GEDCOM file in the Comments field.

• Click OK to close the window and save changes.

• Prepare a label for the disk(s) with the title, “Ancestral File,” and the submitter’s name, address,
phone number. Mail the disk(s) to:

Family History Department
50 East North Temple
Salt Lake City, UT 84150

8. Choose Indented to create a GEDCOM file in an indented format.

Note Not all genealogy programs can read the indented format. Do not choose this option unle
know that you are preparing a GEDCOM file for a program, such as Ultimate Family Tree, Visua
ROOTS, and ROOTS IV, that can read the indented format.

9. Click OK. Click Save in the Save As window.

10. Enter a file name in the GEDCOM File Name field.
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11. Change the folder to the desired location for the GEDCOM file, for example, GEDCOM.

12. Click Save to start the GEDCOM export.

Note You cannot export directly to a floppy disk.

Saving and/or Backing Up Data
Always make copies of your Ultimate Family Tree project files and library files to protect against disk
ruption and hardware failure. These copies are called backups. Without backup files, you might lose 
days, or even years of work.

To minimize losses due to power failure and machine failure, Ultimate Family Tree provides you
backup features. These features, however, do not ensure against lost work due to damaged or worn 

The Save As window allows you to save the current project as an archive. It is important to back
data regularly to prevent loss of information if there is an unexpected problem with your computer sy
You should back up both project and library files, because they are connected. You do not need to ba
media files if you have not modified the Media Library. If it is ever necessary to restore project, library
media files, you will have to reenter any data entered since the most recent backup. Back up your data often.

Backing Up a Project
1. With the project open, choose Save As from the File Menu.

2. Select Backup from the list.

3. Click Options to open the Save As Backup Options window.

4. Check the Project box to back up the project files.

5. Check the Library box to back up the library files.

6. Check the Media box only if you have modified the Media Library. (The Media files greatly incre
the size of your backup.)

Figure 8-8: Save As Backup Options Window

Back up project files
Back up library files

Back up media files
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Note Back up project, library, and media files separately with different file names, especially if
have more than one project. Complete the backup procedure during one editing session. The L
and Media files are common to all projects and need only be archived once for all projects.

7. Click OK.

8. Click Save in the Save As window to open the Save dialog box.

9. Select the location in which the backup file is to be saved. This file can be saved to your hard dis
one or more floppies. If you save to a floppy, Ultimate Family Tree will request new disks as the
required to complete the backup.

10. Click Save.

If you save the backup to your hard disk, copy the archived file to a floppy disk to protect it. Arc
files have the extension .ZIP. See your Macintosh manual for further instructions on copying files to flo

Restoring a Backup
A project need not be open to restore projects, but you must be in Ultimate Family Tree. If you restore a
with another project open, Ultimate Family Tree first closes the open project and then restores the old p
When complete, the backup project you have restored will be open. To restore a project, follow these

1. From the File menu, choose Open.

2. Select Backup and click Open.

3. Select the folder or disk where you placed the backup. The current folder name is displayed ab
list box.

4. Select the backup file to be restored. Backups have the extension .ZIP, such as FILENAME.ZIP

5. Click Open. A warning message will appear, “Note: Restore Project and/or Library files. Warnin
Existing project of same name and/or library will be erased.”

6. Click Proceed. 

Figure 8-9: Save As Window

Enter file name

Path to file
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Note Restoring the project overwrites all existing files for the project and library being restored
Make sure this is what you want to do before you proceed. If you change your mind, click Canc
rather than Proceed.

When processing is complete, open the restored project by following the steps on page 9.

Save As Ultimate Family Tree Project
Use the Save As window to save the current project as a Ultimate Family Tree project with a new nam
option is handy when you want to split part of the project, to create a working copy in another folder u
the same name, or to keep a working copy of the project using another name.

1. With a project open, choose Save As from the File menu.

2. Select Ultimate Family Tree.

3. Click the Options button.

4. Uncheck the Use List box.

Note For detailed steps on how to split a project, see “Splitting a Project” on page 156.

5. Click OK.

6. Click Save.

7. Enter a new name in the Ultimate Family Tree Project field. If you are saving the project using t
same file name, place the new project in a folder different from that occupied by the current pro

8. Select the folder for saving the new project. Use a different project name to avoid confusion.

9. Click Save. When the new project is created, it is the open project. The original project is closed
procedure does not change the original project file in any way.

10. Click Cancel if you want to return to the current project without creating the new project.

Note Do not save to a floppy disk. Because the Save As Ultimate Family Tree feature creates 
project, you must have sufficient disk space on the hard drive before saving the project. Allow a
2.5 MB of free disk space for every 1,000 individuals in your project.

Figure 8-10: Save As Ultimate Family Tree Options Window

Check to split part of project
into a new project
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Splitting a Project
The following procedure shows how to split a portion of an existing project into a new project. For exa
you can create a new project containing your spouse’s ancestors from an existing project. The three 
steps are locating the individuals, moving those found into the Grouping List, and creating the new p
Later you can remove the individuals in the newly created project from the original project. Modify the
instructions to fit your specific needs.

To locate the individuals you want to use in a new project, follow these steps:

1. Choose Relationship from the Search menu.

2. Choose Locate from the Search menu to find the starting person for the search.

3. Select Ancestors Plus Their Descendants in the Relationship Options list.

4. Set the Generation and Descendant Limits options to 999.

5. Check the Add Other Spouses box to add spouses not already included to the Search List.

6. Choose the option, Replace the list with those found, from the pop-up menu.

7. To check the search without committing the results to the permanent search list, click Preview. 
Escape to return to the Search window.

8. Click Search to create the Search list. Close the results list by pressing Escape.

9. Click Group to move the contents of the search to the grouping list.

10. Click OK to close the search window.

To create the new project, follow these steps:

1. From the File Menu, choose Save As.

2. Select Ultimate Family Tree.

3. Click Options. The Save As Ultimate Family Tree Options window opens. The number of individ
in the Grouping List will be displayed.

4. Check the Use List box, and then click OK to close the Options window.

5. Click Save.

6. Enter a new file name for the new project in the Ultimate Family Tree Project field.

7. Select a folder for saving the new project. Use a different project name to avoid confusion. Othe
you must place the new project in a different folder.

8. Click Save. Click Cancel if you want to return to the current project without creating the new pro

Note Because the Save As Ultimate Family Tree feature creates a new project, be sure you ha
ficient disk space on your hard drive before saving the project. Allow at least 2.5 MB of free disk 
for every 1,000 individuals. Do not save to a floppy disk.
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The new project becomes the open project, and the original project is closed. This procedur
not change the original project file in any way. The name you entered in the Description field for
original project will transfer to the new project. Open the Project Information window from the F
menu and enter a new name on the Description line.

You might want to remove the records in the new project from the original project. If you have n
completed a new Relationship search or created a new Grouping List, continue with the steps below.
have created another Relationship search and/or Grouping List, you will need to repeat the steps you
previously to locate the individuals in the new project.

1. Open the original project.

2. Choose Grouping from the Search menu.

3. Select Relationship from the Individual Search list.

4. Select Invert Selected.

5. Click Search.

6. Repeat the steps to create a new project.

When you complete these procedures you will have two new projects, with the original project i
After checking the contents of the two new projects, you may want to delete the original project. Mak
backup of the original on a floppy disk and then delete it from the hard drive. See page 159 for inform
on deleting projects.

Deleting Data

Deleting an Individual from the Project
1. To delete an individual from the project, choose Locate from the Search menu or find the name

Individual List accessed from the View menu. Double-click the name to open that person’s Indiv
Record window.

2. Choose Delete Record from the File menu. An “Are You Sure?” message appears. Click OK to 
tinue. Another message appears stating, “(This individual) and all references to him/her will be 
removed from this project. This person is linked to ## events.”

3. Click OK to delete the individual in your project, or Cancel if you want to keep the individual.

Deleting Text
Select the text to be deleted and press the Delete key on the keyboard. See page 36 for instructions 
ing text.
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Deleting an Event
To delete an event, select the event in the Individual Record window and click the numbered button t
left of the event field to open the Events window. Click the Delete button on the right below the OK and
cel buttons. The Events window closes, and a message appears asking if you want to delete the eve
OK.

Deleting a Place from an Event
To delete a place from an event in the Individual Record or Events window, highlight the place and pre
Delete key, or choose Cut from the Edit menu. This procedure removes the place from the event, but
from the Place Library. If you change your mind, choose Undo from the Edit menu.

Deleting a Place from the Place Library
1. In the Individual Record window, select a place field and choose the Find button.

2. Highlight the place to be deleted.

3. Click the Delete button in the Places window. A message appears stating whether this place is 
the current project.

4. Click OK.

Note Because the Place Library is common to all projects, do not delete a place that is used in 
another project.

Deleting a Source from the Sources List in the Evidence Window
1. Open the Evidence window that includes the source you want to remove.

2. Select the source to be removed from the Source List.

3. Choose Selected from the Delete group.

4. Click Proceed to delete the source and footnote reference (if present) or Cancel to return to the
dence window without deleting the source.

Note This procedure removes the source from the Evidence window, but not from the Source 
Library.
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Delete a Source from the Source Library
1. From the View menu, choose Source List.

2. Scroll through the list and highlight the source you want to delete.

3. Double-click the selected source or choose Source Record from the Build menu. The selected 
is displayed.

4. From the File menu, choose Delete Record.

Note This procedure permanently erases a selected source from the project and library. Beca
Source Library is common to all projects, do not delete a source that is used in another project.

Deleting a Slide Show
1. From the Build menu, choose Slide Show to open the Slide Show window.

2. Select the Slide Show you want to delete from the Slide Show list.

3. Choose the Selected radio button in the Delete Show box to delete the selected Slide Show.

4. To delete all slide shows, choose All in the Delete Show group.

Deleting a Project
1. Choose Delete Project from the File menu. A warning window opens with this message, “ARE Y

SURE? ### records will be PERMANENTLY deleted if you choose OK.”

2. Click OK.

3. Another window appears with this message, “ARE YOU SURE? This project will be PERMA-
NENTLY erased if you choose OK.” Click OK.

4. Choose New, Open, or Quit from the File menu.

Combining Individuals
The Combine Individuals feature is helpful when an individual is entered more than once in your proje
you want to remove the duplicate name but retain that person’s links.

1. Select the Name field and click the Find button in the Individual Record window. The Candidate
viduals window opens (Figure 8-11).

2. Select the person you want to keep in the project.
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3. Click Identify. A dialog appears showing the name you selected as the surviving person and wha
to take.

4. Click OK.

5. Select the individual to be merged from the Individual list.

6. Close the list by clicking the Close button or by pressing the Escape key.

Note If the two individuals you are attempting to combine are of a different sex or the sex is ma
as Unknown, you will be prompted to click OK or Cancel.

7. Leave the Candidate Individual list as is (do not select another name) and click Merge to comb
two individuals.

8. A message appears showing the name and record number of the individual who will be merged 
name and record number of the surviving individual. Click OK or Cancel.

9. If you proceed, another message appears asking if you would like to erase the individual who w
merged from the project. Click OK to complete the merge, or Cancel to abort.

10. When you finish the procedure, return to the surviving person’s Individual Record and delete an
duplicate events.

Figure 8-11: Candidate Individuals Window

Select the person
you want to keep

Click Identify

Figure 8-12: Merge Individual Dialog
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The parents and birth record for the surviving individual remain intact. Ultimate Family Tree dele
parent links for the merged individual. Events and Event Evidence for the merged individual link to th
viving individual. Individual Evidence for the merged individual transfers to the surviving individual. C
the Individual Evidence button and then the Save/Build Footnote button to rebuild the footnote.

Note If you started the combine function with the cursor in the main name field (not a Parent fi
and then deleted that person during the combine, a blank individual record will open. Choose L
from the Search menu to find another person.

Combining Places
This feature is helpful when you have entered a place more than once and you want to merge all links
place before removing the duplicates. To combine places, complete the following steps:

1. Select any place field in the Individual Record window and click the Find button. The Candidate
Places window opens.

2. Select the place you want to keep in the project.

3. Click Identify. A note appears showing the name you selected as the surviving place and what 

Figure 8-13: Candidate Places Window

Select the place
you want to keep

Figure 8-14: Merge Place Dialog
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4. Click OK.

5. Select the place to be merged from the Places list.

6. Close the list by clicking the Close button or by pressing the Escape key.

7. Click Merge in the Candidate Places window.

8. Confirm the place names and click OK to merge. Do not delete the place if it is used in other project

A message appears asking if you want to erase the merged place from the Place Library. The pl
choose as the surviving place remains in the Place Library and the duplicate place is deleted. Do not delete 
the merged place if the place you want to combine (not the surviving place) is used in other projects.

Viewing Information About your Project
The Project Information window provides a summary of an open project.

1. From the File menu, choose Project Info.

2. The following information is provided:

• Project Control — The name and path of the selected project control file.

• Last Changed — The date the selected project was last edited and saved.

• Project Version — The version number of the current project. In each session where the project 
saved, the version number is increased by one.

• Project Title — The short name for the project.

Figure 8-15: Project Information Window
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• Program Version — The Ultimate Family Tree version number.

• Individuals — The number of individuals in the project.

• Description — A short description of the project.

• Researcher — The name of the principal researcher for the project. This information is optional. Y
can choose to have this name appear in the footer on printed reports.

• Researcher # — The Researcher’s record number, if you want the relationship to the husband or
to show in Family Group Sheets. If you do not want the relationship to show, enter 0 in the Researcher 
# field.

• Address, etc. — The address and phone number of the researcher, using the Address 1 and Add
City, State, Zip, and Phone fields. This information can also be included in the footer on printed
reports.

• Key Families — A list of surnames found in this project, arranged in order of frequency of occurre
The number of times each surname is encountered is shown to the right of the name. Use the sc
on the right side of the Key Families box to see more.

• Update button — Updates the Key Families list shown in the Project Info window. If you’ve entere
new data in a project and return to the Project Info window, click Update to get a new count of s
names since the last edit.

• Comments — The Comments box displays the source of the data used in this project, including 
import method, date, and time. Enter and edit general information in this box. Use the scroll bar 
right side of the Comments box to see more.

Desktop Preferences
You can customize Ultimate Family Tree in several ways:

1. From the Utilities menu, choose Desktop Preferences, and then Miscellaneous. Select any of t
lowing options:

Figure 8-16: Desktop Preferences Window

Turn on clock

Select messages level
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• Clock — Displays a clock in the lower-right corner of the Ultimate Family Tree window. Select O
the Clock group, and select the 12-hour or 24-hour clock setting.

• Messages — Provides three levels of context-sensitive messages that require a response from y
before continuing. Choose one of the following options:

Critical — Have Ultimate Family Tree ignore inconsistent data and information messages. 
cal messages alert you to an inconsistency or error that may affect the integrity of the data in a 

Plus Inconsistent Data — Have Ultimate Family Tree display critical and inconsistent data m
sages. An inconsistent data message is used when data entry is inconsistent with rules for such 
age, but underlying data is not at risk.

Plus Information — Have Ultimate Family Tree display all critical, inconsistent data, and info
mation messages. Information messages provide a reminder that changes are about to be mad

• Date Format — Specifies the date format in the freeform date field. The date displays and prints i
format in all text reports. You can set your preference to have dates display and print exactly as 
entered them (as entered), or you can set a date format default (such as 12 JUL 1943). Scroll t
the date options, and select the format you want. If you select any option other than as entered,
ers will be converted to full words in the freeform date field, such as ABT to about.

Note Changes to the way dates display and print affect dates entered or changed only after you’ve 
selected a preference. Dates entered before selecting a preference remain unchanged.

If you set the date preference to MM/DD/YYYY (for example, 07/12/1943), and enter a dat
such as 14/10/1955 for October 14, 1955, the first number will be dropped, and the date will con
4/10/1955 (April 10, 1955).

• Ultimate Family Tree provides two styles for desktop display. Check the Use Macintosh Deskto
ors box to make Ultimate Family Tree use the window color selected in the Color control panel.
Uncheck the Use Macintosh Desktop Colors box to make Ultimate Family Tree use custom, mo
orful graphics. You must quit Ultimate Family Tree and restart to see the change.

The custom graphics mode (Use Macintosh Desktop Colors unchecked) can reduce the pe
mance of the program. If you suspect that Ultimate Family Tree is running more slowly than it sh
switch to the Macintosh color mode.

When you open certain windows while in the custom graphics mode, the message, “Pictur
ors may be incorrect. Do you wish to use Macintosh Colors?” may appear. Click No to ignore the
sage, and open the window. Click Yes to change the desktop display to Macintosh colors. Exit, 
then restart Ultimate Family Tree to change to Macintosh colors. This message will appear if yo
monitor is set to 256 colors. If your monitor is set to 16 colors, the Macintosh colors will be used
default.

2. Click OK to close the Desktop Preference window.

3. Quit and restart Ultimate Family Tree if you changed the Use Macintosh Desktop Colors setting
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Modifying the Name Format
To further customize Ultimate Family Tree, you can modify the way names appear in windows. Name
appear alone or with additional information such as dates of birth and death.

These options do not affect how names appear in lists or in the editable name fields in the Indiv
Record window.

1. From the Utilities menu, choose Desktop Preferences, and then Name Format.

2. Select any of the following options from the Add to Name group:

• Nothing — Only the name.

• Years — Names plus birth and death years.

• Record Number — The name plus record number.

• Image Info — The name, plus the word image if an image is linked to the individual.

• Indiv. Flag — The list of flags on the right side of the window is activated when this radio button 
selected. Select the flag you want from the list. The name appears plus the selected individual 
attached to that name).

3. Check the Use Upper Case box in the Surnames group to display surnames in all uppercase le

4. Check the Hide Slashes ( / ) box in the Surnames group to display surnames without slash ma
Checking this also removes the braces {} from titles. This setting does not affect the Individual R
window.

Note After changing the name format, click any open window to display the new name format.

Figure 8-17: Name Format Window

List of individual flags
entered in project

Select an option for
displaying names
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Project Utilities
Ultimate Family Tree offers several features to help you manage your project files. They are found un
Project in the Utilities menu.

Pack
Packing a Ultimate Family Tree project permanently removes records that have been deleted from your
or from a library. This is an important feature to use after deleting a number of records because pack
reduces the total disk space used. Ultimate Family Tree also rebuilds all index files associated with the

From the Utilities menu, choose Project, and then Pack. To interrupt the Pack process, press E
This stops the Pack and leaves the original file unchanged.

Note The Pack process replaces your original project files. Make a backup copy of your projec
before starting Pack.

Ultimate Family Tree creates large work files during the packing process. If Ultimate Family 
runs out of disk space during a pack, it automatically recovers the original project.

Reindex
Reindexing rebuilds any index files that are associated with an open Ultimate Family Tree project. Yo
should reindex in the unlikely event an error message indicates that an index file is corrupted. From t
ities menu, choose Project, and then Reindex. Ultimate Family Tree informs you when the reindexing
complete. See page 173 for information on error messages.

Check Window
The Check feature tests the files in a Ultimate Family Tree Project and Library. Inconsistent links are
repaired if possible, and unlinked events removed (for example, birth events remaining after an indivi
has been deleted). An option is provided to rebuild footnotes.

1. From the Utilities menu, choose Project and then Check.

Figure 8-18: Pack Message Window
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2. Check any of the following boxes in the Project group:

• Events and Event Links — Removes events to which no individuals are linked. This option also che
place links to make sure an associated place is in the Place Library. If an associated place is no
(it may have been deleted while in a different project), the place is restored and given the nameMiss-
ing Place no. nn. The nn will be replaced by the place record number. Edit the place name in the 
vidual Record window to change Missing Place to the correct place name. See page 174 for more 
information.

• Add Birth/Death Events — Checks all individuals for birth events. If one is not found, a new event
added and parents are linked. If the Living status flag for an individual is N, Ultimate Family Tree 
looks for a corresponding death event. If one is not found, a death event for that person is adde

• Find Duplicate Record Numbers — Checks individual record numbers to make sure they are uniq
and reports any duplicates found. Use the Individual Record window to assign unique numbers
“Deleting or Renumbering Duplicate Record Numbers” on page 168.

• Check Parent Links — Checks links to parents.

• Source Links — Checks source links to make sure an associated source is in the source library. 
associated source is not found, the source is restored to the Source Library when the Repair op
chosen. The new source is replaced with a source type called Generic and given the name, Unknown 
source nn. The nn will be replaced by the source record number. Edit the source in the Source R
window to change Unknown Source to the correct source information.

3. Choose Rebuild Footnotes if you want to rebuild all footnotes. This option is useful if you did no
choose to build footnotes during a GEDCOM conversion.

The Rebuild Footnotes procedure overwrites any text you have typed directly into the Foot
text field of an Evidence window. If you do not want this text overwritten, do not choose this opt

4. When you select any of the Project options, the Repair button is activated. You have two ways to
your data:

• Click OK to check items selected on the left side of the window and prepare a report telling you w
wrong. Click OK to see the list of data that will be fixed when you click Repair or that you can ch
to edit yourself.

• Click Repair to check the data and repair if possible.

Figure 8-19: Check Window
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A text file named CHECK.TXT is created when either OK or Repair is clicked. This text file lists
problems found and changes and repairs that have been made to a project and library. If you want to s
file for later use, be sure to rename it before running a new Check.

Note Running a complete set of tests on a project may take from several minutes to many hou
complete, depending on the size of the project. To stop the Check routine, press the Escape ke

Deleting or Renumbering Duplicate Record Numbers
If the Check routine reports that you have duplicate record numbers, you must delete or renumber on
them. To find duplicate record numbers, from the Utilities menu, choose Project, then Check. Check th
Duplicate Record Numbers box. Click OK. When the Check routine is complete, a CHECK.TXT file is
opened, showing any duplicate records. If no duplicates are found, the CHECK.TXT file will not be di
played.

To delete duplicate record numbers, follow these steps:

1. Choose Individual Record from the Build menu to open the Individual Record window. Choose L
from the Search menu and enter the record number, for example, 150. Press the Return key, a
click the OK button.

2. In the Individual Record window, change the record number to an unused one, for example, ch
record 150 to 10150. Choose Save from the File menu to save.

3. Choose Locate from the Search menu and enter the record number for the duplicate, for examp
Press Enter and then click OK.

4. Choose Delete Record from the File menu to delete this record.

5. Once deleted, choose Locate from the Search menu, enter the changed record number (10150
Enter and then click OK. Change the changed record number (10150) back to the original num
(150). Choose Save from the File menu to save.

Viewing GEDCOM Exceptions
Ultimate Family Tree maintains a list of the information that did not convert into a project from a GEDC
file. The GEDCOM Exceptions window appears with the GEDCOM file behind it as a read-only file. T
top left corner of the GEDCOM Exceptions window indicates the path and name of the GEDCOM file
are viewing.

1. From the Utilities menu, choose Project, and then GEDCOM Exceptions to view the contents o
GEDCOM Exceptions list.

Note If you have deleted or moved the GEDCOM file from the folder from which it was importe
and then try to open the GEDCOM Exception window, the message, “GEDCOM file not found,”
displayed in the upper right corner of the Ultimate Family Tree window.
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• Individual — Indicates the individual to whom the exception belongs.

• Event — Indicates the event to which the exception belongs.

• Exception Number — Indicates the number of the exception you are viewing.

• Total Exceptions — Indicates the total number of items that did not convert to the Ultimate Family
Tree project.

• GEDCOM Tag — Indicates the GEDCOM tag that was not imported.

• Exception Note Box — Shows the text that was attached to the selected tag, followed by the phra
ignored or not fully converted or unrecognized or ignored, to indicate the text was left out of the 
project. To update your data more easily, you can copy this text into a text file or field using the 
and Paste commands from the Edit menu.

Note The phrase, unrecognized or ignored, indicates that Ultimate Family Tree correctly interprete
the GEDCOM information but did not use it (usually because a conversion option, such as Inclu
Last Changed Date, was not selected). The phrase ignored or not fully converted, indicates that Ulti-
mate Family Tree could not interpret the information correctly.

2. Click the Next and Previous buttons to scroll through the Exception List in the GEDCOM Excep
window.

3. Click Show to activate a copy of the original GEDCOM file and to view where the exception is loc
in that file. Click the Close box or press the Escape key to close the GEDCOM file and to return
GEDCOM Exception window, or click on the GEDCOM Exceptions window to bring it forward.

4. Click Remove to remove the GEDCOM exception displayed in the Exception Note field from the
GEDCOM Exceptions list.

5. Click Remove All Like to remove the GEDCOM exception displayed in the Exception Note field
all GEDCOM exceptions like it from the GEDCOM Exceptions list.

6. Click Close to close the GEDCOM Exceptions window.

Figure 8-20: GEDCOM Exceptions Window

View previous
exception in the list

View next
exception in the list

Activate copy of
GEDCOM file for
viewing exception
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Opening an External Text Document
1. To open an external text document, choose Open from the File menu.

2. Select Text. Click Open.

3. Change to the folder that contains the text document you want to open.

4. Select the document, and click Open.

Saving An Open External Text Document 
Under a New Name

1. From the File menu, choose Save As.

2. Select Text and click Save.

3. Select the folder in which you want to save the document.

4. Enter a name for the document.

5. Click Save.

Exiting Ultimate Family Tree
To exit Ultimate Family Tree, choose Quit from the File menu.

Note It is not necessary to close a project before exiting Ultimate Family Tree. If you quit Ultim
Family Tree with a project open, that project will be open the next time you start Ultimate Family
Tree. If you close the project before exiting, the next time you start Ultimate Family Tree you wi
need to choose Open from the File menu to open a project. See page 9 for more information on
ing an existing project.
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This appendix provides answers to questions users commonly ask and solutions to problems someti
encountered in Ultimate Family Tree. See “Did You Know?” on page 20 for more information.

Frequently Asked Questions
How do I split my project?

See page 156.

Why is the Find button sometimes dim on the Individual Record?

The Find button is available only when the cursor is on a name or place field.

How do I get events without dates to print in the proper order?

Ultimate Family Tree places all events in chronological order by the date entered in the Sort Date
Events without dates will print first, followed by those with dates. When you know the order in which e
took place, but do not have dates, enter a date in the Sort Date field for each undated event to place th
in the proper order. For example, if you know the birth order of the children in a family, but do not kno
birth dates, enter an approximate date for each child in the Sort Date fields for their births, making su
oldest child has the earliest Sort Date. The Sort Date will not print in the report, but Ultimate Family T
uses it to place events in chronological order. To edit the sort date, click the numbered button to the l
the event name in the Individual Record window to open the Events window.
1 7 1
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How do I edit place names in Ultimate Family Tree?

You can edit the spelling of place names in the Place field on the Individual Record or Events w
dows. See page 23.

How do I add a sibling when I don’t know the parents for an individual?

To use the New Sibling button on the Individual Record, you must enter a parent in either the M
and Father fields. If you do not know the parents for a group of siblings, enter a name for the father o
mother in the appropriate parent field. For example, for an individual named John Smith, you could e
mother or father named Unknown /Smith/, or (-----) /Smith/, etc. With at least one parent named, you can 
enter siblings.

How can I turn off the note messages?

Ultimate Family Tree provides three levels of context-sensitive messages that require a respons
you before continuing. To turn off all but the most critical messages, choose Desktop Preferences fro
Utilities menu and then Miscellaneous. In the Messages group, select Critical. Click OK to close the 
top Preferences window.

How do I turn off graphics?

Ultimate Family Tree runs faster without the default graphics. To turn them off, from the Utilities
menu choose Desktop Preferences and then Miscellaneous. Select Use Macintosh Desktop Colors.

What should I do when I get the message “At least one other source has the same first abbreviation”
when creating new sources?

Abbreviation 1 is used to identify the source in lists. If possible, change Abbreviation 1 to somet
unique so that the source is easily identifiable in lists. If not possible, leave the duplicate, but be aware
duplication when adding sources to evidence windows.

How does Ultimate Family Tree store data?

Ultimate Family Tree organizes family history information into projects. If you are researching y
own family, keep all your research data in one project. If you are a professional genealogist, you will 
bly have at least one project for each client.

When you begin a family history project, Ultimate Family Tree asks you to give your project a n
If, for example, you call your project “SMITH,” Ultimate Family Tree creates two project control files: 
SMITH.PRO and SMITH.FPT. The information Ultimate Family Tree needs to manage your project fi
stored in these two files.

Specific information about individuals and events in their lives is stored in several files managed 
project control files. Approximately 25 to 30 numbered files belong to each project and begin with the
two or three numbers. Each numbered file has two or three different extensions: .DBF (database files
(memo files), and .CDX (index files). You can print a Project Summary report to show how each num
file is used and the drive and directory that contains the file.

Some of the information you enter can be used in more than one family history project. Ultimate
ily Tree stores this information in special libraries that can be accessed by any project you’re working
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Ultimate Family Tree maintains libraries for places, sources and source types, event and role types, 
media. These common libraries save you time and increase the consistency and reliability of your da

Note Because the library files are common to all projects, do not delete places, sources, or m
that might be used in other projects. Deleting an item from a library will remove the links to that
in the current project, but will not remove links in unopened projects. If you ever need to reinstal
mate Family Tree, be sure to back up your library and media libraries before you reinstall, or ins
only the program files.

Troubleshooting
This section lists error messages and possible problems you might experience in Ultimate Family Tre
what you can do if you encounter them.

General Errors

Error 15: Not a database file

The file which Ultimate Family Tree is trying to open may be corrupted. Restore the most recen
backup of your data.

Error 26: Database is not ordered

This message usually means there is a problem with an index file. From the Utilities menu, cho
Project and then Reindex to rebuild the index files. If reindexing does not correct the problem, rebuild
project files by creating a duplicate project. See “Save As Ultimate Family Tree Project” on page 155
steps to create a duplicate project. When you are certain the project has been fixed, you can delete t
nal project. If creating a duplicate project does not correct the problem, try reinstalling the program file
(not a full installation). See “Reinstalling Ultimate Family Tree” on page 4.

Error 41: Memo file is missing/invalid

A file which Ultimate Family Tree is trying to open is either missing or corrupted. Rebuild all pro
files by creating a duplicate project. See “Save As Ultimate Family Tree Project” on page 155 for step
create a duplicate project. When you are certain the project has been fixed, you can delete the origin
project. If creating a duplicate project does not correct the problem, try reinstalling the program files o
(not a full installation). See “Reinstalling Ultimate Family Tree” on page 4.

Error 56: Not enough disk space

Ultimate Family Tree needs approximately 2.5 MB free disk work space for every 1000 individua
the open project. Delete any programs or files that you do not use to free additional hard disk space.
save a project or file to another drive or floppy disk, make sure the disk has sufficient space. This err
also occur if you have duplicate record numbers or an individual is linked as his or her own ancestor.
for duplicate record numbers using the Check routine found in the Utilities, Project menus. Check you
for incorrect links.
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Error 1707: Structural CDX file not found

This message indicates that an index file is either missing or corrupted. Reindex the project by 
ing Project, and then Reindex from the Utilities menu. A file that Ultimate Family Tree is trying to ope
either missing or corrupted. Rebuild all project files by creating a duplicate project. See “Save As Ulti
Family Tree Project” on page 155 for steps to create a duplicate project. When you are certain the pro
been fixed, you can delete the original project. If creating a duplicate project does not correct the pro
try reinstalling the program files only (not a full installation). See “Reinstalling Ultimate Family Tree” o
page 4.

Format not allowed

The image file you are trying to open is either corrupted or the image format is not supported by
mate Family Tree.

Some place names say Place missing from Library

Each place in the Place Library uses an internal record number. When a place is added to an e
link from the event to that place record number is created. If that place is missing from the place libra
because you deleted the place in a different project, you deleted the Place Library, or you overwrote 
Library files by reinstalling the entire program, the link to a valid place is broken.

To restore the missing place, backup your Project and Library files. See “Backing Up a Project”
page 153. Choose Project from the Utilities menu and then Check. Select all options in the Project gro
then click Repair. Any places used in the current project that are missing from the library are restored
new place is given the name, Missing Place no. nn. The nn represents a place number. To change th
name to the correct name, return to the Individual Record window that contained the missing place. T
the place field, Missing Place no. nn, and overwrite Missing Place with the correct place name for that ev
Choose Save from the File menu to save it. A message appears stating that the place was Missing P
nn and is now the name that you just typed. Click Yes to change the spelling to the new name.

Be sure to enter the correct place name. The new place name will now be attached to all events
originally used this missing place in the current project and to all other projects that use this place re

File does not exist (upon opening Ultimate Family Tree)

If you have intentionally or accidentally deleted a program file that Ultimate Family Tree later ne
you might see this message. You might need to reinstall the program files only. Do not reinstall the fu
gram or data entered in the Library files (places, sources, and/or media information) will be lost. See
stalling Ultimate Family Tree” on page 4.

File too large for Ultimate Family Tree

The external text file you are attempting to import is too large for the Ultimate Family Tree text fi

Display Errors

Individual, Marriage or Place Lists contain strange names in the column titles

If the View lists contain strange names (for example, INO instead of numbers) in the column titl
pack the project using Pack from the Utilities, Project menus.
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When A Descendant Box Chart opens, List windows (Individual, Marriage and Source) close

Ultimate Family Tree closes all browse windows before opening a new Box Chart window. This 
normal.

No names are displayed in the Candidate Individuals list

There are two possibilities: Ultimate Family Tree has not found any matching individuals, or the
project needs to be thoroughly indexed using the Check routine (with no options selected) from the U
Project menus.

Displaying Images and Screen Resolutions
The resolution of your computer display adapter and monitor directly affects the quality of the images
display. Resolution is determined by the number of pixels (picture elements) on the monitor and the n
of colors per pixel. A SVGA monitor, having 480 x 640 pixels and 256 colors is the minimum recomme
configuration for displaying images. Image quality improves dramatically as pixels and color depth inc

If you are using a system that is limited to 256 colors, configure Ultimate Family Tree to use the
intosh Colors option. See page 164 for more information.

Slide Show Troubleshooting

First slide flashes before each slide

Play Slide Show flashes the first image before displaying the next image. This is normal.

Printing Errors

The report Use Grouping options are dim

No individuals have been found in the Grouping list. See “Grouping” on page 74.

Place names are shortened or abbreviated in reports

Some structured reports, such as the Family Tree report, are designed with a 30-character limit t
names. Ultimate Family Tree shortens these names, if required.

Starting person not in individual grouping list

Grouping is checked and the selected person for the report is not in the Grouping List. Either ad
individual to the Grouping list, or uncheck Use List in the report window.
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IMPORTANT—READ CAREFULLY BEFORE USING THIS PRODUCT

LICENSE AGREEMENT AND LIMITED WARRANTY

BY USING THE SOFTWARE INCLUDED WITH THIS AGREEMENT (“PROGRAM”) YOU ACCEPT THE TERMS OF THIS LICENSE WITH PAL
LADIUM INTERACTIVE™ INC. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, AND YOU ARE ALSO THE ORIGINAL PUR
CHASER OF THIS PROGRAM LICENSE (“ORIGINAL PURCHASER”), PROMPTLY RETURN THE SOFTWARE TOGETHER WITH ALL 
ACCOMPANYING ITEMS TO YOUR DEALER FOR A FULL REFUND.

LIMITED USE LICENSE.  Palladium Interactive and its suppliers grant you the right to use one copy of the Program for your personal use only. Ahts 
not expressly granted are reserved by Palladium Interactive or its suppliers. You must treat the Program and associated materials and any elements thereof 
like any other copyrighted material (e.g., a book or musical recording). This Agreement is governed by the internal substantive laws of the State of Califor-
nia.

YOU MAY NOT:

• Use the program, or permit use of the program, on more than one computer, computer terminal, or workstation at the same time.

• Make copies of the materials accompanying the Program, or make copies of the Program or any part thereof.

• Copy the Program onto a hard drive or other device and you must run the Program from the CD-ROM (although the Program itself may copy a 
portion of the Program onto your hard drive during installation in order to run more efficiently).

• Use the Program, or permit use of the Program, in a network or other multi-user arrangement or on an electronic bulletin board system or other 
remote access arrangement.

• Rent, lease, license or otherwise transfer this Program without the express written consent of Palladium Interactive except that you may transfer 
the complete Program copy and accompanying materials on a permanent basis, provided that no copies are retained and the recipient agrees to the 
terms of this Agreement. 

• Reverse engineer, decompile, disassemble, or create derivative works of, the Program.

LIMITED WARRANTY. Palladium Interactive warrants to the Original Purchaser only, that the Program shall perform substantially in accordanc
the accompanying written materials for ninety (90) days from the date of purchase.

EXCLUSIVE REMEDY.  The original Purchaser’s exclusive remedy for the breach of this license shall be, at Palladium Interactive’s option, eithea) the 
repair or replacement of the Program that does not meet Palladium Interactive’s Limited Warranty and which is returned to Palladium Interactive with a 
copy of your receipt; or (b) a refund of the price, if any, which you paid for the Program and associated materials. This Limited Warranty is void if the fail-
ure of the Program has resulted form accident, abuse, misapplication, or use of the Program with incompatible hardware.

NO OTHER WARRANTIES. PALLADIUM INTERACTIVE AND ITS SUPPLIERS, IF ANY, DISCLAIM ALL WARRANTIES WITH RESPECT TO 
THE PROGRAM AND ACCOMPANYING MATERIALS, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED 
WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OF THIRD PARTY RIGHTS, AND FITNESS FOR A PARTICULAR PURPOSE.
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. DEPENDING UPON WHERE YOU LIVE, YOU MAY HAVE OTHER 
RIGHTS, WHICH VARY FROM STATE/COUNTRY TO STATE/COUNTRY.

LIMITATIONS ON DAMAGES. IN NO EVENT SHALL PALLADIUM INTERACTIVE OR ITS SUPPLIERS, IF ANY, BE LIABLE FOR ANY CON-
SEQUENTIAL OR INCIDENTAL DAMAGES WHATSOEVER ARISING OUT OF THE USE OF OR INABILITY TO USE THE PROGRAM OR PRO
GRAM PACKAGE, EVEN IF PALLADIUM INTERACTIVE OR ITS SUPPLIERS, IF ANY, HAVE BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. PALLADIUM INTERACTIVE’S LIABILITY SHALL NOT EXCEED THE ACTUAL PRICE PAID FOR THE LICENSE TO USE 
THE PROGRAM. BECAUSE SOME STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSE-
QUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

US. GOVERNMENT RESTRICTED RIGHTS. The Program and documentation are provided with restricted rights. Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CF 52.227-19, as applicable. The Contractor/
Manufacturer is Palladium Interactive, Inc., 900 Larkspur Landing Circle, Suite 295, Larkspur, CA 94939.

SAVE THIS LICENSE FOR FUTURE REFERENCE
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Abbreviation 1 The first abbreviation used to identify a source. Usually, the name of an author or co
piler is used.

Abbreviation 2 The second abbreviation used to identify a source. The identifier can be a title or na
and is italicized in printed reports unless italics are not supported by the printer.

Ahnentafel A German word meaning ancestor table. This report uses a text format rather than the f
tree (pedigree) form.

Ahnentafel number A unique number assigned to each position in a family tree (pedigree) whether o
you have an individual to fill that position. These numbers do not vary from chart to chart. Ahnen
numbers can tell you exactly how a particular ancestor is related to the selected individual.

Ancestral File A compilation of records submitted to the LDS Family History Center by individuals do
genealogical research.

Ancestral Ordered Book The history of an individual back to his or her distant ancestors.

ASCII Stands for American Standard Code for Information Interchange. This standard defines the 
for a character set used for information exchange between computer systems of different manu
ers. ASCII is a common coding standard used in the computer industry.

Backing up Copying data, typically the data on your hard drive, to a floppy disk.

Backup A compressed file used to back up the current project.

BBS (Bulletin Board System) A computer running communications software and connected to a tele
phone line through a modem that can be accessed by remote users

Canon law A code of law in which degrees of consanguinity are defined. In canon law, the degree in
cates the number of steps on a consanguinity chart from one individual to the closest ancestor 
in common by a second individual. This number produces the degree of consanguinity between
individuals.

CD ROM (Compact Disk Read Only Memory) A data storage medium that uses laser optics rather th
magnetic means to read data. Information can be read from CD ROM disks, but not recorded on
They are capable of storing an enormous amount of data compared to a traditional floppy disk.

Check box A small square in a dialog box or window that can be selected or cleared. When the chec
is selected, an X appears in the box. A check box represents an option that you can set.

Citation Detailed information that documents a pedigree, a genealogy, or a statement of fact.
1 7 9
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Civil Law A code of law in which degrees of consanguinity are defined. In civil law, as distinct from 
canon law, the degree depends on the number of steps on a consanguinity chart from one indiv
another.

Click To quickly press and release the mouse button.

Clipboard A temporary storage location used to transfer data between fields, windows, and program

Close box A box found in the upper-left corner of most windows. Choosing the close box closes the
dow. 

Collateral Descended from a common ancestor, but through a different line, such as a cousin, aunt,
nephew, etc.

Command A word or phrase, usually found in a menu, that you choose to initiate an action.

Command key    A key that, when held down while another key is pressed, causes a command to take 
The Command key is marked with a propeller-shaped symbol.  On some keyboards, the Comma
has both the propeller symbol and the Apple symbol on it.

Consanguinity A legal description of the distance between two individuals who are related by blood
Consanguinity is defined differently under civil law and canon law.

Copy An Edit menu command that copies selected text to the Clipboard without removing it from th
original location. See also Paste.

Cut An Edit menu command that removes selected text from its original location and places it on th
board. See also Paste.

Descendant Ordered Book A type of book that singles out an ancestor and traces his or her children
grandchildren, and all other documented descendants to the present day.

Dialog box A window that requests information. A Dialog box is a stepping stone to initiating an acti

Digitized image A photo or picture that has been converted into an electronic (digital) format.

Direct Media Media items that are digitized and stored on your hard disk. 

Double-click To rapidly press and release a mouse button twice without moving the mouse. Double
ing selects an object and carries out an action.

Double dating If you encounter dates prior to 1752, you will find that a double year might be listed, 
as 1725/26. The explanation for double dating is an alteration to the calendar. In 1582 it was fou
the Julian calendar which had begun with Julius Caesar was off by 11 minutes and 14 seconds
according to the cycle of the sun and moon. Beginning when the Julian calendar was first used
BC, the error accumulated yearly, and in 1582 Pope Gregory XIII corrected the discrepancy. Th
endar lost ten days as the Pope decreed that October 4 would be followed by October 15.

Countries accepted the new Gregorian calendar at different times, and England and the Am
colonies did not do so until 1752. By then the discrepancy between the Julian and Gregorian ca
was 11 days. This difference was compounded by the celebration of two New Year’s days by En
and its colonies. The government celebrated New Year’s on March 25, and the masses celebra
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ce pre-
holiday on January 1. Depending upon which calendar you used and when you celebrated New
Day, there would be a difference in dating. To satisfy both conventions—until 1752 when the Ja
New Year’s celebration was made official—double dates sometimes were recorded.

You can enter the double date year in the Free-form date field. The double date will print o
reports, such as the Genealogy report. The Structured date will display the second year in the d
date and will print on structured reports such as the Family Group Report.

Drag To move an object on the screen by selecting the item and then holding down the mouse butto
moving the mouse. For example, you can move a window to another location on the screen by 
ging its title bar.

Emigrant A person who departs from a country to settle elsewhere.

Event GEDCOM The Event GEDCOM Version 1.0 specification has been designed by to provide th
most complete transfer of event-oriented genealogical data. It is an extension of Family Version
that incorporates features for transferring events, roles, sources and images. Event GEDCOM i
designed to be compatible with lineage-linked systems, while providing extensive support for ev
oriented systems, such as ROOTS IV. At the current time, only Ultimate Family Tree and Visual
ROOTS and ROOTS IV programs support Event GEDCOM.

Event text footnote Free-form text that can be used to record explanatory notes or other references
an event that are best reported as a footnote rather than in the body of printed reports.

Evidence Relates to or provides proof of a claim. In genealogy, most evidence comes from records,
ments, and circumstances.

Family GEDCOM The current GEDCOM specification, version 5.5, is a family-focused, lineage-link
format. It uses cross-referenced pointers to connect each child to a family and each family to its
dren. It does not provide for the transfer of as much data as Event GEDCOM, version 1.0.

Family Group Sheet A genealogical form summarizing genealogical data for a single family unit. Th
Family Group Sheet contains detailed information about a family unit–husband, wife, and childr
The Family Group Sheet begins with the husband and wife, and then lists their children in birth 

Field A specific area set aside for a given type of information, for example, a name field, date field, 
field, etc.

Flags A method for keeping track of special information that can be answered true or false. Ten flag
available for each individual in your project. They can be defined differently for each person. Ex
ples of flag situations include the need for more research, attendance at a certain college, or ca
death.

Footer Text printed at the bottom of every page for most Ultimate Family Tree reports. It can include
name and address of preparer and the date the report was printed.

Footnote Provides the evidence to support a fact. Footnotes can be either explanatory text or eviden
sented in a more structured format (such as author or title).

Format The way text appears on the pages of a report.
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Free-form field Fields that allow you to enter names and dates as they appear in their original sourc
out formatting constraints.

Free-form text Text that does not conform to a structured or rigid format.

GEDCOM A standard to provide for genealogical data exchange between programs. GEDCOM sta
for GEnealogical Data COMmunications. Ultimate Family Tree supports two GEDCOM forms: F
ily and Event.

Group A cluster of related radio buttons or check boxes, located in a window, from which you can m
selections.

Grouping Grouping is a way to generate specialized lists of individuals who fulfill certain criteria. 
These lists can be manipulated or merged in a variety of different ways.

Header Descriptive text printed at the top of every page for most Ultimate Family Tree reports. It ca
include book name and page number.

Highlighted Selected object or text that will be affected by the next command or action. Highlighted
appears in black-on-white (reverse video) on monochrome displays and sometimes in color on 
displays. Highlighted objects might change color or be surrounded by a selection cursor.

Icon A small picture representing various types of applications on the desktop.

Image Photographs, movies, videos, digitized images, and any other type of image that might be us
document a family history.

Immigrant A person who comes to a country to take up permanent residence.

Import To convert a non-Ultimate Family Tree file into a Ultimate Family Tree project.

Index A list of all individuals and marriages in the project with a page number reference to where th
name appears on a chart or report.

International characters Alphabetic characters with diacritical marks commonly found in languages 
such as French, Spanish, or German.

Invert selected Grouping command to exchange everyone in the grouping table for everyone previo
excluded from the grouping table project.

List window List windows show information from your project in a table format, using rows and colum

Lock A check box on some windows where you can lock the starting individual in the window. The i
vidual will be in the window when it is next activated.

Long Name The Long Name is a name of up to 65,000 characters for the selected individual. The lo
name is not displayed on screen in Build or View windows, but is used in Family Journal reports.
characters (/) define the surname and curly braces { } define a title.

Media A general term encompassing all types of information from text to sound, but used here to re
specifically to pictures and graphics.
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Memory RAM (Random Access Memory). The memory in a computer designed to store data tempo
The data in RAM is lost when you turn off the computer. Permanent data storage is made on flo
hard disks.

Menu A list of commands you can carry out. Menu names appear in the menu bar at the top of the 
mate Family Tree main window.

Menu Bar A horizontal bar containing the names of all the menus at the top of the main window.

Message dialog box Contains information messages, warnings, and critical messages about the ope
of Ultimate Family Tree.

Modified Register A genealogy format that conforms with the style used in the National Genealogic
Society’s Quarterly. It is sometimes called the Record plan.

NEHGS New England Historic Genealogical Society, 99-101 Newbury Street, Boston, MA 02116.

NGS National Genealogical Society, 4527 17th Street, North, Arlington, VA 22207-2399.

Option A selection in a dialog box. An option affects the way in which a command is carried out. Di
boxes have several kinds of options including radio buttons (you can select only one) and check
(you can select as many as you wish).

Parental partner A parents who is not married or does not have a marriage record.

Paste An Edit menu command that moves text from the clipboard into a text file or Text window at th
new cursor location. See also Copy and Cut.

Preferred image The selected image that can be displayed from the Pedigree, Family, and Descend
windows.

Radio button The small round button in a window that acts like the buttons on a car radio. In a grou
related radio buttons, only one can be on at a time.

RAM Random Access Memory. The memory in a computer designed to store data temporarily. The 
RAM is lost when you turn off the computer. Permanent data storage is made on floppy or hard

Record A collection of related data items, for example, an individual record.

Record Footnote Free-form text that can be entered about an individual to print out as a footnote. No
ommended for formal source citations.

Record plan A genealogy format that conforms with the style used in the National Genealogical Soc
Quarterly. Also called the Modified Register.

Redo Edit menu command that repeats a cut or copy that you make.

Redundant ancestors When there is more than one line from an individual to his or her ancestor, the
ancestor is considered redundant. This normally occurs when cousins marry.

Referenced media Media of every kind that can not be transformed into a digitized format.
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Register A genealogy report that conforms with the style used by the New England Historic Genealo
Society.

Research note Free-form text that can be entered about past, ongoing, or future research on an indi

Reverse Register The Reverse Register is a genealogical report format that uses a numbering syste
ilar to the Register or Modified Register reports, and follows ancestral rather than descendant li

Rich Text Format (RTF) A standard developed by Microsoft describing a method of encoding forma
text for easy transfer between applications. With the RTF standard, documents composed unde
ent operating systems and with different software applications can be transferred between thos
ating systems and applications. Ultimate Family Tree supports this standard.

Save A File menu command used to save changes made to an active window.

Scanned image An electronic reproduction of a picture or document that is stored in a file on the com
puter. 

Scroll bars The bars at the bottom and right edge of a window whose contents are not entirely visib
Each scroll bar contains a scroll box and two scroll arrows.

Scroll box Contained in scroll bars. Dragging the scroll box up or down displays information in a list
document.

Search Criteria The choices selected in the search routines that tell Ultimate Family Tree what to loo
when searching the project.

Selection cursor The selection cursor shows where you are in a window.

Shortcut keys The specialized key strokes (a combination of the Command key with a letter key) tha
press to carry out a command or action. If a command has a shortcut key, the key combination i
to the right of the command name on the menu.

Sibling Brother or sister, first-generation relationship with one or both parents the same.

Sort date The date used to establish the order of events and for calculating information such as a p
age at the time of a specific event. Normally it does not appear on reports.

SOUNDEX A code used by the United States Government to index early census records. It tries to
mize spelling variations.

Structured date A date in fixed form (dd mmm yyyy) used on fixed or structured reports such as the
igree and Family Group reports.

Structured fields Fields, such as the sort date and structured date, that are used for structured repor
as the Pedigree and Family Group reports.

Submitter The individual creating a Tiny-Tafel or GEDCOM file. The word submitter is also used to r
to information about this individual.

Text box A box located in a window where you type information.
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Tiny-Tafel Tiny-Tafel is a shortened variation of an Ahnentafel list. The Tiny-Tafel contains one line 
text for each family line, giving the surname, locations, and the time period represented by that 
line and codes to signify the degree of interest in receiving information concerning the ancestor
descendants of that line.

Title bar The horizontal bar located at the top of a window and containing the title of the window.

Undo An Edit menu command that reverses the last action you performed on any text within a field, r
or file. Undo deletes a new record only if the record was not saved.

Unusual dates Unusual or nonstandard dates (for example, Quaker or Jewish dates). In Ultimate Fa
Tree dates that do not fall between the limits of 100 AD to 3000 AD are considered unusual date
mate Family Tree is able to accept dates in all of these categories.

Wildcard A character used to represent one or more different characters. A question mark (?) can b
to substitute for a single unknown character. The asterisk (*) can be used to substitute for more
one consecutive character.

Window title The title of the window that is found at the top of the window.
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Symbols

 

\ backslash 11, 80
# number sign 11, 30, 31
* wild card 63, 67, 77
/ slash 11, 12, 27, 64, 65, 76, 77
? wild card 63, 67, 77
{ } braces 11, 27, 64, 65, 77, 80

 

A

 

Abbreviation 1 field 40
Abbreviation 2 field 40
adoption 44
Ahnentafel

list 111
number 57
report 90, 91

alias 47, 81
Ancestor (Ahnentafel) report 91
Ancestor Interest (AI) 46, 111–113
Ancestor reports 89–91

Ancestor (Ahnentafel) report 90, 91
Family Tree (Pedigree) Chart 89, 90

ancestors
searching 71
viewing 17

Ancestral File 152
number 48

ASCII text file 37
asterisk 84

 

B

 

backing up 153, 154
backup, restore 154, 155
baptism 15
birth event, creating 14
Birth field 47

book
outline 85–86
title 81

Box Chart 94–102
Auto Edit Text option 100
book format 97
colors 101
deleting 102
design 96
display 101, 102
fonts 100
graphics 99
new 95
preparing 97, 98
Separate Surname option 100
Wall Chart format 97
Web page 123–125

browser, installation 4

 

C

 

caption, image 133
cemetery 15
characters

international 35
reserved 11

chart, Box 94
check spelling 36, 37
Check Window utility 166–168
child 45

adding 16, 44
ClarisWorks 79, 82
clock 164
Combining Individuals feature 159–161
Combining Places feature 161–162
Combining Projects feature 144
Command key 10
comments, project 8
common name 47
creating new record 12
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D

 

D’Aboville numbering system 93
date

adding 29
double dating 30
format 22
free-form 29
last edit 47
preferences 22, 164
sort date 29, 171
structured 29
unusual 30

delete
event 158
event type 32
image 133
individual 157
media 133
place 31, 158
project 20, 159
slide show 159
source 44, 158
text 157
Web page 124, 125

descendant
searching 71
view 55

Descendant Interest (DI) 46, 111–113
Descendant reports 91–102

Descendant Box Chart 94–102
Descendant Text report 92
Direct Drop Descendant report 94
Indented Descendant report 91, 92

description, image 133
desktop display 6

graphics mode 6, 22, 164
Macintosh Desktop Colors mode 6, 22

desktop preferences 163–164
Direct Drop Descendant report 94
direct media 131
display 22
duplicate record number

deleting and renumbering 168
finding 168

 

E

 

emigration 15
employment 15
event 28–33

adding 14, 28
chronological order 171
creating 14, 15
creating new event type 32
deleting 158
deleting event type 32
detail 15, 31
editing 34
GEDCOM 149
import 149
removing deleted 167
search 66
type 29
unrecognized 149

event type
deleting 32
new 32

evidence 38–44
adding 15, 16, 40, 41

Evidence status box 22
exiting Ultimate Family Tree 170
export

GEDCOM 150–153
image 135
text 38

 

F

 

Fa button 27
family

group 18, 53, 54
key 163
tree 18, 52, 53

Family Group, viewing 18, 19
Family Group report 104–106
Family Journal report 87–89
Family Tree (Pedigree) Chart 89, 90
Family Tree (Pedigree) window 17, 52
father 24, 27

adding 13
changing 21
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files 172
find 23

individual 23, 76
find, 

 

see also search

 

flag 47
flag search 67
font setup 82, 83
footnote

creating 41, 42
customizing 43
rebuilding 167

formatting text 35
Free Note 42, 43
free-form date format 146, 164
frequently asked questions 20, 171

 

G

 

GEDCOM 32, 107, 110, 144, 145
exceptions, viewing 168, 169
Exceptions List report 110, 111
export 150–153
importing 145–149
options 145
submission 152
tag 32
Web page 119

generation number 92
Go menu 20, 23, 77
graduation 15
graphics 22

formats 131
Web page 118, 119, 122

grouping 74, 84
adding an individual 75
removing an individual 75

 

H

 

help 1
Henry numbering system 93
hints 20
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image 131
adding 131–133, 136, 137
caption 133

image
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deleting 133
description 133
displaying 134
exporting 135
linking 16, 135–137
new 132
preferred 136
viewing 134, 137
Web page 118, 119

immigration 15, 47
import

Family Tree Maker 148
GEDCOM 145–149
Personal Ancestral File 148
Reunion 148
ROOTS III 148
text 37
unrecognized events 149

Indented Descendant report 91, 92
index additions 81
individual

combining 159–161
creating new 12, 26
deleting 157
finding 23, 76, 77
flag 47
list view 58, 59
media 50
miscellaneous information 46–48
record 26–33
summary 54, 55
text 34

Individual button 26
Individual List report 23
individual summary, viewing 19
Individual Summary report 106
installation

browser 4
program 3

Instant Web Page
connecting to Palladiumnet 119
creating 116, 117
file organization 117, 118
graphics 122
linking files 118, 119
previewing 124
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tutorial 120–122
uploading 126

interest level 46, 112
international characters 12, 35
Internet 2, 119, 125

 

K

 

Key Families field 163
Key Families, updating 8
keyboard 10
kinship view 56, 57

 

L

 

language 48
last edit date 47
launching word processor 82
LDS event 15
Library, restoring 154, 155
linking media 135–137
list

individual 58
marriage 59
source 59

locating individual 76

 

M

 

Macintosh desktop colors 6, 22, 164
Mail Label window 46, 48
Mail List report 109
mail search 68
marriage 21, 33

creating 14, 33–34
editing 21, 34
list view 59

media
adding 136, 137
caption 133
deleting 133
description 130, 133
exporting 135
linking 135, 136
new 132, 136, 137
Ref Name 130
referenced 130
searching 69
slide show 137–141

Media Library 50, 129–133, 139
Media Link window 16, 50
medical

history 16, 49
searching 69

Medical History window 16
menu bar 10
merging 144
messages 164
Microsoft Word 79, 82
Miscellaneous Individual Information window 16, 46
miscellaneous searching 70
Mo button 27
modified Henry numbering system 93
Modified Register report 87, 88
More button 16, 45
mother 24, 27

adding 13
changing 21

 

N

 

name
alias 47
common 47
entering 27
long 46
preference 81
religious 48
searching 63, 77
title 27

name format 165
reports 81

National Genealogical Society 81, 88
nationality 47
New England Historic Genealogical Society 81, 88
New File window 7
new individual 26
New Individual button 12
new project 7, 8
New Spouse button 21, 33

 

O

 

online 119, 120–122, 125
opening

existing project 9
new project 7, 8
text file 170

Open File window 9
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optimize
Check function 166–168
pack 166
reindex 166

 

P

 

Pack utility 166
page

layout 81
setup 80–83

Palladium Interactive 119
parents 24

adding 13, 27
changing 21, 28
editing 27
unmarried 45
viewing 53

Pedigree report 89, 90
pedigree, viewing 52
performance 164
Personal Ancestral File 148
photo, viewing 58
place

adding 30, 33
combining 161–162
deleting 31, 158
editing 23, 31
missing from library 174
removing from an event 158

Portrait report 103, 104
preferred image 136
preparer

information 8
name 81, 105

printing, 

 

see also reports

 

options 80, 81
preparing 85
reports 83, 84

project 172
backup 153–155
control files 172
creating 7, 8
deleting 20, 159
duplicate 155
information 162, 163
merging 144
opening 9

project 
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restoring 154, 155
saving 153–155
split 156, 157
viewing information 162, 163

Project Information window 8
Project Summary report 107
proof 38–42

 

Q

 

Quick Start Tutorial 12–20
QuickTime 129
quit 170

 

R

 

record number 27, 58
duplicate 168

redundant ancestors 56
Reference field 47
referenced media 130
Register report 87, 88
registering a web page 126
Reindex utility 166
reinstalling Ultimate Family Tree 4
Relationship List report 102, 103
relationship

searching 71
viewing 56

religion 48
religious name 48
repairing a project 166–168
report 102, 103

Ancestor (Ahnentafel) 90, 91
basic steps 83
book title 81
Descendant Box Chart 94–102
Descendant Text 92, 93
Direct Drop Descendant 94
Family Group 104–106
Family Journal 87–89
Family Tree 89, 90
GEDCOM Exceptions List 110, 111
Indented Descendant 91, 92
Individual List 108
Individual Summary 106
Mail List 109
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Marriage List 108
name format 81
name preference 81
Pedigree 89, 90
Portrait 103, 104
preferences 80, 81
Project Summary 107
Source List 108
Text 103
Tiny-Tafel 111–114
Title Page 86, 87

Research report (Family Group) 106
researcher 8, 81, 163
reserved characters 11
restoring a backup 154, 155
Reunion 148
Rich Text Format (RTF) 2, 11, 79, 80

 

S

 

saving
backup 153–155
data 11
project 153–155

search 62, 63
ancestors 71
citation 65, 66
complex name 65
descendants 71
events 66
flags 67
grouping 74–75
individual 23
individual events 67
mail 68
media 69
medical 69
miscellaneous 70, 71
name 63, 64
options 62
relationship 71
rules 77
SOUNDEX 64
source 65
surname 64
text 72, 73
vital statistics 73

shortcut key 10, 11
sibling adding 17, 45
signature 47
slide show 137–141

adding existing slide show 140, 141
creating 138, 139
deleting 159
editing 139
viewing 58

Social Security number 48
sort date 171
sound, Web page 119
SOUNDEX 64, 102
source 38–43

adding 39, 40
deleting 44, 158
editing 43
list view 59
new 40
record 39–41

Spell Check feature 36, 37
splitting a project 156, 157
spouse 24

adding 14, 21
changing 21, 34

Spouse button 33
start new project 7, 8
starting Ultimate Family Tree 4, 5
submitter, Tiny-Tafel 113
summary, view individual 19
system requirements 2

 

T

 

technical support 2
temple code 15
text

adding 15, 16
biographical 34
deleting 157
event 34
exporting 38
external 170
footnote 34
formatting 35
importing 37
individual 34
opening external file 170
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research note 34
saving external file 170
searching 72
selecting 36

Text report 103
Tiny-Tafel 46
Tiny-Tafel report 111–114
tips 20
Title Page report 86, 87
title

book 81
names 27

troubleshooting 173–175
tutorial

quick start 12
Web page 120–122

 

U

 

Ultimate Family Tree
getting familiar with 10
installing 3, 4
quit 170
starting 4, 5

Undo 22
Universal Resource Locator (URL) 48, 116
unmarried parents 45
update Key Families 8
utilities 166

 

V

 

view
ancestors 17
descendants 55
family group 53
family tree 52
GEDCOM exceptions 168, 169

view
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image 134, 137
individual 55
individual list 59
individual summary 19, 54
kinship 56, 57
marriage list 59
name 58
name format 165
pedigree 52
photo 58
project information 162, 163
record number 58
redundant ancestors 56
relationship 56
slide show 58
source list 59
Web page 124

vital statistics search 73

 

W

 

Wall Chart 97
Web link 48
Web page

Box Chart 123, 124
connecting 119
deleting 124, 125
GEDCOM 119
graphics 122
images 118, 119
registering 126
tutorial 120–122
uploading tips 126
viewing 124

wild card 63, 67, 77
WindowShade 11
word processor 82
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